Manual Guide - Notebook Series | & Il

This manual coverstwo notebook series, and this document contains two manual s with information relating to both notebook series. The main difference

between the two notebook seriesisin the chipset and CPU’ s supported as outlined in the table below.

Feature

Notebook Series |

Notebook Series Il

Feature

Chipset

Mobile Intel® HM70 Express Chipset

Mobile Intel® HM76 Express Chipset

Chipset

List

Supported CPU

Intel® Pentium® B980

Intel® Pentium® B970

Intel® Pentium® B960

Intel® Pentium® B950

Intel® Pentium® B840

Intel® Celeron® B820

Intel® Celeron® B815

Intel® Celeron® B810

Intel® Celeron® B730

Intel® Celeron® B720

Intel® Core i7-3612QM
Intel® Core i7-3520M
Intel® Core i5-3360M
Intel® Core i5-3320M
Intel® Core i5-3210M
Intel® Core i7-2620M
Intel® Core i5-2540M
Intel® Core i5-2520M
Intel® Core i5-2450M
Intel® Core i5-2430M
Intel® Core i5-2410M
Intel® Core i3-3110M

Intel® Core i3-2370M

Intel® Core i3-2350M

Intel® Core i3-2330M

Intel® Core i3-2310M

Intel® Pentium® B970

Intel® Pentium® B960

Intel® Pentium® B950

Intel® Pentium® B940

Intel® Pentium® B840

Intel® Celeron® B815

Intel® Celeron® B810

Intel® Celeron® B800

Intel® Celeron® B720

Intel® Celeron® B710

Supported CPU
List

Within each of thetwo seriesthere arethreedifferent models (entitted Models A, B & C, with different design stylesdifferingin color, general appearance
and features supported. Note that your computer may look slightly different from those pictured throughout either manual. See Appendix D at the end of

each manual for full specification details. If you need any assistance you can contact your service representative for further help.
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Notice

The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.

©June 2013

Trademarks
Intel, Pentium and Intel Core are trademarks/registered trademarks of Intel Corporation.
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R&TTE Directive
Thisdeviceisin compliance with the essential requirements and other relevant provisions of the R& TTE Direc-
tive 1999/5/EC.

Thisdevice will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.

ErP Off Mode Power Consumption Statement:
Thefigures below note the power consumption of thiscomputer in compliance with European Commission (EC)
regulations on power consumption in off mode

« Off Mode <0.5W
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CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters“CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark

is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R& TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and hasissued afavorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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FCC Statement

(Federal Communications Commission)

Y ou are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limitsfor aClass B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonabl e protection against harmful interferencein
aresidential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, thereisno guarantee that interference will not occur in aparticular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on acircuit different from that to which the receiver is connected.
» Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the
device.
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FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator
and your body.

N\ A/
L&
Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.

If your purchase option includes both Wireless LAN and 3.75G modules, then the appropriate antennas will be installed.
Note that In order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate
in conjunction with any other antenna or transmitter.

Important Notice - 3G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G module and the Bluetooth/Wireless LAN modules
at the same time as this may disrupt radio frequency, and cause interference. When the 3G module is powered on, make
sure that the Bluetooth/Wireless LAN modules are powered off.
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed bel ow, to reduce therisk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.

4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.

5. This product is intended to be supplied by a Listed Power Unit with an AC Input of 100 - 240V, 50 - 60Hz, DC
Output of 19V, 3.42A or 18.5V, 3.5A (65 Watts) minimum AC/DC Adapter.

This Computer’s Optical Device is a Laser Class 1 Product

Vi



Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions.

1.

Preface

Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Do not expose the computer
to any shock or vibration.

surface.

Do not placeit on an unstable

Do not place anything heavy
on the computer.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-

aged.

Do not expose it to excessive
heat or direct sunlight.

Do not leaveit in a place
where foreign matter or mois-
ture may affect the system.

Don't use or store the com-
puter in a humid environment.

Do not place the computer on
any surfacethat will block the
Vents/Fan Intakes.

Vi
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Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other
strong magnetic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don'’t forget

to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power
until you properly shut down
all programs.

Do not turn off any peripheral
devices when the computer is
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance
on your computer.

VIiI

Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.




Power Safety

The computer has specific power requirements:

* Only use a power adapter approved for use with this computer.

* Your AC/DC adapter may be designed for international travel but it still requiresa
steady, uninterrupted power supply. If you are unsure of your local power specifications,

consult your service representative or local power company.

» The power adapter may have either a 2-prong or a 3-prong grounded plug. The third
prong is an important safety feature; do not defeat its purpose. If you do not have access

to acompatible outlet, have a qualified electrician install one.

*  When you want to unplug the power cord, be sure to disconnect it by the plug head, not

by itswire.

* Make sure the socket and any extension cord(s) you use can support the total current

load of all the connected devices.

» Before cleaning the computer, make sure it is disconnected from any external power

supplies (i.e. AC/DC adapter or car adapter).

cord if you are wet.

Do not plug in the power

Do not use the power cord if
it is broken.

Do not place heavy objects
on the power cord.

Preface
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Power Safety
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines and

power cord).

You must also remove
your battery in order to
prevent accidentally
turning the machine
on. Before removing
the battery discon-
nect the AC/DC
adapter from the
computer.
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Polymer Battery Precautions
Note the following information which is specific to polymer batteries only, and where applicable, this overrides
the general battery precaution information overleaf.

» Polymer batteries may experience aslight expansion or swelling, however thisis part of the battery’s safety mecha-
nism and is not a cause for concern.

e Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient tempera-
ture environments, and do not store unused batteries for extended periods.

See a'so the general battery precautionary information overleaf for further information.
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Battery Precautions

Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.

Do not remove any batteries from the computer while it is powered on.

Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
resultinfire.

If you do not use the battery for an extended period, then remove the battery from the computer for storage.
Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

K eep the battery away from metal appliances.

Affix tape to the battery contacts before disposing of the battery.

Do not touch the battery contacts with your hands or metal objects.

SN
ALK

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
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Cleaning

Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

*  When the power cord or AC/DC adapter is damaged or frayed.

 If the computer has been exposed to rain or other liquids.

 |If the computer does not work normally when you follow the operating instructions.

 If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
» If thereisan unusual odor, heat or smoke coming from your computer.

S
&
Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before restoring power to the system.

Also note the following when the cover is removed:

e Hazardous moving parts.
* Keep away from moving fan blades.

Xl
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Travel Considerations

Packing
Asyou get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.

The AC/DC adapter uses voltages from 100 to 240 volts so you won't need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both
hardware and software. Make sure your documents are prepared.

SN
ALK

Power Off Before Traveling

agprwbPE

N o

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your

computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.

X1l



Preface

On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these pointsin mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’'t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Bewar e of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
Theserestrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power whereyou can - If an electrical outlet isavailable, usethe AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from acold to awarm location, water vapor can condense inside the computer.
Wait afew minutes before turning it on so that any moisture can evaporate.

XV
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Developing Good Work Habits

Developing good work habitsisimportant if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

Adjust the height of the chair and/or desk so that the keyboard is at or dightly below the level
of your elbow. Keep your forearms, wrists, and hands in arelaxed position.

Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a
footrest if necessary.

Use a chair with aback and adjust it to support your lower back comfortably.

Sit straight so that your knees, hips and elbows form approximately 90-degree angles when
you are working.

Take periodic breaks if you are using the computer for long periods of time.

Remember to:

Alter your posture frequently.

Stretch and exercise your body several times a day.

Take periodic breaks when you work at the computer for long periods of time. Frequent and
short breaks are better than fewer and longer breaks.

XV
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatiguein your neck and
shoulders.

Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
Position the display directly in front of you at a comfortable viewing distance.

Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image per sistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

Set the Windows Power Plansto turn the screen off after afew minutes of screenidle time.

Use arotating, moving or blank screen saver (this prevents an image from being displayed too long).
Rotate desktop background images every few days.

Turn the monitor off when the system isnot in use.

LCD Electro-Plated Logos

Note that in computers featuring araised LCD electro-plated logo, the logo is covered by a protective adhesive.
Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may develop sharp
edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated
logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during
transport. If any such wear and tear develops contact your distributor/supplier.

XVI
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Quick Start Guide

Chapter 1. Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

e Chapter 2 A guideto using some of the main features of the computer e.g. the stor age devices (hard disk,
optical device, card reader), Touchpad & Mouse & Audio.

e Chapter 3  The computer’s power saving options.

e Chapter 4 Theinstalation of the driversand utilities essential to the operation or improvement of some of the
computer’s subsystems.

» Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).

» Chapter 6 Instructionsfor upgrading your computer.

» Chapter 7 A quick guide to the computer’s PC Camera, WirelessL AN, Combo Bluetooth & WLAN and
3G modules (some of which may be optional depending on your purchase configuration).

e Chapter 8 A troubleshooting guide.

« Appendix A Definitions of the interface, ports/jackswhich allow your computer to communicate with external
devices.

» Appendix B Information on Control Center.

» Appendix C Information on the video driver controls.

» Appendix D The computer’s specification.

» Appendix E Information related to the Windows 8 operating system.

Overview 1 -1
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Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
torefer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “ Upgrading The Computer” on
page 6 - 1 inthe reminder of the User' sManual. Y ou may also find the notes marked with a# of interest to you.

Beginners and Not-So-Advanced Users

If you are new to computers (or do not have an advanced knowledge of them) then
4 the information contained in the Quick Start Guide should be enough to get you up
Notes and running. Eventually you should try to look through all the documentation (more
Check the light colored detailed descriptions of the functions, setup and system controls are covered in the
boxes with the mark | remainder of the User's Manual), but do not worry if you do not understand every-
above to find detailed in- = thing the first time. Keep this manual nearby and refer to it to learn as you go. You
utors foatiroe. <™ | may find it useful to refer to the notes marked with a s indicated in the margin,
For amore detailed description of any of the interface ports and jacks see “ I nterface

(Ports & Jacks)” on page A - 1.

Warning Boxes

No matter what your level please pay careful attention to the warning and safety information indicated by the
2 symbol. Also please note the safety and handling instructions as indicated in the Preface.

1-2 Overview
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Not Included

Operating Systems (e.g. Windows 7) and applications (e.g. word processing, spreadsheet and database programs)
have their own manuals, so please consult the appropriate manuals.

4

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “ Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If
your system hasn't been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your com-
puter to communicate with external devices, connect to the internet etc.

. |
Overview 1 -3
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System Startup

Remove all packing materials.

Place the computer on a stable surface.

Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an
outlet, and connect the AC power cord to the AC/DC adapter.

Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 130 degrees); use the other
hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by
the lid/LCD).

PobNPE

o

4

Shutdown

Note that you should al-
ways shut your comput-
er down by choosing the
Shut Down command
from the bottom right of
the Start menu in Win-
dows. This will help
prevent hard disk or
system problems.

130°

Figure 1 - 1 - Opening the Lid/LCD & Computer with AC/DC Adapter Plugged-In

1 -4 System Startup
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System Software

Y our computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the Windows 7 (with Service Pack 1 in-
stalled) and Windows 8 operating systems are supported.

The majority of this menu covers information covers information related to the Windows 7 operating system,
however for specific information on the Windows 8 operating system see Appendix E.

Note: In order to run Windows 7 (SP1) without limitations or decreased performance, your computer requires a
minimum 1GB of system memory (RAM).

4

Windows 7/8 OS

In order to run Windows 7 or 8 (32 Bit) without limitations or decreased performance, your computer requires a minimum
1GB of system memory (RAM), however if you are running Windows 7 or 8 (64 bit) your computer requires a minimum
2GB of system memory (RAM).

System Startup 1 -5
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Model Differences
This notebook seriesincludesthr ee different models that vary slightly in design style (M odels A and B include

two distinct design styles), color, general appearance and features supported. Note that your computer may ook
dlightly different from that pictured throughout this manual.

Feature Model A Model B Model C
Display 14.0" / 35.56cm HD (1366 * 768), 16:9 15.6"/ 39.62cm HD (1366 * 768) / HD+ | 17.3"/ 43.94cm HD+ (1600 * 900),
Type Backlit Panel (1600 * 900), FHD (1920 * 1080), FHD (1920 * 1080),
Supported 16:9 Backlit Panel 16:9 Backlit Panel
Dimensions See “Dimensions & Weight” on page D - 5.
& Weight

See “ Specifications” on page D - 1 for full details.

Table 1 - 1 - Model Differences

1 -6 System Startup



System Map: LCD Panel Open - Model A Design |

N /
2§
Wireless Device

Operation Aboard
Aircraft

The use of any portable elec-
tronic transmission devices
aboard aircraft is usually pro-
hibited. Make sure the mod-
ule(s) are OFF if you are
using the computer aboard
aircraft.

Use the key combinations to
toggle power to the 3G/
WLAN/Bluetooth modules,
and check the LED indicator
or on-screen icon to see if the
modules are powered on or
not (see

/
).

Note that the Touchpad and Buttons valid operational area is that indicated within the red dotted lines

indicated on the right.

=

N o

ahrwN
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Figure 1 -2

LCD Panel Open -

Model A Design |

Built-In PC Camera
(Optional)

LCD

Power Button

Hot Key Buttons
LED Status
Indicators
Keyboard

Built-In Microphone
Touchpad &
Buttons

©
X A

Touchpad Buttons

(valid operational area)

System Map: LCD Panel Open - Model A Design 11-7
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Figure 1 - 3 System Map: LCD Panel Open - Model A Design |l

LCD Panel Open -

i N/
Model A Design Il o 7@‘
1. Built-in PC Camera Wireless Device
(Optional) Operation Aboard
2. LCD Aircraft
3. Power Button The use of any portable electronic
4. LED Status 9 transmission devices aboard air-
. craft is usually prohibited. Make
Indicators sure the module(s) are OFF if you
5. Keyboard are using the computer aboard
: . aircraft.
6. Built-In Microphone

Use the key combinations to tog-

7. TOUChpad & gle power to the 3G/WLAN/Blue-
Buttons tooth modules, and check the
e e LED indicator or on-screen icon to
see if the modules are powered on
e or not (see
I

)-

Touchpad Buttons e
(valid operation area)

Note that the Touchpad and Buttons valid operational area is that indicated within the red dotted lines
indicated on the left.

1 - 8 System Map: LCD Panel Open - Model A Design I
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System Map: LCD Panel Open - Model B Figure 1 - 4
e o0 = i "

/2

\Y

=

Wireless Device Built-in PC Camera
Operation Aboard (Optional)

9 Aircraft

2. PC Camera LED
The use of any portable electronic 3. LCD
transmission devices aboard air- 4. Power Button
craft is usually prohibited. Make
sure the module(s) are OFF if you 5. LED Status
are using the computer aboard Indicators
aircraft.
o 6. Keyboard
Use the key combinations to tog- *Buil
gle power to the 3G/WLAN/Blue- 7. B_UI t-In
tooth modules, and check the Microphone
6 e LED indicator or on-screen icon *Note that the
to see if the modules are powered microphone location is
on or not (see
@ ’ dependent upon your
). model design
8. Touchpad &
Buttons

o
o ® e

Note that the Touchpad and Buttons valid operational area is that indicated within the red dotted lines
indicated on the right.

System Map: LCD Panel Open - Model B 1-9
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Figure 1-5
LCD Panel Open
Model C

1. Built-In PC Camera
(Optional)

PC Camera LED
LCD

Power Button

LED Indicators
Keyboard

Built-In Microphone
Touchpad &
Buttons

©NOOALON

18]

Note that the Touchpad and
Buttons valid operational area
is that indicated within the red
dotted lines above.

System Map: Model C - LCD Panel Open

18]

1-10 System Map: Model C - LCD Panel Open

2§
Wireless Device

Operation Aboard
Aircraft

The use of any portable elec-
tronic transmission devices
aboard aircraft is usually pro-
hibited. Make sure the mod-
ule(s) are OFF if you are
using the computer aboard
aircraft.

Use the key combinations to
toggle power to the WLAN/
Bluetooth modules, and
check the LED indicator or
on-screen icon to see if the
modules are powered on or
not (see




LED Indicators
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Icon Color Description
The LED indicators on the computer display helpful . .
information about the current status of the computer Green | 1 (Optional) Wireless LAN Module
in puter. is Powered On
T Win 7 - The (optional) Bluetooth
Orange DC Power is Plugged In Orange | win 8 - The (optional) Bluetooth
- Module is Installed (this is not a
Green The Computer is On power on/off indicator in Windows 8)
. The Computer is in Slee
Blinking Green P P Green Hard Disk Activity
Mode
The PC Camerais In Use Green Number Lock Activated
Blinking Orange | (for 14.0” / 35.56cm Model A
computers only) Green Caps Lock Activated
Orange The Battery is Charging
Green The Battery is Fully Charged Green Scroll Lock Activated
- The Battery Has Reached
Blinking Orange Critically Low Power Status Blue Power Button

Table1-2-LED

Power Indicators

Table 1 - 3 - LED Status Indicators

LED Indicators 1 - 11
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Hot Key Buttons - Some Model A Design Styles

These buttons give instant access to the default Internet browser and e-mail program, and allow you to toggle
the Silent M ode on/off with one quick button press.

Hot Key Function

® 2] o

Toggle *Silent Mode (for power saving)
OR
WLAN ON/OFF

OR

Activate the Default Internet Program

Activate the Default E-Mail Browser (Note that this button has no function in Windows
7 without Outlook/Outlook Express installed. If Outlook/Outlook Express are installed
then the button will activate the application)

®  ®© 0O

Table 1 - 4 - Hot Key Buttons - Some Model A Design Styles

*When enabled, Silent M ode will reduce fan noise and save power consumption. Note this may reduce comput-
er performance.

1-12 Hot Key Buttons - Some Model A Design Styles
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4

Other Keyboards

Keyboard - Model A

The keyboard has an embedded numerical keypad for easy numeric data input, and
function keys to change operational features instantly. See Table1 - 5, on page 1 -

15 for function key details and Appendix E for Windows 8 keyboard information. If your keyboard is dam-
aged or you just want to

make a change, you can

use any standard USB

keyboard. The system will
detect and enable it auto-
matically. However spe-
cial  functions/hot-keys
unique to the system'’s
regular keyboard may not
work.

NumLk & ScrLk

NumLk &
Play/Pause Key ScrLk Keys
3G

Module Power
Toggle Key

Numerical Keypad

Hold down the Fn Key
and either NumLk or

Figure 1 - 6 - Keyboard - Model A ScrLk to enable number
or scroll lock, and check

the LED indicator for sta-

/ tus.

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

Keyboard - Model A 1- 13
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4

Other Keyboards

If your keyboard is dam-
aged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it auto-
matically. However spe-
cial  functions/hot-keys
unique to the system'’s
regular keyboard may not
work.

NumLk & ScrLk

Hold down the Fn Key
and either NumLk or
ScrLk to enable number
or scroll lock, and check
the LED indicator for sta-
tus.

Keyboard - Models B & C

The keyboard has an embedded numerical keypad for easy numeric data input, and
function keys to change operational features instantly. See Table1 - 5, on page 1 -
15 for function key details and Appendix E for Windows 8 keyboard information.

| Function Keys

NumLk &
ScrLk Keys

Play/Pause Key

3G Numerical
Module Power Keypad
Toggle Key

(For Model B only)

[ ]

Fn Key
Figure 1 - 7 - Keyboard - Models B & C

4

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

1-14 Keyboard - Models B & C
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Function/Hot Key Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility isinstalled.

Keys Function Keys Function
Fn+~ Play/Pause (in Audio/Video Programs) Fn + F8/F9 Brightness Decrease/Increase
Silent Mode Toggle (for some
3G Module Power Toggle ) ”
Fn + (Models A & B Only) Model A Designs Only - see
page 3 - 2)
Fn+F1 TouchPad Toggle Fn + F10 PC Camera Power Toggle
Turn LCD Backlight Off
Fn+F2 (Press a key to or use TouchPad to turn on) Fn+F1l WLAN Module Power Toggle
Fn+F3 Mute Toggle Fn + F12 Bluetooth Module Power Toggle
Fn+F4 Sleep Toggle Fn + NumLk Number Lock Toggle
Fn + F5/ Volume Decrease/ Fn + ScrLk Scroll Lock Toggle
F6 Increase
Fn+F7 Display Toggle Caps Lock Caps Lock Toggle

Table 1 -5 - Function & Hot Key Indicators

Function/Hot Key Indicators 1 - 15
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Control Center

Press the Fn + Esc key combination, or double-click the icon E in the notification area of the taskbar to
toggle the Control Center on/off. The Control Center gives quick access to frequently used controls and en-
ables you to quickly turn modules on/off (see Appendix B for full details). The Control Center in Windows 8
works under the Desktop app and not under the Start screen, and does not feature the wirel ess/Bluetooth buttons
and Airplane Mode (see page E - 15 for Windows 8 information).

4

Control Center

Click on any button to turn any of the modules (e.g.
TouchPad, Camera) on/off.

Click on the power conservation modes to switch be-
tween Performance, Balanced or Energy Star modes
(see page 3 - 10). To remove the Power Conservation
Modes screen just click in a blank area of the icon or
press a key on the keyboard.

Click on the buttons (or just click and hold the mouse but-
ton) to adjust the slider for Brightness/VVolume.

Click on Display Switch and click to choose a display
mode from the menu (see page C - 10).

Figure 1 - 8 - Control Center

. |
1 - 16 Control Center
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System Map: Front & Left Views - Models A & B Figure 1- 9

Front & Left Views

o Models A & B
1. LED Power Indi-
cators
2. DC-InJack
G 3. External Monitor
Port
@ 4, RJ-45 LAN Jack
5. HDMI-Out Port
(2] ® 4 © © © (8] 6. USB 3.0 Port
7. Vent/Fan Intake/
Outlet
8. Multi-in-1 Card
(6] @ Reader
e ®© 0o © @ e}

Multi-In-1 Card Reader
The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / RSMMC
SD (Secure Digital) / Mini SD / SDHC / SDXC
MS (Memory Stick) / MS Pro / MS Duo

System Map: Front & Left Views - Models A& B 1- 17
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Figure 1 - 10
Front & Left Views
Model C

=

LED Indicators
DC-In Jack
External Monitor
Port

RJ-45 LAN Jack
HDMI-Out Port
USB 3.0 Port
Vent/Fan Intake
Multi-In-1 Card
Reader

wnN

©NoaA

System Map: Front & Left Views - Model C

Multi-In-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / RS MMC
SD (Secure Digital) / Mini SD / SDHC / SDXC
MS (Memory Stick) / MS Pro / MS Duo

USB 3.0 Port OR USB 2.0 Port

This model includes USB 3.0 ports on the left side of the computer. USB 3.0 ports are de-
noted by their blue color; USB 2.0 ports are colored black. Note that the USB 3.0 ports
require a driver installation for Windows 7 (Windows 8 does not require a driver) and do
not support wake on USB.

1-18 System Map: Front & Left Views - Model C
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System Map: Right & Rear Views - Models A & B Figure 1- 11

Right & Rear Views
Models A & B

1. Microphone-In
o 9 9 9 @ Jack
2. Headphone-Out
Jack
3. USB 2.0 Port
4. Optical Device

@ 9 9 9 Drive Bay (for CD/

DVD Device)
5. Security Lock Slot
6. Battery

4

Battery Information

Always completely dis-
charge, then fully charge, a
new battery before using it.
Completely discharge and
charge the battery at least
once every 30 days or after
about 20 partial discharges.
See “Battery Information”
on page 3 - 11 for full in-
structions.

System Map: Right & Rear Views - Models A & B 1-19
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Figure 1 - 12 System Map: Right & Rear Views - Model C

Right & Rear Views -
Model C

1. Headphone-Out
Jack 00 o (4] (5
2. Microphone-In
Jack
3. USB 2.0 Port
4. Optical Device

Drive Bay @
5. Security Lock Slot
6. Battery

Z

Battery Information

Always completely dis-
charge, then fully charge, a
new battery before using it.
Completely discharge and
charge the battery at least
once every 30 days or after
about 20 partial discharges.
See “Battery Information”
on page 3 - 11 for full in-
structions.

1 - 20 System Map: Right & Rear Views - Model C



Disk Eject Warning

Don't try to eject a CD/DVD while the system is ac-
cessing it. This may cause the system to “crash”. Stop
the disk first then eject it, or press the stop button
twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to
an unexpected power interruption) you may push the
end of a straightened paper clip into the emergency
eject hole. Do not use a sharpened pencil or any ob-
ject that may break and become lodged in the hole.
Don't try to remove a floppy disk/CD/DVD while the
system is accessing it. This may cause the system to
“crash”.

Quick Start Guide

4

Changing DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code
(see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.

.|
System Map: Right & Rear Views - Model C 1 - 21
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Figure 1 - 13 System Map: Bottom View - Model A
Bottom View
I:/fodeIA o

=

Battery
2. Component Bay

Cover @

3. Vent/Fan Intake/

Outlet 9 9
4. Hard Disk Bay

Cover
5. 3.75G USIM Card (3]

Cover (Optional)

CPU

The CPU is not a user
serviceable part.

Overheating H

To prevent your comput- S

er from overheating Bottom Covers

make sure nothing blocks If your model includes the 3G option then a small cover 5 to enable you to access the

the Vent/Fan Iptgke while module’s USIM card will be included (see ).
the computer is in use.

1-22 System Map: Bottom View - Model A
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System Map: Bottom View - Model B Figure 1 - 14
Bottom View - Model B
1. Battery
0 2. Component Bay
Cover
9 3. Vent/Fan Intake/
Outlet

4. Hard Disk Bay

9 9 Cover

6 6 5. 3.75G USIM Card
Cover (Optional)
6. Speakers

CPU

The CPU is not a user
serviceable part.

7 \

'IX' Overheating

To prevent your comput-

Bottom Covers er from overheating

If your model includes the 3.75G option then a small cover 5 to enable you to access the make sure nothing blocks

module’s USIM card will be included (see ). the Vent/Fan Intake while
the computer is in use.

System Map: Bottom View - Model B 1 - 23
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Figure 1 - 15 System Map: Bottom View - Model C

Bottom View
Model C o
1. Battery
2. Component Bay e
Cover
3. Fan Intake/Vent e
4. Hard Disk Bay (2]
Cover e
5. Speakers

4

Battery Information

Always completely dis-

charge, then fully el
charge, a new battery ’Q‘
before using it. Com- CPU
pletely discharge and
charge the battery at
least once every 30 days Overheating

or after about 20 partial To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake
discharges. while the computer is in use.

The CPU is not a user serviceable part.

1 - 24 System Map: Bottom View - Model C
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Windows 7 Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows 7 are accessed from the Start menu (see Ap-
pendix E for information on the Windows 8 OS). When you install programs and utilities they will be installed
on your hard disk drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click
the Start menuicon , and then select Properties to customize the appearance of the Start menu.

Click here to toggle Category View

Figure 1 - 16 - Start Menu & Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
inWindows (e.g. power, video, network, audio etc.). Windows 7 provides basic controls for many of the features,
however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all
controls it may be necessary to toggle off Category View to view the control panel icons.

System Map: Bottom View - Model C 1 - 25
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Video Features

Y ou can switch display devices, and configure display options, from the Display control panel (in Appear ances
and Personalization) in Windows 7 (see over). For more detailed video information see “ Video Driver Con-
trols’ on page C - 1. To access Display (Control Panel) and Screen Resolution in Windows:

Click Start and click Control Panel.

Click Display (icon) - In the Appearances and Personalization category.

Click Adjust Screen Resolution/Adjust resolution.

Alternatively you can right-click the desktop and select Screen resolution.

Use the dropbox to select the screen Resolution @ (Figure 1 - 17).

Click Advanced settings @ (Figure 1 - 17) to bring up the Advanced properties tabs.

ok wbNpE

Figure 1 - 17 - Screen Resolution

1 - 26 Video Features
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To access the I ntel (R) Graphics and Media Control Panel:

1. Click Advanced settings @ (Figure 1 - 17 on page 1 - 26) in the Display Settings control panel in Windows.
2. Click Graphics Properties (button) @ (Figure 1 - 18) in the Intel Graphics & Media Control Panel tab.

OR

3. Right-click the desktop and select Graphics Properties from the menu.

OR

4. Click the icon E e (Figure 1 - 18) in the taskbar and select Graphics Properties from the menu.
OR

5. Access the Intel(R) Graphics and Media Control Panel from the Windows control panel in Classic View.

o )

C )

Figure 1 - 18 - Intel Graphics and Media Control Panel

Video Features 1 - 27
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Power Options

The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 24 or see Ap-
pendix E for information on the Windows 8 OS) allows you to configure power management features for your
computer. Y ou can conserve power by means of power plans and configure the options for the power button,
sleep button, computer lid (when closed), display and sleep mode from the left menu. Note that the Power
saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create anew plan. Click Change plan settings and click Change advanced power settingsto access further con-
figuration options. Pay attention to the instructions on battery care in “ Battery I nformation” on page 3 - 11.

Figure 1 - 19 - Power Options

.|
1 - 28 Power Options



Features & Components

Chapter 2. Features & Components

Overview

Read this chapter to learn more about the following main features and components
of the computer:

Hard Disk Drive

Optical (CD/DVD) Device
Multi-In-1 Card Reader
TouchPad and Buttons/Mouse
Audio Features

For information on the Windows 8 operating system see Appendix E.

. |
Overview 2 - 1
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Hard Disk Drive

SN
'Ll\ The hard disk drive is used to store your data in the computer. The hard disk can be
Power Safety taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height

Before attempting to ac- of 9.5 mm.

cess any of the internal . .
Selae e e era  Thehard disk isaccessible from the bottom of your computer as seen below. For fur-

oA CERERENENTNE  ther details see “ Upgrading the Hard Disk Drive” on page 6 - 5.
that the machine is not

connected to the AC

power, and that the ma-

chine is turned off. Also -
ensure that all peripher-

al cables, including

phone lines, are discon-

nected from the comput-

er.

Figure2-1
Hard Disk Location

2 - 2 Hard Disk Drive
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Optical (CD/DVD) Device

Thereisabay for a5.25" optical (CD/DVD) device (12.7mm height). The actual de- Z

vice will depend on the module you purchased (see “ Storage” on page D - 3). The Sound Volume
optical device is usualy labeled “Drive D:” and may be used as a boot device if Adjustment
properly set inthe BIOS (see “Boot Menu” on page5 - 15). How high the sound vol-

ume can be set depends

Loading Discs on the setting of the vol-
ume control within Win-

Toinsert aCD/DVD, press the open button @ and carefully place aCD/DVD onto | gows. Click the Volume
thedisc tray with label-side facing up (usejust enough forcefor thedisctoclick onto | icon on the taskbar to
the tray’ s spindle). Gently push the CD/DVD tray in until itslock “clicks’ and you | check the setting (see
are ready to start. The busy indicator @ will light up while datais being accessed, | Audio Features™ on

or while an audio/video CD, or DVD, isplaying. If power isunexpectedly interrupt- page 2- 12).
ed, insert an object such as a straightened paper clip into the emergency gject hole
© to open thetray. :
Figure2 -2

Optical Device

Optical (CD/DVD) Device 2 - 3
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Handling CDs or DVDs

7\[:1'( Proper handling of your CDS/DVDs will prevent them from being damaged. Please
follow the advice bel ow to make sure that the data stored on your CDS/DV Ds can be

CD Emergency Eject
accessed.

If you need to manually

SEei R RETERCRE - Note the following:

an unexpected power

LIEER RS GIER EVAl  » Hold the CD or DVD by the edges; do not touch the surface of the disc.
EERER I ESE o Use aclean, soft, dry cloth to remove dust or fingerprints.
f;{g'g::i?ﬁgrgg?grejﬂg « Do not write on the surface with a pen.

T EENEE e ¢ Do not attach paper or other materials to the surface of the disc.
SNeRRTEEE R ET Rl o Do not store or place the CD or DVD in high-temperature areas.
SRS EIEE o Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
SRS EECS . Do not bend the CD or DVD.

db lodged i .
ﬁ]ne hoﬁfome =S8 . Donot drop or subject the CD or DVD to shock.

Disk Eject Warning

Don't try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.

.|
2 - 4 Optical (CD/DVD) Device
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DVD Regional Codes

To change the DVD regional codes: Z

1. Go to the Control Panel DVD Region Note
2. Double-click Device Manager (Hardware and Sound), then click the + next to DVD region detection is
DVD/CD-ROM drives. device dependent, not
3. Double-click on the DVD-ROM device to bring up the Properties dialog box, and 0S-dependent. You can
select the DVD Region (tab) to bring up the control panel to allow you to adjust the select your module’s re-
regional code. gion code 5 times. The
) fifth selection is perma-
* Region 1-USA & Canada nent. This cannot be al-

« Region 2 - Western Europe, Japan tered even if you change
' ’ your operating system

South Africa, Middle East & Egypt ST LEE e e i
* Region 3- South-East Asia, Taiwan, another computer.
South Korea, The Philippines, Indo-
nesia, Hong Kong
* Region 4 - South & Central Amer-
ica, Mexico, Australia, New Zealand
* Region 5- N Korea, Russia, Eastern
Europe, India& Most of Africa _
+ Region 6 - China Figure2- 3
DVD Region Codes

Optical (CD/DVD) Device 2 - 5
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Card Reader Cover

Make sure you keep the
rubber cover provided in
the card reader when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the card reader.

Figure2-4
Left View

1. Card Reader

Multi-In-1 Card Reader

The card reader alows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the card reader driver (see
“ CardReader” on page 4 - 6.

« MMC (MultiMedia Card) / RSMMC
» SD (Secure Digital) / Mini SD / SDHC/ SDXC
* MS(Memory Stick) / MSPro/ MS Duo

Note: Some of these cards require PC adapters that are usually supplied with the
cards.

o

2 - 6 Multi-In-1 Card Reader



Features & Components

TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add a mouse to _
your computer through one of the USB ports. The TouchPad buttons function in Mouse Driver
much the same way as a two-button mouse. If you are using an ex-

ternal mouse your op-
erating system may be
able to auto-configure

your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’'s user docu-
mentation for details.

TouchPad and Buttons/Mouse 2 - 7
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Once you have installed the TouchPad driver (see “ Touchpad” on page 4 - 6) you
can configure the functions from the Mouse control panel in Windows, or by double-
TouchPad Scrolling clicking the TouchPad driver icon  in the notification area. Y ou may then config-
ure the TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options

phis computer model se- 1y vy preferences. Y ou will find further information at www.synaptics.com.

ries may feature different
TouchPad versions.

These TouchPads may
differ in their vertical
scrolling function in most
scrollable windows.

Some TouchPads require
sliding the finger up and
down on the right of the
TouchPad to scroll the
window. Other versions
require  tapping/holding
down the finger at the top
right or bottom right of the
TouchPad to scroll the
window.

Figure2-5
Mouse Properties

2 - 8 TouchPad and Buttons/Mouse
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Gestures and Device Settings

The Synaptics Gestures Suite application allows you to use a specific gesture (ac-
tion) on the surface of the TouchPad to perform specific actions to manipul ate doc-
uments, objects and applications.

Y ou can configure the settings from the Device Settings tab in M ouse Properties:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Mouse (Hardware and Sound).

3. Click Device Settings (tab) and click Settings.

4. Use the menu tree on the left to access the user configurable settings.

-
@

TouchPad and Buttons/Mouse 2 - 9

4

Show Video

You can get a clearer
view of the gestures in-
volved by clicking the
Show Video option for
each gesture item.

Select the gesture (Pinch
Zoom, Rotating, Three
Fingers Down and
Three Finger Flick) in the
Device Settings > Set-
tings left tree menu

and click the Show Video
button to see the demon-
stration video.

For more details on any of
the gestures see the help
in the lower part of the
right menu window.

Figure2-6
Mouse Properties -
Device Settings
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Scrolling

The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and verticaly. Place two fingers, slightly separated, on the
TouchPad surface and slide both fingers in the direction required (in a straight con-
tinuous motion).

Figure2-7
Scrolling Gesture

Zooming

The Pinch Zoom gesture can be used to perform the same function as a scroll wheel
in Windows applications that support CTRL + scroll wheel zoom functionality.
Place two fingers on the TouchPad (for best results use the tips of the fingers) and
dlide them apart to zoom in, or closer together to zoom out.

Figure2-8

Zooming Gesture

2 - 10 TouchPad and Buttons/Mouse
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Rotating

Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments.
Place a finger down on the left “target” zone and keep it stationary. Place another

finger near the middle of the TouchPad and slide it in a circular motion around the

stationary finger (clockwise or counterclockwise) to rotate the object.

Figure2-9
Rotating Gesture

Three Finger-Flick/Three Fingers Down (Press)

The Three Finger-Flick gesture may be used to enhance navigation with avariety of
applications such as browsing the Internet or scrolling through a photo viewer. The
Three Fingers Down gesture may be used to launch user-sel ectable applications.

Figure2- 10
Flick/Press
Gesture

. |
TouchPad and Buttons/Mouse 2 - 11
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Audio Features

Y ou can configure the audio options on your computer from the Sound  control
panel in Windows, from the HD V Deck icon on the desktop or VIA HD Audio
Deck control panel 2| via +p Audio Deck .

4

Sound Volume
Adjustment

The sound volume level

is set using the volume | The volume may also be adjusted by means of the Fn + F5/F6 key combination.
control within Windows

(and the volume func-

tion keys on the comput-

er). Click the volume

icon in the taskbar to

check the setting.

Figure2- 11
VIA HD Audio Deck

2 - 12 Audio Features
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Expert Mode will alow you to access more advanced configuration menus for "
Speaker, Microphone and Stereo Mix. ZX

Syncing Left & Right
Volume
Balance

If you wish to adjust the left
and right channel volume
levels separately, you will
need to adjust this from the
VIA HD Audio Deck in Ex-
pert Mode.

Click Speaker in VIA HD
Audio Deck (in Expert
Mode) and click the Sync
Left and Right volume
button (see left). You can
then adjust the volume slid-
ers independently (this set-
ting also controls the
Balance setting in the Win-
dows Sound control pan-
el).

Figure2- 12
VIA HD Audio Deck
(Expert Mode)

Audio Features 2 - 13
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Power Management

Chapter 3. Power Management P

Overview OS Note

To conserve power, especially when using the battery, your computer power man- | Power  management

. . functions will vary slight-
agement conserves power by controlling individual components of the computer ly depending on_ your

(the LCD and hard disk drive) or the whole system. This chapter covers: operating system. For
more information it is

« The Power Sources best to refer to the user’s

* Turning On the Computer ENE ©F o EREE:
ing system.

« Power Plans

» Power-Saving States (Note: All pictures used

» Configuring the Power Buttons on the following pages

are from the Windows 7

* Power Conservation Modes
0S))

» Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OSto set devicesinto low-power states based on user set-
tings and information from applications.

For information on the Windows 8 operating system see Appendix E.

. |
Overview 3 - 1
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4

Silent Mode
(For Some Model A
Designs Only)

Use the (W key to tog-
gle Silent Mode to re-
duce fan noise and save
power consumption.
Note this may reduce
computer performance.

The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Useonly the AC/DC adapter that comeswith your computer. Thewrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.

2. Plug the AC power cord into an outlet, and then connect the AC power cord to the
AC/DC adapter.

3. Raise the lid/LCD to a comfortable viewing angle.

4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet isunavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely beforerecharging (see“How do | completely discharge the battery?”

on page 3 - 15).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “ Battery Information” on page 3 - 11.

3 - 2 The Power Sources
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Turning On the Computer P

Now you are ready to begin using your computer. To turnit on simply pressthe pow-
er button on the front panel. Forced Off

; ; If the system “hangs”,
When the computer is on, you can use the power button as a Stand by/Hibernate/ i s G 2 T ]

Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and | ey combination doesn't
holding the power button for longer than this will shut the computer down). Use || work, press the power

Power Optionsin the Windows control panel to configure this feature. button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

4
Power Button as
Shut Down Stand by or

Note that you should always shut your computer down by choosing the Shut Down com- Hibernate Button

mand from the bottom right of the Start menu in Windows. This will help prevent hard disk
or system problems.

You can use the OS’s
Power Options control
panel to set the power
button to send the sys-
tem into Stand by or Hi-
bernate mode (see your
OS’s documentation, or
“Configuring the Pow-
er Buttons” on page 3
- 8 for details).

Turning On the Computer 3 - 3
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4

Resuming
Operation

See Table3 - 1, on
page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure3-1
Power Plan
Advanced Settings
(Win 7)

Power Plans

The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity.

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

3 - 4 Power Plans
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. Thisisworth bearing in mind if you are experiencing
any reduced performance (especialy under DC/battery power).

Choose High performance (you may need to click Show additional plansto view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered. The recommended Balanced power plan will balance power saving and per-

formance.
Figure3-2
Click to Show/Hide Power Plans
additional
power plans

. |
Power Plans 3 - 5
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Power-Saving States

Y ou can use power-saving states to stop the computer’ s operation and restart where
you left off. Win 7 uses the Sleep, Hiber nate and Shut Down power-saving states.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save al the
information to the hard disk and shut the computer down before the battery becomes
depleted.

3 - 6 Power-Saving States



Hibernate

Hiber nate uses the least amount of power of al the power-saving states and saves
al of your information on a part of the hard disk before it turns the system off. If a
power failure occursthe system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. Y ou should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut down

Y ou should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from Shut down takes longer than
from Sleep or Hibernate.

-

Power-Saving States 3 - 7

Power Management
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Silent Mode
(For Some Model A
Designs Only)

You can use Silent
Mode to reduce power
consumption and fan
noise.

Use the Silent Mode

hot key (N to toggle
this mode on/off.

On screen visual indica-
tors will display the Si-
lent Mode status (see
Table 1 -5, on page 1 -
15).

Note Silent Mode may
reduce computer perfor-
mance.

Figure3-3
Lock Button menu
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Configuring the Power Buttons

Z The power/seep button (Fn + F4 key combo) and closed lid may be set to send the
Password computer in to a power-saving state. Click Choose what the power buttons do on
PTHEERT the left menu in Power Options to bring up the menu.

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure3-4
Power Options
Define Power
Buttons

.|
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Resuming Operation

Y ou can resume operation from power-saving states by pressing the power button,

or in some cases pressing the sleep button (Fn + F4 key combo).

Orange (AC/DC adapter)

Power Status Icon Color To Resume
Power Off Off Press the Power Button
Press the Power Button
Sleep Blinking Green
Press the Sleep Button (Fn + F4 Key Combo)
Off (battery)
Hibernate Press the Power Button

Display Turned Off

Green

Press a Key or Move the Mouse/Touchpad

4

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).

Configuring the Power Buttons 3 - 9

Power Management

4

Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Table3-1
Resuming
Operation
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Power Conservation Modes

g This system supports Energy Star power management features that place comput-
3 Power Conservation ers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period
Modes of inactivity. Adjust Power Conservation Modes from the Control Center:

The Energy Star setting 1. Pressthe Fn + Esc key combination to toggle the Control Center on/off.
will result in maximum & 2 Click either the Performance, Balanced or Energy Star button.
power saving, but with 3. Click in a blank area of the icon or press a key on the keyboard to exit Power

the possible loss of Conservation Mode without making any changes.
some performance.

Setting the mode to Bal-
ance will give power
saving matched with
performance.

Performance will give
optimum computer per-
formance but with less
power conservation.

Figure3-5

Control Center
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Battery Information
Follow these simple guidelines to get the best use out of your battery.

Low Battery
Battery Power Warning

Y our computer’s bqttery power _is depender_n upon many factors, includi ng the pro-  BEVFESS i G
grams you are running, and peripheral devices attached. You can set actions to be B ETA e e
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from FeeliiEea G Aelb/e
power plan Change plan settings > Change advanced power settings (see Figure JaSaiaafe el

_ _ or save your work, oth-
3-1onpage3 4)' erwise, the unsaved

data will be lost when
the power is depleted.

Click the battery icon  [d in the taskbar to see the current battery level and charge
status.

Figure3-6
Battery Icon
(Taskbar) & Battery
Advanced Settings

.|
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Conserving Battery Power

Z » Useapower plan that conserves power (e.g Power saver), however note that
Windows Mobility this may have an affect on computer performance.
Center « Lower the brightness level of the LCD display. The system will decrease LCD
The Windows Mobility brightness slightly to save power when it is not powered by the AC/DC adapter.

gf)r\],tigés Z%merglsy ppa:)r;ﬁ: * Reduce the amount of time before the display is turned off.

of access forinformation | « Close wireless, Bluetooth, modem or communication applications when they are

on battery status, power not being used.

plans used and wireless ] _ )

device status etc. » Disconnect/remove any unnecessary external devices e.g. USB devices,
ExpressCards etc.

Figure3-7
Windows Mobility
Center

.|
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Battery Life

Battery life may be shortened through improper maintenance. To optimize the life
and improveits performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason (e.g. long term storage) see“ Removing the Battery”
on page6 - 4.

New Battery

Always completely discharge, then fully charge, a new battery (see “ Battery FAQ”
on page 3 - 15 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hoursto fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery chargetimeisless. (Refer to“LED Indica-
tors’ on page 1 - 11 for information on the battery charge status, and to “ Battery
Information” on page 3 - 11 for more information on how to maintain and properly
recharge the battery pack.)

.|
Battery Information 3 - 13
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Proper handling of the Battery Pack

7£l< * DO NOT disassemble the battery pack under any circumstances
Caution * DO NOT expose the battery to fire or high temperatures, it may explode
* DO NOT connect the metal terminals (+, -) to each other

Danger of explosion if
battery is incorrectly re-
placed.

RS

Damaged Battery Warning

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Should you notice any physical defects (e.g. the battery is bent out of shape after being

dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your distributor/supplier. If the battery has been dropped we
do not recommend using it any further, as even if the computer continues to work with a
damaged battery in place, it may cause circuit damage, which may possibly result in fire. It
is recommended that you replace your computer battery every two years.

.|
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Battery FAQ

How do | completely discharge the battery?

Use the computer with battery power until it shuts down due to alow battery. Don't

turn off the computer even if amessage indicates the battery iscritically low, just let
the computer use up al of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

Figure3-8
Power Plan Create
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3. Click Change plan settings (after creating it) and click Change plan settings >
Change advanced power settings.

Figure3-9
Change Plan
Settings / Change
Advanced Power
Settings

.|
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

Figure3- 10
Power Options
Advanced Settings -
Battery

* Low battery levels= 0%

» Critical battery Levels=1%

* Low battery action = Do Nothing

 Critical battery action (On battery) = Shut Down
» Critical battery action (Plugged in) = Do Nothing

.|
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How do | fully chargethe battery?
When charging the battery, don’t stop until the LED charging indicator light changes

from orange to green.
How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

.|
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Chapter 4: Drivers & Utilities

This chapter dealswith installing the drivers and utilities essential to the operation or
improvement of some of the computer’s subsystems. The system takes advantage of
some newer hardware components for which thelatest versions of most avail able op-
erating systems haven't built in drivers and utilities. Thus, some of the system com-
ponents won't be auto-configured with an appropriate driver or utility during
operating system installation. Instead, you need to manually install some system-re-
quired drivers and utilities.

See Appendix E for specific information on the Windows 8 operating system.

What to Install

TheDeviceDrivers& Utilities+ User’sManual disc containsthe driversand util-
ities necessary for the proper operation of the computer. Table4 - 1, on page4 - 3
listswhat you need toinstall and it isvery important that thedriversareinstalled
in the order indicated.

Module Driver Installation

The proceduresfor installing driversfor the PC Camera, WirelessL AN, Bluetooth
& WLAN Combo and 3.75G modules are provided in “Modules & Options’ on
page7 - 1.

What to Install 4 - 1

Drivers & Utilities

\ 7/
L&
Driver Installation &
Power

When installing driv-
ers make sure your
computer is powered
by the AC/DC adapter
connected to a work-
ing power source.
Some drivers draw a
significant amount of
power during the instal-
lation procedure, and if
the remaining battery
capacity is not adequate
this may cause the sys-
tem to shut down and
cause system problems
(note that there is no
safety issue involved
here, and the battery will
be rechargeable within 1
minute).




Drivers & Utilities

Driver Installation

Insert the Device Drivers & Utilities+ User’s Manual
discand click Install Drivers (button), or Option Driv-
ers (button) to access the Optional driver menu.

Figure4 - 1- Drivers Installer Screen 1

Check the driver installation order from Table 4 - 1,
on page 4 - 3 (the drivers must be installed in
this order) which is the same as that listed in the
Drivers Installer menu below.

Click to select the driver you wish to install, (you
should note down the drivers as you install them).
Follow the instructions for each individual driver
installation procedure as listed on the following
pages.

Figure4 - 2 - Install Drivers

4 - 2 Driver Installation
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Win 7 SP1/Win 8 Driver Page # Win 7 SP1/Win 8 Driver Page #

PC Camera Module
Chipset Page 4 -6 (Only 14.0” / 35.56cm Model A computers Page 7 - 2
require a camera driver for Windows 8)

Video (VGA) Page 4 -6 Wireless LAN Module Page 7 - 10

LAN Page 4 -6 Bluetooth & WLAN Combo Module Page 7 - 31

3G Module (for Models A & B only)

CardReader Page 4-6 No driver is required for Windows 8 Page 7-39
Touchpad Page 4 -6 Trusted Platform Module Page 7 - 64
i Intel Rapid Storage Technology i

Hot Key Page 4 -7 (required for hard disks in AHCI mode) Page 7-78
USB 3.0 (Win 7 Only) page4-7 | All driversprovided are for Windows 7 with Service Pack 1
(Not required for Windows 8) or Windows 8 (see Appendix E for Win 8 information).
MEI Driver Page 4 -7

Audio Page 4 -7

Table 4 - 1- Driver Installation

Notethat you need toinstall both the WLAN & Bluetooth driversthefor WLAN and Blutooth combo modules.

Driver Installation 4 - 3
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Manual Driver Installation

Click Browse CD/DVD (button) inthe Driversinstall-
er application and browse to the executable file in the
appropriate driver folder.

Windows Update

After installing all the drivers make sure you enable
Windows Updatein order to get all the latest security
updatesetc. (all updateswill includethelatest hotfixes
from Microsoft). See “Windows Update” on page 4 -
8 for instructions.

Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if itisnot listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+” to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.

4 - 4 Driver Installation



User Account Control

If aUser Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow theinstallation procedure as direct-
ed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

Y ou will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

Drivers & Utilities

New Hardware Found

If you see the message “New Har dwar e Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.

4

Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter
(and in Chapter 7 Options & Modules), are accurate at
the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.

Make sure any modules (e.g. PC Camera, WLAN or 3G)
are ON before installing the appropriate driver.

Driver Installation 4 - 5
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Driver Installation Procedure

Insert the Device Drivers & Utilities+ User’s Manual
disc and click Install Drivers (button).

Chipset

1. Click Llnstall Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

Video (VGA)

1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

Note: After installing the video driver go to the Dis-
play/Display Settings control panel to adjust the vid-
€0 Settings to the highest resolution.

LAN

1. Click 3.Install LAN Driver > Yes.
2. Click Next > Install.

3. Click Finish.

CardReader
1. Click 4.Install Cardreader Driver > Yes.
2. Click Finish.

Touchpad

1. Click 5.Install Touchpad Driver > Yes.

2. Click Next.

3. Click the button to accept the license agreement
and click Next.

4. Click Finish > Restart Now to restart the com-
puter.
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Hot Key

1. Click 6.Install Hotkey AP > Yes.
2. Click Next > Next.

3. Click Finish > Finish to restart the computer.

USB 3.0 (Win 7 Only)

1. Click 7.Install USB 3.0 Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

MEI Driver

1. Click 8.Install MEI Driver > Yes.
2. Click Next > Yes> Next.

3. Click Finish to restart the computer.

Drivers & Utilities

Audio

1. Click 9.Install Audio Driver > Yes.

2. Click Next.

3. Click the button to agree to the license and
click Next.

4. Click Next > Next > Next.

5. Click Finish to restart the computer.

Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, gect
the Device Drivers & Utilities + User’s Manual disc
and thenreinsert it (or double-click thedisciconinMy
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.

It isrecommended you now also install the Intel Rap-
id Storage Technology driver (see“|RST Driver In-
stallation” on page 7 - 78 - required for AHCI mode
hard disks).

(see over)
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4
Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Click Start, and click Control Panel (or point to
Settings and click Control Panel).

2. Click Windows Update (System and Security/
Security).

3. Click Check for updates (button).

4. The computer will now check for updates (you
need to be connected to the internet).

5. Click Install now (button) to begin checking for the
updates.

6. Click Install updates (button) to install the
updates.

Windows Experience Index

After the drivers are installed follow this procedure to

ensure an accurate rating from the Windows Experi-

ence I ndex (make sure the AC/DC adapter is plugged
in):

1. Click Sart, and click Control Panel.

2. Click Performance Information and Tools
(System and Security > System > Check the
Windows Experience I ndex).

3. Click “Ratethis computer/Refresh Now/Re-
run the assessment”.

4. The computer will take afew minutesto assess
the system performance.

5. Close the control panel.
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Optional Drivers

See the pages indicated in Table 4 - 1, on page 4 - 3 for the driver installation procedures for any modules in-
cluded in your purchase option.

Figure 4 - 3 - Option Drivers
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Chapter 5: BIOS Utilities "

Overview BIOS Screens

This chapter gives a brief introduction to the computer’ s built-in software: i e e B
screens  pictured on

. these pages are intend-
If your computer has never been set up, or you are making important changesto the BESEERIREREE IRE

system (e.g. hard disk setup), then you should review this chapter first and note the B FSEeNIE S R
original settings found in Setup. Even if you are abeginner, keep arecord of the set-  JHEISES
tings you find and any changes you make. This information could be useful if your

- BIOS versions are sub-
system ever needs servicing. ject to constant change

and revision, therefore
Thereis one general rule: Don’t make any changes unless you are sure of what you VSISl lE]

. . . : screens may appear
aredoing. Many of the settings are required by the system, and changing them could slightly _ different _from

cause it to become unstable or worse. If you have any doubts, consult your service  BEFSEE IS T
representative. pages.

. |
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BIOS Settings
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Pre-
vious Values with
<F2>, or Optimized De-
faults with <F3>.

UEFI Boot & POST

When UEFI Boot is en-
abled, then the prompts
to press F2 or F7 will
not appear. However
you can still press F2 to
enter the setup, or F7 to
choose the preferred
boot device, if you press
the key immediately the
system boots up.

The Setup Utility

Each time you turn on the computer the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

Asthe POST proceeds, the computer will tell you if thereisanything wrong. If there
isaproblem that prevents the system from booting, it will display asystem summary
and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can't get into Setup without rebooting.

The Aptio Setup Utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

To enter Setup, turn on the computer and press F2 (give the system a few seconds
to enter Setup). If the Boot L ogo is enabled the F2 on screen will be highlighted to
illustrate that the system is processing the request during the POST (or press F7 for
boot options). If you get a*“Keyboard Error”, (usually because you pressed F2 too
quickly) just press F2 again.

If the computer is aready on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

To see the boot options press F7 and choose your preferred boot device.

5 - 2 The Setup Utility
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Failing the POST
Errors can be detected during the POST . There are two categories, “fatal” and “non-
fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) and you can then press F7 (the F7 on screen
will be highlighted to illustrate that the system is processing the request) for boot
options.

Press F2 (give the system a few seconds to enter Setup; the F2 on screen will be
highlighted to illustrate that the system is processing the request) to run the Setup
program and try to correct the problem. If you still get an error message after you
change the setting, or if the “cure” seems even worse, call for help.
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4

Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer's menus will
indicate the configura-
tion appropriate for your
model and options.

Figure5-1
Navigation Menu

Setup Screens

The following pages contain additional advice on portions of the Setup. Along the
top of the screen is a menu bar with menu headings. When you select a heading, a
new screen appears. Scroll through the features listed on each screen to make chang-
esto Setup.

Instructions on how to navigate each screen are in the box at the bottom right side of
the screen.

If these tools are confusing, press F1 to call up aGeneral Help screen, and then use
the arrow keysto scroll up or down the page.

Theltem Specific Help onthe upper right side of each screen explainsthe highlight-
ed item and has useful messages about its options.

If you see an arrow p next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.
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Main Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

System Date

Figure5-2
Main Menu

System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @@ = midnight; 13 = 1 pm). If you
can change the date and time settingsin your operating system, you will aso change
these settings. Some applications may also alter data files to reflect these changes.

Main Menu 5 - 5



BIOS Utilities

SATA Port # (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a optical Device/
HDD on the computer’s SATA Ports.

System/Extended Memory: (Main Menu)
Thisitem contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

MB Series/ BIOS Revision / KBC/EC firmware Revision
This item contains information on the BIOS version etc., and is not user configu-
rable.
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Advanced Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

Figure5- 3
Advanced Menu

P Advanced Chipset Control

Advanced Chipset Control (Advanced Menu)
The sub-menu here alows you to adjust the Bluetooth Power Setting.
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SATA Mode
Selection

If you have installed the
Windows operating

system with either IDE
or AHCI mode enabled,
DO NOT disable the set
mode (if you wish to dis-
able the set mode you
will need to reinstall the
Windows OS).

Bluetooth Power Setting (Advanced Menu > Advanced Chipset Control)

Y ou can adjust the Bluetooth module power setting to your preference. The default
setting (Disabled) will see the Bluetooth module powered off when the system is
started up or restarted. Enabling the power setting will have the module retain the
last power status (on or off) before any restart or shut down.

SATA Mode Sl ection (Advanced Menu)

Y ou can configure SATA (Serial ATA) control to operate in | DE (native/compati-
ble), AHCI (Advanced Host Controller Interface) modes from this menu. The
SATA Mode should be set BEFORE installing an oper ating system, and after you
have backed up all necessary files and data (see sidebar).

Boot Logo (Advanced Menu)

Use this menu item to enable/disable the Boot L ogo screen at system startup. If you
disable the Boot L ogo you will not see the F2 Enter Setup or F7 Boot Options
prompts on the screen, however you can still press these keys, while the boot screen
is displayed, to perform the Enter Setup or Boot Option functions.

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep: (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
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Security Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

4

Security Menu

The changes you make
here affect the access
to the Setup utility itself,
and also access to your
machine as it boots up
after you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in your
software OS.

Secure Boolk Mode [Standard]

Secure Boot Mode
Standard
Custom

Figure5-4
Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Aptio Setup Utility. This will not affect
access to the computer OS (only the Aptio Setup Utility).
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N2
2

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled), NEVER
forget your password.

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Set User Password (Security Menu)

Y ou can set a password for user mode access to the Aptio Setup Utility. Thiswill
not affect access to the computer OS, (only the Setup utility) unless you choose to
set a Password on Boot (see below). Many menu items in the Aptio Setup Utility
cannot be modified in user mode.

Note: You can only set the user password after you have set the supervisor pass-
word.

Password on boot: (Security Menu)

Specify whether or not apassword should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is“ Disabled”.

.|
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Secure Boot (Security Menu)

Secure Boot prevents unauthorized operating systems and software from loading
during the startup process. Secure Boot is available as a menu option if you have
Windows 8 set as your operating sytem, and have enabled UEFI Boot (see “ Boot
Menu” on page 5 - 15). Enabling Secure Boot will bring up the Secure Boot M ode
menu to enable you to configure Secure Boot as Standar d (with afixed secure boot
policy), or Custom (which enables you to make changes to the | mage Execution
Policy and Key Management database).
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Figure5-5
TPM Support

TPM Configuration (Security Menu)

This sub-menu will allow you to enable/disable Trusted Platform Module (TPM)
support, and to configure the TPM State. Select TPM Configuration and press En-
ter to access the sub-menu. Press Enter to accessthe TPM Support menu and select
Enable to display the full TPM configuration menu (see “ Trusted Platform Mod-
ule” on page 7 - 64 for details).

Aptio Setup Utility — Copyright (C) 2011 American Megatrends Inc.

TPM SUPPORT [Disable]
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TPM Sate (Security Menu > TPM Support Enabled)
Select TPM State, press Enter and select Enable to change the TPM state to en-
abled. Y ou will then need to press F4 to save the changes and restart the computer.

Aptio Setup Utility — Copyright (C) 2011 American Megatrends Inc.

TPM SUPPORT [Enable] Figure 5-6
TPM State (Enabled)

Asthe computer restarts press F2 to enter the BIOS again and go to the TPM Con-
figuration menu.
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Figure5-7
Pending TPM
operation
(Enable Take
Ownership)

5 - 14 Security Menu

Pending TPM operation (Security Menu > TPM Support & TPM Sate Enabled)
Select Pending TPM operation, press Enter and select the option you require (if
you areinitializing TPM you should select Enable Take Owner ship). Y ou will then
need to press F4 to save the changes and restart the computer. Y ou can now install
the TPM driver (see “ Trusted Platform Module (TPM) Driver Installation” on
page 7 - 67) and then initialize the TPM.

Aptio Setup Utility — Copyright (C) 2011 American Megatrends Inc.

Pending TPM operation [Hone]

Pending TPM operation
Hone
Enable Take Ownership
Disable Take Owmership
TPM Clear
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Boot Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

Boot .
Figure5-8
Boot Menu

Boot Opticn #1 [Windows Boot Manager]

SN
ALK

BIOS Screens

Note that the BIOS
screens  pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore

S . your computer's actual
When you turn the computer on it will look for an operating system (e.g. Windows TS TR Cpeey

7) from the devices listed in this menu, and in this priority order. If it cannot find ~ EESFRRIENHAEAEE T
the operating system on that device, it will try to load it from the next device in the B GEEETREEL R NG
order specified in the Boot Option Priorities. Item specific help on the right is §EEESE

available to help you move devices up and down the order.
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Boot Option Priorities (Boot Menu)

(If UEFI Boot is disabled)

Press Enter to select the Boot Option # and use the + and - keys to move any de-
vice's boot priority up and down the list (the selected device will be highlighted in
white).

OS Slect (Boot Menu)
This item tells alows you to set the operating system you intend to use. Thisitem
should be set before you install an operating system.

UEFI Boot (Boot Menu > OS Select)

Enable/disable UEFI Boot from this menu. The Unified Extensible Firmware Inter-
face (UEFI) specification provides a clean interface between operating systems and
platform firmware at boot time. In contrast to BIOS, UEFI defines a set of standard
boot and runtime services.

5 - 16 Boot Menu
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Exit Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

o Figure5-9
Exit Menu

Save Changes and Reset

Click Save Changes and Reset to save al changes made. Choosing to Discard
Changes, or Exit Discarding Changes, will wipe out any changes you have made
to the Setup. Y ou can also choose to restore the original Setup defaults that will re-
turn the Setup to itsoriginal state, and erase any previous changes you have madein
aprevious session.

Exit Menu 5 - 17
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Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problemsyou can con-
tact your service representative for further help. Before you begin you will need:

» A small crosshead or Phillips screwdriver
* A small regular slotted (flathead) screwdriver
e Anantistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

* Removing the Battery

» Upgrading the Hard Disk Drive

» Upgrading the Optical (CD/DVD) Device
» Upgrading the System Memory (RAM)

Please make surethat you review each procedur e before you perform it.

N2
2

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Overview 6 - 1
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When Not to Upgrade
7£l< These procedures involve opening the system’ s case, adding and sometimes replac-
Power Safety Warning ing parts.

el e EREIE] Y ou should not perform any of these upgradesif:

any upgrade proce-

AU ELE SRRl ¢ Your system is still under warranty or a service contract
VELEVERCIG GRSl «  You don't have all the necessary equipment
SOUEEEEEEEEEE . You're not in the correct environment

ed all peripherals and
cables (including tele- [N You doubt your abilities

PRONEHINES GNCIROWEES g any of these conditions, contact your service representative to purchase or re-

place the component(s).

cord).

You must also remove
your battery in order to
prevent accidentally
turning the machine on.
Before removing the
battery disconnect the
AC/DC adapter from
the computer.

2N
2L &
Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before restoring power to the system.

Also note the following when the cover is removed:

e Hazardous moving parts.
» Keep away from moving fan blades.

. |
6 - 2 Overview
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Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with afast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.

Overview 6 - 3
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SN
L&

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure6-1
Battery Removal

Removing the Battery

If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery.

1.

2.
3.
4

Turn the computer off, and turn it over.

Slide the latch @ in the direction of the arrow.

Slide the latch @ in the direction of the arrow, and hold it in place.
Slide the battery out in the direction of the arrow @.

6 - 4 Removing the Battery
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Upgrading the Hard Disk Drive

\ A/
The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard ’Ll\
disk drives with a height of 9.5mm (h) (see“ Storage” on page D - 3). Follow your HDD System
operating system’ sinstallation instructions, and install all necessary driversand util- SUELLIRE
ities (see “ Driver Installation” on page 4 - 2), when setting up a new hard disk. New HDD's are blank. Be-

fore you begin make sure:
You have backed up any
data you want to keep from
your old HDD.

You have all the discs re-
quired to install your oper-
ating system and
programs.

If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

Upgrading the Hard Disk Drive 6 - 5
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1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws @ & @.
3. Remove the hard disk bay cover @.

Figure6- 2
Hard Disk Bay
Cover Removal

@
®

6 - 6 Upgrading the Hard Disk Drive



Nogas

Upgrading The Computer

Slide the hard disk in the direction of arrow @.
Lift the hard disk out of the bay @. V4
Remove the screw(s) @ - € and the adhesive cover @.

Reverse the process to install a new hard disk drive (do not forget to replace all the Hard Disk Screws &
screws and covers). Cover

The hard disks and cov-
ers pictured here may
appear slightly different
from your model design
e (these designs are sub-

ject to change and up-
grade without notice).
Pay careful attention to
the screws (if included)
and cover orientation.

Figure6- 3
6 Hard Disk Removal

Upgrading the Hard Disk Drive 6 - 7
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Upgrading the Optical (CD/DVD) Device

The procedure for removing the optical device will depend upon your particular
computer model:

» See"Removing the Optical Device for Model A Computers’ on page 6 - 9.

» See“Removing the Optical Device for Model B & C Computers’ on page 6 -
11.

.|
6 - 8 Upgrading the Optical (CD/DVD) Device



Removing the Optical Device for Model A Computers

1.
2.
3.

4,

Upgrading The Computer

\ A/
Turn off the computer, and turn it over and remove the battery. 7&‘
Locate the component bay cover and remove screws @ - @. Fan Cable & Cover

Carefully (a fan and cable are attached to the under side of the cover) lift up

the bay cover.

Make sure you recon-

Carefully disconnect the fan cable @, and remove the cover @. nect the fan cable 5

(2]
®

before screwing down

the bay cover. Note the
information on replac-
ing the RAM & CPU
bay cover in

Figure6- 4
Removing the
Component Bay

6 Cover
(Model A

Computers)

Upgrading the Optical (CD/DVD) Device 6 - 9
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5.  Remove the screw at point @), and use a screwdriver to carefully push out the
optical device at point @.
6. Reverse the process to install the new device.

Figure6-5
Removing the a
Optical Device @
(Model A
Computers)

6 - 10 Upgrading the Optical (CD/DVD) Device
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Removing the Optical Device for Model B & C Computers

1. Turn off the computer, and turn it over and remove the battery.

2. Remove the hard disk (see page 6 - 5)

3. Remove the screw at point 0 and use a screwdriver to carefully push out the
optical device at point @.

4. Reverse the process to install the new device.

5. Replace the hard disk bay cover.

Figure6- 6
Removing the a
- Optical Device
(Model B & C
o Computers)

2] 2]

Upgrading the Optical (CD/DVD) Device 6 - 11
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Upgrading the System Memory (RAM)

The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-
DIMM) DDRIII (DDR3) type memory modules (see “Memory” on page D - 2 for
details of supported module types).

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws @ - @.

(1) (1)
(2] (2]
(3] ®
Figure6-7 o (4]
Component Bay
Cover Screws
o
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3. Raise the bottom cover up and carefully (a fan and cable @ are attached to the
under side of the cover) lift up the bay cover @. DA
Model A Fan Cable
Make sure you recon-
@ nect the fan cable 5

before screwing down
the bay cover.

5] 5]

Model B

(5) © Figure6- 8
Component Bay
Cover Removal

Model C
(6]

Upgrading the System Memory (RAM) 6 - 13
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Figure6-9
RAM Module
Release Latches

SN
ALK

Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the cleanest
hands have oils which
can attract particles, and
degrade the module’s
performance.

Figure6 - 10
RAM Module
Removal

4.

5.

Gently pull the two release latches on the sides of the memory socket in the
direction indicated by the arrows (@ & @) in Figure 6 - 9.

(8]

The RAM module will @) pop-up, and you can remove it.

4

Single Memory Module
Installation

If your computer has a single memory
module, then insert the module into the
Channel 0 (JDIMM1) socket. In this
case this is the lower memory socket
(the socket closest to the mainboard).

6 - 14 Upgrading the System Memory (RAM)
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10.

11.

12.

.|
Upgrading the System Memory (RAM) 6 - 15

Upgrading The Computer

Pull the latches to release the second module if necessary.

Insert a new module holding it at about a 30° angle and fit the connectors firmly
into the memory slot.

The module’s pin alignment will allow it to only fit one way. Make sure the module
is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit
without much pressure.

Press the module in and down towards the mainboard until the slot levers click into
place to secure the module.

Replace the bay cover by inserting it at an angle and aligning the cover pins (see
sidebar).

Make sure you reconnect the fan cable before replacing all the screws and
screwing down the bay cover.

Restart the computer to allow the BIOS to register the new memory configuration
as it starts up.

4

Cover Pins

Note that the computer
has four cover pins.
These pins need to be
aligned with slots in the
case to insure a proper
cover fit, before screw-
ing down the bay cover.

Figure6- 11
Cover Pin
Alighment
(One Model
Pictured)
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Chapter 7: Modules & Options %

Y/

\§

1 Wireless Device
OverV|eW Operation Aboard
This chapter contains information on the following modules, which may come with Aircraft
your computer, depending on the configuration purchased. If you are unsure please B eSS el
contact your service representative. electronic transmission de-

vices aboard aircraft is usu-
* PC CameraModule e 3G Module ally prohibited. Make sure
» WiredlessLAN Module  Trusted Platform Module ;*;i xduus'ii(g)th?ioﬁ;;;:
* Bluetooth & WLAN Combo Module « Intel Rapid Storage Technology T B

For information on the Windows 8 operating system see Appendix E.

4

Driver Installation &
Module Power

Make sure any modules
(e.g. WLAN, PC Camera &
Bluetooth modules) are ON
before installing the appro-
priate driver.

. |
Overview 7 - 1
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7 - 2 Overview

\ A/
2§
Important Notice
If your purchase option includes both Wireless LAN and 3G modules, then the appropriate
antennas will be installed. Note that In order to comply with FCC RF exposure compliance

requirements, the antenna must not be co-located or operate in conjunction with any other
antenna or transmitter.

Important Notice - 3G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G module and the
Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency, and
cause interference. When the 3G module is powered on, make sure that the Bluetooth/
Wireless LAN modules are powered off.
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PC Camera Module e

Before installing the PC Camer a driver, make sure that the optional PC Camerais -
on. Use the Fn + F10 key combination (see “Function/Hot Key Indicators’ on
page 1 - 15) or Control Center button to toggle power tothe PC Cameramodule.
Make sure you install the driversin the order indicated in Table 4 - 1, on page 4 - 3. [ S S UERREE RIS

See“PC Camera (Windows 8)” on page E - 25 for Windows 8 configuration infor- i - RIERaEaie
Manual disc, and any

mation. accompanying  insert
Notethat only 14.0" / 35.56cm Model A computersrequireacameradriver for pages, for the latest up-
Windows 8. When the 14" /35.56cm screen Model A PC Camera is in use the geged 'gt:r:ﬁ?;on gzvtgf
power LED indicator will blink orange (see Table1- 2, on page 1 - 11). which may override the

information provided

When the Model B/C PC Cameraisin usethe LED indicator to theleft of the camerawill be  BESSE
illuminated in red (see @ Figure 1 - 4 on page 1 - 9/Figure 1 - 5on page 1 - 10).

Latest PC Camera
Driver Information

. . . . PC Camera Driver Un-
There are anumber of different cameramodules available with this computer model installation

series. You will have the appropriate application installed for your camera. Make .
L . If you need to uninstall
sure you access the application via the desktop shortcut. the driver. then uninstall

_Il/_ the WebCam Installer
N item from the Programs

PC Camera Application and Power-Saving States and Features control
panel in Windows.

If the computer enters Sleep or Hibernate mode while running the camera application, the

program will stop running, and will need to be restarted when the system resumes from the
power-saving state.

PC Camera Module 7 - 3
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PC Camera Driver Installation

ﬁ 1. Make sure the module is powered on, and then insert the Device Drivers &
PC Camera Screen Utilities + User’s Manual disc into the DVD drive.
Refresh 2. Click Option Drivers (button).
ey s ——— 3. Click 1.Install Webcam Driver > Yes.
it e | 4 Click Finish to restart the compuiter.
12 fps. If you find that OR
(S i =i 4. Click Next > Finish.
SEEERCREE TS 5. Run the camera application program from the desktop shortcut (if the hard-
S iz reduced_”‘et wareisturned off use the Fn + F10 key combination to turn it on again).
the OutLL Siae andlo See“PC Camera (Windows 8)" on page E - 25 for information on the cam-
put Size and/or L. .

sion.

To reduce Output Size
and/or Color Space
Compression run the
camera application,
click Options and select
Video Capture Pin. Ad-
just the settings from the
appropriate  pull-down
menu.

7 - 4 PC Camera Module



Modules & Options

PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

Click Start, and click Control Panel (or point to Settings and click Control Panel).
Click Sound  (Hardware and Sound).

Click Recording (tab).

Right-click Microphone (VIA High Definition Audio) and make sure the item is not
disabled.

Double-click Microphone (or select Properties from the right-click menu).

Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to
the level required.

7. Click OK and close the control panels.

Run the camera application program from the desktop shortcut.

Go to the Devices menu heading and select Microphone (VIA....) (it should have
a tick alongside it).

10. Go to the Capture menu heading and select Capture Audio (it should have a tick
alongside it).

PwODNE

o u

© ©
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Figure7-1
Audio Setup for PC
Camera

Right-click

7 - 6 PC Camera Module
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Camera Application
The cameraapplicationisavideo viewer for general purpose video viewing and test-
ing, and for capturing video filesto .avi format.

1. Runthe camera application from the desktop shortcut (it is recommended that you
set the capture file before the capture process - see Set Capture File below).

2. Gotothe Capture menu heading (if you wish to capture audio check “PC Camera
Audio Setup” on page 7 - 5) and select Start Capture.

3. Click OK (the file location will be displayed in the pop-up box) to start capturing the
video, and press Esc to stop the capture (you can view the file using the Windows
Media Player).

Set Capture File

Prior to capturing video files you may select the Set Capture File... option in the
File menu, and set the file name and |ocation before capture (thiswill help avoid ac-
cidentally overwriting files). Set the name and location then click Open, then set the
“Capturefilesize:” and click OK. Y ou can then start the capture process as above.

Note the important information in “ Reducing Video File Size” on page 7 - 8 in or-
der to save file space, and help prevent system problems.

. |
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Reducing Video File Size

Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (goto My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to aremovable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows system requires a minimum of 15GB of free space on the C:
drive system partition. In order to prevent system problemsit is recommended that
you save the captured video file to alocation other than the C: drive (see“ Set Cap-
ture File” on page 7 - 7), limit the file size of the captured video or reduce video
resolution (see below).

To Reduce Video Resolution Qutput Size:

1. Run the camera application program from the desktop shortcut.

2. Go to Options and scroll down to select Video Capture Pin....

3. Click the Output Size drop box and select a lower resolution size in order to
reduce the captured file size.

4. Click OK.

7 - 8 PC Camera Module



Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to
adjust the setting in the Video Capture Filter options.

1. Run the camera application from the desktop shortcut.
2. Goto Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under PowerLine Frequency.

4

Camera Options

The video capture filter
figure pictured here may
appear slightly different
for some camera mod-
ules. To adjust the anti
flicker properties look un-
der the headings Anti
Flicker/Frequency/Pow-
erLine Frequency.

PC Camera Module 7 - 9
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\ A/

Z &
Latest PC Camera
Driver Information

Check the Device Driv-
ers & Utilities + User’s
Manual disc, and any
accompanying insert
pages, for the latest up-
dated information on the
PC Camera driver,
which may override the
information provided
here, including the fig-
ures pictured.

Figure7-2
Video Capture Filter
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Taking Still Pictures
& The camera application allows you to take still pictures.

Snapshot Folder 1. Run the camera application from the desktop shortcut.
The' Snapshot folder's 2. Goto Options and select Take Picture.
T 3. The picture (in JPEG format) will be placed in the Snapshot folder on the

desktop. Do not move desktop.
this folder or an error
may appear when you

try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.

. |
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Wireless LAN Module S

/
If you haveincluded an Intel® or 3rd Party WirelessLAN (or WLAN & Bluetooth Wirele/fsl;evice
combo) module in your purchase option, make sure that the WLAN moduleison be- Operation Aboard
foreinstaling thedriver. See“ Wireless LAN Settings (Windows 8)” on page E - 30 A
for Windows 8 configuration information.

The use of any portable

S . . lectronic t ission de-
Use the Fn + F11 key combination (see “ Function/Hot Key Indicators’ on page 1 Siig’;f;ﬁ'gar?i;il”ﬁji'i‘;”usﬁ_

- 15) or Control Center button to toggle power to the Wireless LAN module. gl ChisiEEEECEEE
Make sure you install the driversin the order indicated in Table4 - 1, on page 4 - 3. [ EEEEOREER

you are using the computer

aboard aircraft.

Note that you need to install both the WLAN & Bluetooth drivers for the Combo

Use the Fn + F11 key com-
WLAN and Bluetooth modules. bination or hot key button to

toggle power to the WLAN
module, and check the indi-
cator to see if the module is
powered on or not (see

/

Wireless LAN Module 7 - 11
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3rd Party 802.11b/g/n Driver Installation (for WLAN Module)

See over for information on installing thedriversfor the 3rd party WLAN & Blue-
tooth combo module.

If you see the message “Found New Hardwar e’ click Cancel to close the window.

1. Makesurethemoduleis powered on, and then insert the Device Drivers
& Utilities + User’s Manual disc into an attached DVD drive.

Click Option Drivers (button).

Click 2.Install WLAN Driver > Yes.

Choose the language you prefer and click Next.

Click Next.

Click Finish to restart the computer.

SOUkWN

Note: The operating system is the default setting for Wireless LAN control in Win-
dows (see page 7 - 17). See “ Wireless LAN Settings (Windows 8)” on page E - 30
for Windows 8 configuration information.

. |
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3rd Party 802.11b/g/n Driver Installation (for Combo Modules)
If you see the message “Found New Hardwar €’ click Cancel to close the window.

1. Makesurethemoduleis powered on, and then insert the Device Drivers
& Utilities + User’s Manual disc into an attached DVD drive.

2. Click Option Drivers (button).

3. Click 2.Install WLAN Driver > Yes.

4. Click Next (if aprompt appearsto ask you to turn the Bluetooth power on,
pressthe Fn + F12 key combination to do so, otherwise the driver will not
be installed).

5. Click Finish to restart the computer (see sidebar for important information).

Note: The operating system is the default setting for Wireless LAN control in Win-
dows (see page 7 - 17). See “Wireless LAN Settings (Windows 8)” on page E - 30
for Windows 8 configuration information.

. |
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Intel® WLAN Driver Installation

For a standard Intel® WLAN driver installation and configuration choose the Typ-
ical Installation below and use the Windows OS for Wireless LAN control (see
over leaf). If youwant to use | ntel® PROSet/WirelessWiFi Connection Utility as
your WLAN interface, and/or add Intel® MyWifi Technology (Personal AreaNet-
work) see overleaf.

Typical Installation:

1.

2.

N U~ W

If you see the message “Found New Hardware” click Cancel to close the
window.

Make sure the moduleis powered on, and then insert the Device Drivers
& Utilities + User’s Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 2.Install WLAN Driver > Yes.

Click Next > Next.

Click the button to accept the license and click Next.

Click Typical > Install.

Click Finish.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows (see“ Connecting to a Wireless Network in Windows 77 on page 7 - 17). See
“WirelessLAN Settings (Windows 8)” on page E - 30 for Windows 8 configuration
information.
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Custom Installation (for Intel® ProSet and/or Intel® MyWiFi Technology):
Note that if you wish to install Intel® MyWiFi you will need to install Micro-
soft.net Framework 4.0 (or later version) beforeinstalling the driver as per the
procedure below. To get the Microsoft.net Framework file go to the Microsoft
website, search for the file, Download it and then install it.

1. If you see the message “Found New Hardware” click Cancel to close the
window.

2. Makesurethe moduleispowered on, and then insert the Device Drivers

& Utilities + User’s Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 2.Install WLAN Driver > Yes.

Click Next > Next.

Click the button to accept the license and click Next > Custom.

Toinstal Intel® MyWiFi Technology click theicon alongside Intel®

MyWiFi Dashboard and select “ Entire feature will beinstalled on local

hard drive’ (see Figure7 - 3 on page7 - 16).

8. Toinstal Intel® PROSet/Wireless WiFi Connection Utility click theicon
alongside it and select “ Entire feature will be installed on local hard
drive’ (seeFigure7 - 3 0n page7 - 16).

9. Click Next > Install > Finish.

10. See“(For Intel® WLAN Modules Only)” on page 7 - 20 or “Intel® My
WiFi Configuration” on page 7 - 22 for further information.

NoOA®
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Figure7-3 C>

Install Intel® MyWiFi
Technology & Intel®

PROSet/Wireless
7 WiFi Connection
Utility

S
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Connecting to a Wireless Network in Windows 7

Make sure the Wireless LAN module is turned on. e

1. Click the taskbar wireless icon ¥, and then double-click an access point to con- Network and
nect to or click to Open Network and Sharing Center if you do not see a network Sharing Center
you want to connect to in the taskbar menu (a list of options will appear allowing

setting changes, and creating a new network). LSl el U e bl

work and Sharing Cen-
ter control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure7-4
Click Taskbar Icon
Menu & Network
and Sharing Center
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2. You may need to enter a security key for any access point to which you are trying
to connect.

3. Click to select a network location (e.g. Home, Work or Public).

4. Click “View or change settings in Network and Sharing Center” to access
further options for the connection.

Figure7-5
Network Location
Set
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5. Click the taskbar icon g to see any currently connected networks.
6. To disconnect from the wireless network you can click the taskbar wireless icon |, ﬁ

7 \Y
click the active connection and then click Disconnect (button). .
Security Enabled

Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure net-
works may allow unauthor-
ized access to your
computer, documents, web-
sites and files etc.

Figure7-6
Click Taskbar Icon
Menu - Disconnect
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Connecting to a Wireless Network Using Intel® PROSet Wireless

(For Intel® WLAN Modules Only)

1. Make sure the Wireless LAN module is on.

2. Access the Intel® WiFi Connection Utility from the Start menu (Start > All
Programs > Intel PROSet Wireless > WiFi Connection Utility).

3. Click to select a network from the found list WiFi network access points, or click
Refresh to update the list.

Figure7-7
Intel® PROSet/
Wireless WiFi

Connection Utility
(Connect)
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4. Click Connect to connect to the select WiFi network access point.

5. If the access point is encrypted then you will need to enter the password and click
OK.

Figure7-8
Intel® PROSet/
Wireless WiFi

Connection Utility
(Connecting &
Connected)

o

You can turn WiFi On/WiFi Off from the button at the bottom of the Utility.
To disconnect, select the connected access point and click Disconnect.

8. Select Help from the menu at the top of the utility (or at the bottom right) to bring
up the Help menu.

~
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Intel® My WiFi Configuration

a (For Intel® WLAN Modules Only)

Intel® My WiFi Technology (Intel® MWT) uses your WLAN to transform your
system into a Wi-Fi Personal Area Network, and enables you wirelessly share your
To get help on Intel® = videos, photos, music with other WiFi enabled devices, while still connecting to the

My WIiFi configuration § | nternet through your WiFi wireless connection.
and settings, access the

Intel® My WiFi Dash- ) ) .
board from the Start Intel® MWT also features achat function, and offers you the option of being able to
menu (Start > All Pro- & create a WiFi hotspot from your computer. Intel® MWT offers greater range and

grams > Intel PROSet | gpeed than other personal area networks, and does not require an access point.
Wireless > Intel(R) My

WiFi Dashboard), or by
clicking the taskbar
icon®. click the Help
icon in the dash-
board and select a help
topic from the Contents
menu.

Intel® My WiFi Help
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Intel® My WiFi Configuration
Y ou can configure the My WiFi settings as follows.

1. Make sure the Wireless LAN module is on.

2. Access the Intel® WiFi Connection Utility from the Start menu (Start > All
Programs > Intel PROSet Wireless > Intel(R) My WiFi Dashboard), or click the
icon £ in the notification area of the taskbar (or right-click and select Open
Dashboard).

3. Aninitial welcome message will appear on the first run of the program (click “Don’t
show this message again” to turn this off in future).

Figure7-9
Intel® My WiFi
Utility - Welcome

. |
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Intel® My WiFi Interface

Figure7 - 10
Intel® My WiFi

Utility - Interface
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Intel® My WiFi Help
Click theHelp icon  in the dashboard to bring up the Help menu and select and
item from the Contents menu to obtain the help information.

Figure7-11
Intel® My WiFi

Utility - Help
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Preferences
Click the Optionsicon [=] and select Prefer ences to configure the options.

Figure7 - 12
Intel® My WiFi
Utility - Preferences
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Hotspot
Y ou can turn the computer into a hotspot to allow other devicesto connect to it (and
any locally connected devices), and also (if available) the internet.

1. Click the Hotspot icon to turn the Hotspot on.

2. The Hotspot settings tab shows the SSID and password (you will need to enter
this information when accessing the hotspot from the client computer/device).

3. Click OK to close the Hotspot settings.

Figure7- 13

Intel® My WiFi
O Utility - Hotspot

. |
Wireless LAN Module 7 - 27



Modules & Options

Finding Devices

You can find any Nearby Devices by clicking the Refresh button in the main
window. Click again at any time to update the list. If alot of devices are found they
will be listed on multiple pagesand you can usetheleft  orright  buttonstoturn
the pages.

Sensitivity

The Sensditivity controls displays available devices based on their signal strength

and proximity e.g decreasing (-) the sensitivity lists only devices closest to the com-
puter’s location.

Group Devicesby Type

If you click Group by typeit will list all devices according to their type in afolder
group. Double-click on any group folder to see the devices of that type listed. There
are 12 possible device types available.

Search
If you want to search for a particular device by name then enter the device namein
the Search field to return results for devices matching the name of the device.
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Favorite Devices
The Favorite Devicestab is where you keep devices to which you connect most of -
ten, and this is particularly useful in environments where many devices are listed

nearby. A favorite device will display theicon

To make any device afavorite just click to select it and select Add Favorite.

Figure7- 14
Intel® My WiFi
Utility - Interface

. |
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Connect to a Device

Click the device you want to connect to, and click the connect icon

An invitation will be sent to the target device.

The user must then accept the invitation.

After the invitation is accepted the connection will be made.

Use the Windows Network and Sharing Center to set permissions for viewing
and sharing the resources on your computer with another connected computer.

agpNE

Further Information

For information on how to block/unblock devices, setting Do Not Disturb, sharing
an internet connection and chat options see “Intel® My WiFi Help” on page 7 -
25.
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Windows Mobility Center

The Windows Maobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:

1. Click Start, and click Control Panel (or point to Settings and click Control
Panel).

2. Double-click Windows Mobility Center (Mobile PC).

3. Click the button to Turn wireless off/on, or click the icon  to access the network
menu.

Figure7 - 15
Windows Mobility
Center
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\ 7/
LS
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if

you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the LED indicator to
see if the module is pow-
ered on or not (see

/

Bluetooth & WLAN Combo Module

If your purchase option includes the Combination Wireless LAN & Bluetooth
module (either Intel® or 3rd Party) then install the driver asinstructed (see” Blue-
tooth Settings (Windows 8)” on page E - 37 for instructions on Bluetooth settings
for Windows 8).

Usethe Fn + F12 key combination or Control Center button to toggle power to
the Bluetooth module.

4

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in

one direction only (simultaneous data transfer is not supported). Therefore if you are copying a
file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Blue-
tooth enabled device to your computer until the file transfer process from the computer has been com-
pleted.

e 3rd party WLAN & Bluetooth (V4.0) combo modules - see“ 3rd Party Blue-
tooth (V4.0) Combo Driver Installation” on page 7 - 33 and “ Standard Blue-
tooth Configuration in Windows 7” on page 7 - 35.

* Intel Bluetooth combo modules - see “Intel Bluetooth Combo Driver Installa-
tion” on page 7 - 34 and “ Sandard Bluetooth Configuration in Windows 7”
on page 7 - 35.
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3rd Party Bluetooth (V4.0) Combo Driver Installation

Notethisdriver isrequired for the 3rd Party combo Bluetooth and WLAN module
(Bluetooth V4.0) only.

1. Beforeinstallingthedriver make suretheBluetooth moduleispowered
on (use Fn + F12 key combination), then insert the Device Drivers & Utili-
ties+ User’'s Manual disc into the CD/DVD drive. If aFound New Hard-
ware window appears, click Cancel in all windows that appear, and then
proceed to install the driver as below.
Click Option Drivers (button).
Click 3.Install Combo BT Driver > Yes.
Click Next (if aprompt appearsto ask you to turn the Bluetooth power on,
pressthe Fn + F12 key combination to do so, otherwise the driver will not
be installed).
5. Click Finish to restart the computer.
6. See“Sandard Bluetooth Configuration in Windows 77 on page 7 - 35 for
configuration instructions. See “ Bluetooth Settings (Windows 8)” on
page E - 37 for instructions on Bluetooth settings for Windows 8.

PwWN

. |
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4

High Speed Bluetooth
Data Transfer

The Combination Wire-
less LAN & Bluetooth
module supports high
speed data transfer. How-
ever to achieve such
transfer speeds, both de-
vices must support
high speed data trans-
fer.

To obtain high speed
data transfer make sure
that both the WLAN and
Bluetooth modules are
powered on.

Check your Bluetooth
compatible device’'s doc-
umentation to confirm it
supports high speed data
transfer.

Intel Bluetooth Combo Driver Installation

Notethisdriver isrequired only for the I ntel combo Bluetooth and WLAN module
only.

1.

NoakrwnN

Beforeinstalling thedriver make surethe Bluetooth moduleis powered
on (use Fn + F12 key combination), then insert the Device Drivers & Utili-
ties+ User’'s Manual disc into the DVD drive. If aFound New Hardware
window appears, click Cancel in al windows that appear, and then proceed
to install the driver as below.

Click Option Drivers (button).

Click 3.Install Combo BT Driver > Yes.

Click Next > Next.

Click the button to accept the license and click Next.

Click Next > Finish.

See over for configuration instructions. See “ Bluetooth Settings (Windows
8)” on page E - 37 for instructions on Bluetooth settings for Windows 8.

Note that, at the time of going to press, Intel® Centrino® Wireless-N 135 & In-
tel® Centrino® Wireless-N 2230 WLAN & Bluetooth combo modules use the
standard Bluetooth configuration in Windows 7 (see over for configuration instruc-
tions).
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Standard Bluetooth Configuration in Windows 7

Setup your Bluetooth Device so the Computer Can Find it 4

1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on. Add a Device

2. Make the device discoverable (to do this check your device documentation). Click Start: andlclick Gon-

To Turn the Bluetooth Module On tDrO' e Ee sy G1E S

T evices and Printers
1. Pressthe Fn + F12 key combination to power on the Bluetooth module. (Hardware and Sound).
2. A Bluetooth icon [ will appear in the taskbar notification area. Click Add a device to

3. You can then do any of the following to access the Bluetooth Devices control search for any available
panel Bluetooth devices.

«  Double-click the taskbar icon EJ to access the Bluetooth Devices control panel. Bluetooth Module &

* Click/Right-click the taskbar icon ﬂ and choose an option from the menu. Resumin'\g/gl F(;om Sleep
ode

The Bluetooth module’s de-
fault state will be off after
resuming from the Sleep
power-saving state. Use
the key combination (Fn +
F12) to power on the Blue-
E tooth module after the com-

/ puter resumes from Sleep.
Add a device

Right-Click Taskbar Icon Figure7 - 16

Bluetooth Devices &
Click Icon Menu
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To Add a Bluetooth Device

/ 1 1. Access the Bluetooth Devices control panel and click Add a device.
2. Double-click the device you want to pair with the computer.

Pairing Options

If a device has been pre-
viously connected then
the pairing option menu
will appear when you at-
tempt subsequent con-
nections. You can choose
to have the computer cre-
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

Figure7 - 17

Add a Device ] ) ) ) ) B
3. Onfirst connection the computer will provide you with a pairing code to be entered

onto the device.
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4. Enter the code into your Bluetooth enabled device and follow any on-screen
instructions to complete the pairing.

4

- Figure7- 18
Pairing Codes

Pairing Code
The example outlined here shows a connection to Example

a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
dure, and may require you to confirm a pairing
code is correct on both devices. Follow the on-
screen instructions to complete the pairing.

5. Windows will check to see if any drivers are required to complete the pairing.

6. Follow any on-screen instructions on the computer if device drivers are required to
be installed.

7. Click Close.

Figure7-19
Pairing Complete &
Bluetooth Device
Enabled
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To Change Settings for the Bluetooth Device
4 1. Click the taskbar icon and select Show Bluetooth Devices.
2. Right-click on the device you want to change and click Properties to:

* Change the name of the device (click Bluetooth, type a new name and click OK).
To get help on Bluetooth « Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

Bluetooth Help

configuration - and - set- | 1, pmake your Computer Discoverable to Bluetooth Devices
tings, select Help and

Support from the Start 1. Click the taskbar icon and select Open Settings.
menu. Type Bluetooth in 2. Click Options, and make sure that Allow Bluetooth devices to find this

the Search Help box, and computer check box (Discovery) has a tick inside it.
select an item from the re- 3. Make sure that the Alert me when a new Bluetooth device wants to connect
turned search results to check box (Connections) has a tick inside it, if you want to be notified when a
get more information. Bluetooth device wants to connect.
Figure7 - 20
Bluetooth Settings -
Options
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3G Module

(For ModelsA & B Only) 4

If you have included an optional UM TS/HSPDA OR UMTS/HSPDA+ based 3G 3G Module Options
Module (Universal Mobile Telecommunications System or High Speed Packet Ac- | ... e two optional
cess) module (see” Communication” on page D - 3 for specification details) inyour | 3.6 modules available for
purchase option, you will have the appropriate application (Wireless Manager, | this series of computer
AirCard Watcher or Mobile Partner) provided for Windows 7 (see “ 3G Settings 'STL‘;‘:;'; vf:ﬁ'lh:"gg::f’pr'f
(Windows8)” on page E - 42 for information on Windows 8 asno driver/application | ate application software.
installation is required). Follow the instructions on page 7 - 40 to install the USIM

card (which will be provided by your service provider), and then install the applica

The module type supplied
’ may depend upon the com-
tion. puter model purchased.

2NZ
Z &

Important Notice - 3G & Bluetooth/Wireless LAN Modules

Check with your distributor/
supplier for details.

Install the driver from the
Drivers Installer menu and
check the instructions for
the appropriate application
on the following pages.

In order to comply with FCC regulations you should NOT operate the 3G module and the
Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency, and
cause interference. When the 3G module is powered on, make sure that the Bluetooth/
Wireless LAN modules are powered off.
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1. Turn off the computer, and turn it over and remove the battery (see page 6 - 4).
2. Locate the 3G USIM card cover and loosen screw @), and then remove the USIM
card cover @.
Figure7-21
USIM Card Cover
Removal o

\ A/
L&
Power Safety

Warning 9

Before you undertake any

USEEIEE eSS 3. Insert the USIM card as you would into your mobile phone.
make sure that you have

tumned off the power, and 4. Slide the SIMLOCK towards the hinge in order to release the lock and lift it up.
disconnected all peripher- 5. Insert the USIM card as illustrated in (Figure 7 - 22) and close the SIMLOCK.
als and cables (including

telephone lines). It is advis-

able to also remove your

battery in order to prevent

accidentally turning the ma-

chine on.

Figure7-22
Insert the USIM Card
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6. Lock the SIMLOCK by pushing it in the direction of the arrow in Figure 7 - 23 until
it clicks into the lock position.

Figure7-23
SIMLOCK Lock

4

3G Modules &
System Wake Up

Note that the 3.75G mod-
ules DO NOT support
system wake up on 3G
modem activity.
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Beforeinstalling theapplication, make surethat the 3G moduleisON (installing
the driver with the module off will not allow the software to detect the modul e hard-
ware correctly). UsetheFn+  key combination (see Table 1 - 5, on page 1 - 15)
or Control Center button to toggle power tothe 3G module. Make sure you install
thedriversin the order indicated in Table 4 - 1, on page 4 - 3. Notethat exiting the
application does NOT turn off the 3G module.

* WirelessManager - See “Wireless Manager | nstallation” on page 7 - 43 for
driver installation information and “ Wireless Manager Application” on page 7
- 44 for instructions on using Wireless M anager.

» AirCard Watcher - See” Sierra Wireless AirCard Watcher I nstallation” on
page 7 - 65 for driver installation information and “ Air Card Watcher Applica-
tion” on page 7 - 66 for instructions on using Air Card Watcher.

* MobilePartner - See “Mobile Partner Application Installation” on page 7 -
79 for driver instalation information and “ Mobile Partner Application” on
page 7 - 80 for instructions on using M obile Partner.

» See 3G Settings (Windows 8)” on page E - 42 for Windows 8 configuration
information.
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Wireless Manager

With the 3G module and USIM card (supplied by your service provider) installed ZX
you may then install the Wireless Manager application. The Wireless Manager Wireless Device
application allows you to directly access your internet service from the computer. Operation Aboard
. . Aircraft

Wireless Manager Installation
1. Enable power to the module by pressingthe Fn +  key combination or er;itrzifc ;’;ni';{,;;,‘:ﬁag':

Control Center button (give the module about 10 seconds to power on). vices aboard aircraft is usu-

. : . ally prohibited. Make sure

2. If aFound New Hardware window appears, click Cancel (click Cancel for the module(s) are OFF if

all Found New Hardware windows that appear). you are using the computer
3. Insert the Device Drivers & Utilities + User’s Manual disc into your DVD aboard aircraft.

drI.Ve. . . Use the Fn + [ key com-
4. Cl!Ck Optlon Dr IVGI'S. (bUtton)- bination to toggle power to
5. Click 4.Install 3G Driver > Yes. the 3G module, and check
6. Click Next > Next > Install. tmhgdﬂg'ciztogotv‘;efgg e
7. Click Finish. ot

. . . (see

8. Accessthe Wireless Manager application from the Start menu or the desk- /

top shortcut
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Wireless Manager Application

a The connection information is stored on the USIM card supplied by the service pro-
PIN Number vider (where thisis not the case you may need to create a profile - see “ Creating a
Profile” on page 7 - 50).
The PIN number for
your USIM card will be 1. Power on the 3G module using the Fn + key combination.

supplied by your service 2. Access the Wireless Manager application from the Start menu (Start > All

provider. You usually Programs > Wireless Manager > Wireless Manager) or the desktop shortcut
have alimited numberof | 3. You may be required to enter you PIN number and click OK.
attempts to enter the 4. Click the Connect |  Commect | button (a Profile needs to be selected, and in

correct PIN number. most cases this will be pre-configured).
If you fail to enter the

PIN number correctly

you will be blocked from

accessing the USIM

card and you will need a

PUK (Personal Un-

blocking Key), supplied

by your service provider,

to unlock it.

Figure7-24
Wireless Manager
(Not connected)
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5. The system will connect to your network.
6. Connected will appear above the timer icon (the timer will indicate your connected /
time for the current session) ¢ -
7. You can then access the internet, download e-mail etc. as per any internet Wireless Manager

connection. Help

To get help on Wireless
Manager configuration

and settings, click the
Help icon or press F1.

€9 Help

Figure7 - 25
Wireless Manager
(Connected)
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8. Click the Wireless Manager notification area icon to view the connection status,
or wireless iconjif to view the Mobile Broadband Connection status.

Figure7 - 26
Notification Area
Icons (Connected)

7 O N

Notification Area
Icon 9. Theindicator _gll__ will display the signal strength and radio access
technology. UMTS
. To disconnect from the service provider, click the Disconnect [ pisemea | button
s (note that if you click the close icon at the top right of the screen the application will
menu to Open/Exit Wire- S 2 — T .
e55 wETeEE, DR minimize to t_he sy§tem tray, hpwe_ver the a_pphcatlon W|II st_|II be running; to gxn the
nect or Turn radio off. application right-click the notification area icon and click Disconnect or Exit
Wireless Manager).
11. The program will disconnect from the service provider.
12. The module will still be on, and you will need to press the Fn + key combination
to turn it off.
13. If you are unsuccessful in connecting this way you may need to add a profile with
information provided by your service provider (see the following pages).

Right-click the notification 10
area icon to bring up the
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Profiles

1. Access the Wireless Manager application from the Start menu (Start > All Pro-
grams > Wireless Manager > Wireless Manager) or the desktop shortcut

2. Click the Settings > Advanced.

3. Click the Profiles (tab).

Figure7 - 27
Advanced Settings -
Profiles

. |
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Figure7 - 28
Multiple Profiles
Found

4. Multiple profiles may be available from the USIM card and the first time the

application starts it may require you to select a profile (Set Profile) to use for your
connection.

Multiple Profiles Found

Multiple profiles were found for this SIM card. From
the list below, please select which profile to use for
connecticn.

[ Set Profile |

Automatic Profile Selection

If Automatic selection is chosen, then the application will search the operator pro-
file database for a profile that matches the details on your USIM card. If a correct
profileisfound it will be automatically selected as your profile.

Manual Profile Selection

If Manual selection is chosen, then you can select a profile from the applications's
operator profile database, or you can create a new profile.
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Selecting a Profile

1. Click Manual selection (button).
2. Click the Filter to view the drop-down list.
3. Select the Profile you wish to use and click Apply to confirm the selection.

Figure7 - 29
Profile - Manual
Selection (Filter)
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Creating a Profile
Click Manual selection (button).
Click the New.
Enter a name you prefer for the profile.
- Enter the Access Point Name (APN).
To delete a profile click . . . .
to select Manual selec- Enter the User Name and Password if required (some service providers may not
tion and select the pro- require this information and the fields may then be left blank).
If your service provider requires IP address, DNS and Protocols to be entered,
click the appropriate tab and enter the supplied information (otherwise leave blank).
7. Click Save to save the profile information.
8. The profile will be stored under User defined in the Filter drop-down list.

4

Deleting a Profile

agrONE

o

file and click Delete.

Modifying a Profile

To modify a profile click
to select Manual selec-
tion and select the pro-
file and click Edit.
Change the settings as
required and then click
Save (note that only
user defined profiles
may be edited).

Figure7 - 30
New Profile IP, DNS
& Protocols
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Settings
The Settings tab allows you at adjust the application features. Click to put atick in

Launch Wireless Manager at Windows star tup to launch the application at Win-
dows Startup.

Figure7 - 31
Settings

The Advanced settings allows more detailed configuration. To access the Ad-
vanced settings:

1. Access the Wireless Manager program from the Start menu (Start > All Pro-
grams > Wireless Manager > Wireless Manager) or the desktop shortcut

2. Click the Settings > Advanced.

3. Click the tab to edit any particular setting.
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SIM
2 Most USIM cards are protected by a Personal Identity Number (PIN). Y ou may turn
on or off the Request PIN at startup (click Apply to save any changes). You can
also Change PIN (you will need to enter the new PIN in the two fields provided and

You will have to enter | click Apply to save any changes).
your current PIN to )
change the PIN settings. Radio

Radio needs to be turned on before you can make any connection (note this is not
Request PIN at startup . . ..
will apply only after you the same as powering the mo_dule off/on using the F_n +  key combi natlo_n), but
have shut the computer | YOu may turnit off when required. Automatic mode is the recommended setting for
down and restarted it | most 3G networks asit will use 3G where available. All Frequency bands are se-
(not just restarted). lected as default (click Apply to save any changes).

Radio & Power
Saving States

PIN Notes

You can choose to have
the radio turned on or off
during Hibernate or
Sleep power saving
states.

Figure7 - 32
Advanced Settings
SIM & Radio
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Networks

The mobile network list lists available networks at your location, and allows you to s
select a network which to connect. Y ou must disconnect before being able to select Warning
a network.

Note that some applica-
Connection tions automatically
transmit data when con-
nected, and you may be

You can set the Wireless Manager to automatically connect at Windows startup
(however the module must be powered on, and radio must be turned on). You can  BEEEEEE AR
also automatically connect when resuming from a power-saving state (click Apply eGSRy e

to save any changes). Click Default to return to the original default settings. connection/connection
settings may lead to ex-
pensive roaming charg-
es.

Figure7 - 33
Advanced Settings
Networks &
Connection
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Figure7 - 34
SMS Utility Open

Text Messaging Service (SMS)

In addition to standard internet services you may also send and receive SMS text
messages using the Wireless Manager, if your service supports SMS.

SMS Utility

1. Access the Wireless Manager application from the Start menu (Start > All Pro-
grams > Wireless Manager > Wireless Manager) or the desktop shortcut

2. Click SMS and the SMS Utility will then start.

3. The indicator in the upper right corner will display if radio is currently on or off
(radio must be on in order to send/receive messages).
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Messages
Click the M essages tab to access the tabs displaying text messages. The tabs at the
top of the menu display the I nbox, Drafts, Outbox, Sent and Trash menus.

Inbox Drafts Outbox Sent Trash

Figure7 - 35
SMS Utility
Messages

Text messages are automatically saved to your computer and may be sorted in as-
cending or descending order by name or date.
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Figure7 - 36
SMS Utility - New
Message

Sending a Text Message

1.

wn

Access the Wireless Manager application from the Start menu (Start > All Pro-
grams > Wireless Manager > Wireless Manager) or the desktop shortcut

Click SMS and the SMS Utility will then start.

Click the New Message tab.

Enter the phone number in the To field (multiple numbers may be entered
separated by a semicolon (;), or click the phonebook icon i to select a name from
the phonebook.

Select any contact’s phone number and click OK (you can click a check box to
select multiple contacts or more than one phone number for each contact).

Type the message body in the Message field (to a maximum of 160 characters).
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7. Click Send (3 send |to send the message or Save [ [\ save | to save the message in

the Drafts folder. o

Clicking the Clear icon | & S| clears both the Message and To fields.

9. Ifradio is on then the message will be sent, however if the radio is off the
message will be stored in the Outbox.

o

Notethat you do not have to connect to the networ k to Send/Receive SM S mes-
sages.

Inbox

Any received text messages will be displayed in the Inbox. The number of unread
messages will be displayed in parenthesisin the inbox tab. Unread messageswill be
displayed in a darker color then the read messages, and incoming messages will be
displayed briefly in the Notification Area.

Figure7 - 37
SMS Utility - Inbox &
New Message
Received
Notification
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Figure7 - 38
Close Message

Messages

Opening a text message: Double-click the message and the message will open
in anew window (to closeit click the close icon in the top right of the message).

O A/Click to close the message

Previewing a text message: Click the preview icon (& and the message preview
will open. Click the icon again to close the preview.

Replying to atext message: Double-click the message and click Reply. Type
the reply in the message field and click Send to send the message (or Save to
saveit in Drafts.

Forwarding a text message: Double-click the message and click Forwar d.
Type the recipients name in the To field or click the icon i to select recipients
from the phonebook.

Deleting a text message: Right-click the message select Delete selected. To
delete @ messages in the folder right-click any message and select Delete All.
Holding down the Ctrl key and sel ecting messages allows you to multiple select
messages for deletion (choose Delete selected). Deleted message will be sent to
the Trash folder. To permanently delete messages right-click and select Delete
selected or Delete All (or you may choose to Recover/Recover All) and click
Yes to confirm.
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Phonebook

The Phonebook allows you to view and edit all your frequently used contacts, and
is divided into Contacts ffj and Groups iﬁ To access the Phonebook:

1. Access the Wireless Manager application from the Start menu (Start > All Pro-
grams > Wireless Manager > Wireless Manager) or the desktop shortcut

2. Click SMS and the SMS Utility will then start.

3. Click the Phonebook tab.

Figure7- 39
SMS Utility -
Phonebook

(Contacts)
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4

Import/Export
Contacts

Import/Export Con-
tacts: Click the Import/
EXport |: Import.. | I: Export... |
buttons to import or ex-
port the list of contacts.

Figure7 - 40
SMS Utility
New Contact

7 - 60 3G Module

Contacts

New Contact: Click the New contact button [ & Mewcontact.. | to create a contact.
Add the name and at |east one phone number (M obile, Wor k, Home and Other
fields are available) for the contact. Click the (&) icon to expand the number
details. Select Synchronize with SIM to synchronize the contact information

with your USIM card. Click the Save icon [] to save the information.

Edit Contact: Click the edit icon £ to make changes to a contact detail, and
click save 5] to confirm the changes.

Delete Contact: Click the deleteicon il to delete a contact from the phone-

book.
Send a message to a Contact: Click the message icon [ to send atext mes-

sage to any contact.
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Groups
Y ou can organize existing contacts into groups from the Gr oups tab.

» New Group: Click the New group button [ Newgreup..| to create agroup. Click
the (&) icon to expand the group details, and click acheck box to add at least one

phone number from the contacts for the group. Click the Saveicon [£] to save
the information.

Figure7-41
SMS Utility
Groups

« Edit Group: Click theediticon ¢ to make changesto a contact detail, and click
save [B] to confirm the changes, or close B3 to exit without making changes.
+ Delete Group: Click the delete icon [ to delete a group from the phonebook.

» Send amessageto a Group: Click the message icon 4 to send a text message
to any group.
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SMS Settings
The SM S Utility Settingstab allows you at adjust the SM S features.

Figure7 - 42
SMS Utility Settings

SMS Settings

Message Length: You can
set the number of blocks
that can be sent (up to a
length of 10 blocks).

Message validity period:
This sets the period after
which the message will be

deleted from the SMS cen- ) ) ) )
ter and therefore not for- || The Advanced settings allows more detailed configuration. To access the Ad-

warded to the recipient(s) vanced settings
when they come online. )

Display information mes- 1. Access the Wireless Manager application from the Start menu (Start > All Pro-
SEJEEE VD BRI Grenss grams > Wireless Manager > Wireless Manager) or the desktop shortcut
whether to allow informa- £ 5 - cyiel gMS and the SMS Utility will then start

tion messages to automati- : !c an_ e Hity wi S
Ca”y appear on screen or 3 CI|Ck the Sett'ngs > Advanced

not. 4. Click the tab to edit any particular setting.
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Send

Click Delivery Report to automatically request areply from arecipient. If you click
to Send messagesin Outbox automatically upon connection then messages writ-
ten when theradio is off, will then be sent automatically the next timeradio isturned
on. You can also choose to Include original messagein reply.

Notification

Thismenu allows you to enable/disable Show animation on new messageto get an
animated notification of newly received messages. Enabling Play sound on new
message will play an audio notification upon receipt of new messages.

Figure7 - 43
SMS Utility -
Advanced Settings
Send & Notification

. |
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Number

Y ou can choose to Use default service center number or you can uncheck the box
and add your number manually if your service provider supplies a different number
(click Apply to save the change or Default to return to the default number).

Memory
Phonebook memory status displays the number of contacts displayed on the USIM
card.

Figure7 - 44
SMS Utility -
Advanced Settings
Number & Memory

. |
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Sierra Wireless AirCard Watcher

With the 3G module and USIM card (supplied by your service provider) installed
you may then install the Sierra Wireless Air Card Watcher application. AirCard
Watcher allows you to directly access your internet service from the computer.

Sierra Wireless AirCard Watcher Installation

1.

2.

Nouk W

R E2 o [e0]

. |
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Enable power to the module by pressingthe Fn +  key combination or
Control Center button (give the module about 10 seconds to power on).

If aFound New Hardware window appears, click Cancel (click Cancel for
all Found New Hardware windows that appear).

Insert the Device Drivers & Utilities + User’'s Manual disc into your DVD
drive.

Click Option Drivers (button).

Click 5.Install 3G Driver > Yes.

Click Next > Install > Finish > Next > Finish.

The hardware driver installation is now complete so select “ No, | will
restart my computer later” and click Finish (do not restart the computer).
Another window will now pop up to install the AirCard Watcher applica-
tion.

Click Next, click the button to accept the license agreement and click Next.

. Click Finish.

The Air Card Watcher application will now run, or you can click the desk-
top shortcut or run it from the Sierra Wirelessitem in the Sart menu.

Modules & Options

N /
Z &
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + . key com-
bination to toggle power to
the 3G module, and check
the indicator to see if the
module is powered on or
not (see

/
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PIN Number

The PIN number for
your USIM card will be
supplied by your service
provider. You usually
have a limited number of
attempts to enter the
correct PIN number.

If you fail to enter the
PIN number correctly
you will be blocked from
accessing the USIM
card and you will need a
PUK (Personal Un-
blocking Key), supplied
by your service provider,
to unlock it.

Figure7 - 45
AirCard Watcher
(Not connected)

AirCard Watcher Application

The connection information is stored on the USIM card supplied by the service pro-
vider (wherethisis not the case you may need to create aprofile - see” Profiles” on

page 7 - 72).

1. Power on the 3G module using the Fn + key combination.

2. Access the AirCard Watcher application from the Start menu (Start > All
Programs > Sierra Wireless > AirCard Watcher) or the desktop shortcut

3. If you need to set up a network operator (see page 7 - 71).

4. Click the Connect button (a Profile needs to be selected, and in most

cases this will be pre-configured).
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5. The system will connect to your network.
6. Theicon [[@will turn greenfd (and the upload/download speeds will be indicated). /
7. You can thenh access the internet, download e-mail etc. as per any internet

connection. AirCard Watcher
Help Topics

To get help on AirCard
Watcher configuration
and settings, click the
Menu icon and select
Help Topics.

Always |

Help Topics

Figure7 - 46
AirCard Watcher
(Connected)
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8. When connected the uplink/downlink speeds will be indicated.
/ \ 9. You can also click the Speed Graph icon to get a visual display of the uplink/
downlink speeds.
Roaming 10. While connected you can also click the icon I in the notification area of the
Notification taskbar to display the Windows 7 Mobile Broadband connection status.

AirCard Watcher will
provide notification

when you connect to a
network other than your
service provider. This
can be turned on/off
from User Options >
General > Warning
Messages.

Figure7 - 47
AirCard Watcher
with Speed Graph
(Connected)
&
Taskbar Menu
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11. To disconnect from the service provider, click the Disconnect button :
(note that if you click the close [x] icon at the top right of the screen the application /
will close however the connection will still be maintained).
12. You can also click the icon n in the notification area of the taskbar to display the Online Help

connection status, click Connected, and then click the Disconnect button.

13. The program will disconnect from the service provider.

14. The module will still be on, and you will need to press the Fn + key combination
to turn it off.

Click the Online Help

icon to access the
Sierra Wireless website
for further help if re-
quired.

Figure7 - 48
AirCard Watcher
Disconnect
&
Taskbar Menu
Disconnect
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Air Card Watcher Menu
4 . Right-click the menu [&] button at the top of the Air Card Watcher screen to bring
up the menu, and click to select any item required.

Airplane Mode

Click on the Airplane
Mode icon to turn the ra-
dio power off (e.g. if you
are aboard an aircraft).
You can turn the radio
on again by clicking the
Turn Radio On button.

Figure7 - 49
AirCard Watcher
Menu

. |
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Selecting a Network Operator/Service Provider

In most cases all your network operator/service provider details will be stored on 2
your USIM card, and will not need to be edited/modified. If you do need to set up a

. . . i Network Operator
network operator/service provider follow these instructions.

If the network operator
1. Access the AirCard Watcher application from the Start menu (Start > All Pro- is not listed then choose
grams > Sierra Wireless > AirCard Watcher) or the desktop shortcut . Generic UTMS.
2. Either click the menu [&] button and select Options, or click the Options button
from the main program window.
Click Firmware.
Click to select a Network Operator from the dropdown menu.
Click OK.

ok w

Figure 7 - 50
Options - Firmware
(Network Operator)
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Figure7-51
Options - Profile
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Profiles

A profile containsinformation used to establish a data connection, and thisinforma-
tionisusually stored on the USIM card supplied by your service provider. However
you can create, edit or delete profilesif required.

Creating a Profile

1.

2.
3.

Access the AirCard Watcher application from the Start menu (Start > All Pro-
grams > Sierra Wireless > AirCard Watcher) or the desktop shortcut

Make sure you are not connected to a network.

Either click the menu [=] button and select Connections, or click the Connections
button . from the main program window.

Click Profiles and click the Add new profile button and select Custom.

Add new profile
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5. You will need to complete the fields for Profile name, Username, Password and

Access Point Name (you will need to get the username and password details from /
your service provider).

6. Once you have added the details above you can click the Profiles heading menu Edit or Delete
and click to select the profile from the Selected Profile dropdown menu and then Profiles

click OK to set the profile as the default connection.

7. Select the profile and click Advanced to set the Autolaunch, TCP/IP and DNS
settings (check with your service provider for any specific requirements in these
fields).

Select any existing pro-
files to edit or delete it,
and then click OK to

confirm any changes
made.

You can also change the
default profile from the
dropdown menu and then
click OK to confirm the
changes.

Figure7 - 52
Profile - Advanced

3G Module 7 - 73



Modules & Options

User Options
Y ou can configure User Options asfollows.

1. Access the AirCard Watcher application from the Start menu (Start > All Pro-
grams > Sierra Wireless > AirCard Watcher) or the desktop shortcut

2. Either click the menu [&] button and select Options, or click the Options button
from the main program window.

3. Click on any of the menu headings on the left to access the options that may be
configured (note that not all options will be available to be configured as they may
depend on your USIM card settings).

Figure7 - 53
User Options

. |
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* General - Thisitem allows you to set options for Sartup/Shutdown, War ning
M essages, Display and Windows support.

» Messaging - Set options here for SM S settings.

* Network - Configure the network settings from this menu though your fre-
guency band information is usually stored on the USIM card.

* SIM Settings - You can set your SIM Security and PIN # options here.

» Sounds- Thisallows you to set sounds applicable to certain application actions
e.g. when anew SMS arrives.

» Profiles- Create, edit, delete and set the default profile from the items here.

» Data Useage Tracking - You can enable/disable data tracking e.g. for billing
purposes.

» Firmware - If you need to change network operator/service provider you can do
so here.
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Text Messaging Service (SMS)

In addition to standard internet services you may also send and receive SMS text
messages using Air Card Watcher, if your service supports SMS.

SMS Express

1. Access the AirCard Watcher application from the Start menu (Start > All Pro-
grams > Sierra Wireless > AirCard Watcher) or the desktop shortcut

2. Either click the menu [&@] button and select SMS Express, or click the SMS
Express button n from the main program window.

Figure7 - 54
SMS Utility Open
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Sending a Text Message

1. Access the AirCard Watcher application from the Start menu (Start > All Pro- /
grams > Sierra Wireless > AirCard Watcher) or the desktop shortcut

2. Either click the menu |[&] button and select SMS Express, or click the SMS S ESSEEES

Express button [ from the main program window. Sent messages will be
3. Select File > New Message or click the New button in the toolbar. automatically saved to
4. Type the recipients phone number in the “To:” field (to send to multiple recipients the Sent Items folder.

separate the numbers using a semi-colon or space).
Type the message (160 characters max) in the bottom part of the Message window.
6. Click the Send button or Save the message to send/edit later.

m

Figure7 - 55
Profile - Advanced

Notethat you do not have to connect to the networ k to Send/Receive SM S mes-
sages aslong asthe moduleison.
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Inbox

Any received text messageswill be displayed in the Il nbox. The number of total mes-
sages and unread messages will be displayed in the inbox folder title.

M essages

Opening a text message: Click on any message in the Inbox to read it in the
bottom panel of the window.

Replying to a text message: Click on any message in the | nbox and select
Actions > Reply or click the Reply button in the toolbar. Type the reply in the
message field and click Send to send the message (or Save to save it in Drafts).

Forwar ding a text message: Click on any message in the appropriate folder
and select Actions> Forward or click the Forward button in the toolbar. Enter
the recipient’s phone number in the “To:” field and make any additions/changes
required in the message field and click Send to send the message (or Save to
saveit in Drafts).

Deleting a text message: Click on any message in the appropriate folder and
select Actions > Delete or click the Delete button in the toolbar. Click Yesto
confirm the deletion.
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Mobile Partner

With the 3G module and USIM card (supplied by your service provider) installed ZX

you may then install the M obile Partner application to directly access your HSPA Wireless Device

internet service from the computer. Operation Aboard
Aircraft

Mobile Partner Application Installation
The use of any portable

1. Enable power to the module by pressingthe Fn +  key combination or ; 0
i electronic transmission de-
Control Center button (give the module about 10 seconds to power on). vices aboard aircraft is usu-
2. If aFound New Hardware window appears, click Cancel (click Cancel for ally prohibited. Make sure
all Found New Hardware windows that appear). the module(s) are OFF it

you are using the computer

3. Insert the Device Drivers & Utilities+ User’s Manual disc into your DVD aboard aircraft.

drive.
4. Click Option Drivers (button). s fo”t;gge ';‘;yw‘:?”t"o
5. Click 5.Install 3G Driver > Yes. the 3G module, and check
6. Click Next > Install > Finish > Next. the indicator to see if the
7. Click | Agree (button) to accept the license agreement. nmo‘id‘(ls";eis powered on or
8. Click Install > Finish. _ _ /
9. Choose the language you prefer and click OK, and then click Next.

10. Click I Agree (button) to accept the license agreement.

11. Click Next > Install > Finish.

12. Click Finish to restart the computer.

13. Accessthe M obile Partner application from the Start menu (Start > Pro-
gramg/All Programs> Mobile Partner), or by double-clicking the M obile
Partner icon on the desktop.

. |
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Mobile Partner Application

a Y ou will need to contact your service provider to obtain the exact details of how ex-

Mobile Partner Help actly to configure the settings on this page.

To get help on Mobile | Profile Management

Partner  configuration 1. Power on the 3G module using the Fn +  key combination.
and settings, click the & 2 Access the Mobile Partner application from the Start menu (Start > Programs/
Help menu and select All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon
Online Help or press on the desktop
Fl. 3. If you have not created a profile, click Tools and select Options, and then click
Profile Management.
4. Click New and input the appropriate information for Profile Name, APN
and Authentication etc. as supplied by your service provider.
5. Click Save to save the profile.

Figure7 - 56
Profile Management

. |
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Connecting to the Service Provider

1. Power on the 3G module using the Fn + key combination.

2. Access the Mobile Partner application from the Start menu (Start > Programs/
All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon
on the desktop

3. The software will run and you can select the Profile Name from the menu.

4. Click Connect to begin the connection process.
Figure7 - 57
Connect
5. The Mobile Partner application will then display the connection information.
Figure7 - 58
Network

Connection Prompt

. |
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6. While connected you can also click the icon [ in the notification area of the
taskbar to display the Windows 7 Mobile Broadband connection status.

Figure7 - 59
Connected
Taskbar
Notification Area
Notification

7. You can then access the internet, download e-mail etc. as per any internet
connection.
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8. While you are connected the indicators in the Mobile Partner window will display
uploading and downloading icons.

9. To disconnect click the Disconnect icon, or right click the natification
area icon and select Disconnect (you can also select the connection in the Mobile
Broadband connection status window, and click Disconnect).

Figure 7 - 60

© © Disconnect

10. The program will disconnect from the service provider.
11. The module will still be on, and you will need to press the Fn + key combination
to turn it off.
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12. If you click the Mobile Partner close icon a message will be displayed asking
you to click OK to confirm the program exit and to terminate the connection.

Figure7- 61
Exit Prompt

13. Exiting the program terminates the connection, but DOES NOT turn off the 3G
module, and you will need to press the Fn + key combination to turn off the
module (pay careful attention to this aboard aircraft - see “Wireless Device
Operation Aboard Aircraft” on page 7 - 79).

14. If the module is on and the computer enters a power-saving state, then the power
status of the module on resuming from the power-saving state will be as below:

 |f the 3G module is on and the computer is Shut Down or Restarted; the mod-
ule will be off when the computer starts up.

 If the 3G module is on and the computer enters Sleep or Hiber nate; the module
will be off when the computer resumes from sleep.
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Text Messaging Service

In addition to standard internet services you may also send and receive SMS text
messages using the M obile Partner program, if your service supports SMS.

Reading SMS Messages

1. Anicon =] will blink at the bottom of the Mobile Partner interface to notify you of
any new messages received.

2. Click the Text icon in the Mobile Partner Interface.

3. Select the Local > Inbox or SIM/USIM Card folder and select any message to
read it.

4. Right-click the message and choose an option to reply, forward or delete the
message.

Creating and Sending SMS Messages

1. Click the Text icon in the Mobile Partner Interface.

2. Click the New button [=].

3. Enter the recipient’'s number in the Send To... field or click the Send To... button to
select an entry from the phone book, and click OK.

4. Type in the message details.

5. Click the Send button, Save button to send the message later or Close > Yes to
save in the Draft folder.

For more details on SMS click the Help menu and select Online Help or press F1
and select SM S.

. |
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Trusted Platform Module

The TPM security chip alowsyou to create and manage digital certificatesfor user
and platform authentication. This type of security is usually administered within
large enterprises and organi zations, and therefore requires implementation by asys-
tem administrator before users can access security features.

Individual users can use the TPM as an authentication with the fingerprint reader.

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection. In addition Make sure you prepare
aremovablemedia (e.g. aUSB flash drive) to stor e passwor dsetc. befor e begin-
ning the TPM initialization process.

Before setting up the TPM functions you must initialize the security platform.

7 - 86 Trusted Platform Module



Modules & Options

Enabling & Activating TPM

Restart the computer.

Enter the Aptio Setup Utility pressing F2 during the POST/startup.

Use the arrow keys to select the Security menu.

Select Trusted Configuration and press Enter to access the sub-menu.

Press Enter to access the TPM Support menu and select Enable to display the
full TPM configuration menu.

Select TPM State, press Enter and select Enable to change the TPM state to
enabled. You will then need to press F4 to save the changes and restart the
computer.

agrwnE

o

Aptio Setup Utility — Copyright (C) 2011 American Megatren

TPM SUBPORT

Figure7 - 62
TPM State
(Enabled)

7. As the computer restarts press F2 to enter the BIOS again and go to the TPM
Configuration menu.

. |
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8. Select Pending TPM operation, press Enter and select the option you require (if
you are initializing TPM you should select Enable Take Ownership). You will then
need to press F4 to save the changes and restart the computer.

Aptio Setup Utility — Copyright (C) 2011 American Megatrends Inc.

Pending TPM operaticn [Hone]
Figure7 - 63
Pending TPM
operation
(Enable Take Pending TPM operation
OwnerShip) gﬁgsle Take Ownership

Disable Take Owmership
TPM Clear

9. You can now install the TPM driver (see “Trusted Platform Module (TPM)
Driver Installation” on page 7 - 89) and then initialize the TPM.

. |
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Trusted Platform Module (TPM) Driver Installation

1. Make sure you have enabled and activated the TPM in the BIOS before
installing the driver (if you do not do see the note below).

Insert the Device Drivers & Utilities + User’s Manual disc into the DVD
drive.

Click Option Drivers (button).

Click 5.Install TPM Driver > Yes.

Click Install > Next.

Click the button to accept the license and click Next.

Click Next > Next > Install.

Click Finish > Yes to restart the compuiter.

N

N AW

If you haveinstalled the driver without enabling and activating the TPM first, acon-
firmation message will appear on restart.

h configuration change was regquested to enable, activate, and allow the creation of Flgure_7 - 64
an operator authentication walue that permits temporary deactivation of the TPM TPM Confirmation
Message

Press [F10] to enable, activate, amd allow the creation of an operator authentication
ralue that permits temporary deactivation of the TPM (if the driver is installed

Press ESC to reject this change regquest and continue

without TPM being en-
abled and activated in the

Press F10 to enable and activate the TPM and you can then configure as overleaf. ~ BIOS)
However it is recommended that you enter the BIOS and take ownership (see page

7 - 87) of the TPM before configuration in Windows. Alternatively press Esc to con-

tinue without making changes the TPM.
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Initializing TPM

1. Run the application from the Infineon Security Platform Solution > Manage
Security Platform item in the Start > Programs menu.

2. Click User Settings (tab) and click Yes, or right-click the icon I__EE in the notification
area of the taskbar, and select Security Platform Initialization (or click the
Security Platform State taskbar bubble).

3. The Quick Initialization method will automatically be selected for you (if you need
to use advanced settings provided by your network administrator then select
Advanced Initialization).

4. You will need to use a removable media (e.g. a USB Flash Drive) to store
passwords and data (keep the media in a safe place until required).

5. Select the drive you want to use from the drop-down menu and click Next.

Figure7 - 65
Security Platform
Quick Initialization

Wizard
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6. Choose the Security Platform Features you want to use by clicking the
appropriate tickbox. 4
7. Enter a Basic User Password (and re-type to confirm it) and click Next.

Help

Right-click the icon in
the notification area of the
taskbar to bring up the menu
to select Help or How to use
the Security Platform Fea-
tures.

You can also click the Help
button in any of the Infineon
Security Platform Settings
Tool tabs to bring up specific

8. Click Next to confirm the settings. help topics on each tab.

9. The computer will then initialize the settings.

10. Click Finish.

11. Click the tabs and control panels to adjust the settings. Figure7 - 66

12. Double-click the icon in the taskbar notification area to access the Infineon
Security Platform Settings Tool, or right-click the icon and select a menu
item.

Settings
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Infineon Security Platform Settings Tool

e The Infineon Security Platform Settings Tool allows you to manage and check the
TPM state, manage your password information, and to backup and restore the TPM
data. As TPM is usually administered within large enterprises and organizations,

Note that not all the .. . . . . . .
menus pictured here will | YOUr System administrator will need to assist you in managing the information here.

be available for access.
The menu items that ap-
pear will be dependent on
your configuration set-
tings etc. (see the Help
file for full details).

Menus

Figure7 - 67
Infineon Security
Platform Settings

Tool
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User Settings

This page allows the settings to be configured for the currently logged in Infineon
Security Platform user including the ability to change the password, configure se-
cure e-mail, file and folder encryption and Enhanced Authentication. You can also
import or delete certificates protected by the security platform.

Figure7 - 68
Infineon Security

Platform Settings
Tool (User Settings)
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Backup

Here you can configure backup and restore operations. Backup files contain the
computer identification and user identification information which is used to match
the machine name and user name with the current machine and user during restora-

tion.

Figure7 - 69
Infineon Security
Platform Settings

Tool (Backup)
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Migration
The Migration tab is used to help securely transfer keys and certificates from one
platform to another.

Figure7- 70
Infineon Security

Platform Settings
Tool (Migration)
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Password Reset
Use Password Reset to reset basic user passwords when required.

Figure7-71
Infineon Security

Platform Settings
7 Tool
(Password Reset)

7 - 96 Trusted Platform Module



Modules & Options

BitLocker

BitLocker Drive Encryption can be used in conjunction with the TPM to encrypt
data on the disk and is done via the Microsoft BitL ocker Control Panel Applet.
Click Configure and select a drive to be encrypted and then follow the Wizard to
begin the encryption process.

Figure7- 72
Infineon Security

Platform Settings
Tool 7
(BitLocker)

. |
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Access the Microsoft BitL ocker Drive Encryption control panel applet from the
Windows control panel (System and Security).

Figure7-73
BitLocker Drive

Encryption
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Advanced
Configure all the Security Platform owner and policy settings from the Advanced
tab. The settings that can be changed are for the local computer only.

Figure7-74
Infineon Security
Platform Settings

Tool
(Advanced)

Trusted Platform Module 7 - 99



Modules & Options

Intel Rapid Storage Technology

Install the Intel Rapid Storage Technology to support your SATA driveif set up in
AHCI mode in the BIOS (see “SATA Mode Selection (Advanced Menu)” on

page>5 - 8).

IRST Driver Installation

1

gL

Insert the Device Drivers & Utilities + User’s Manual disc into the DVD
drive.

Click Option Drivers (button).

Click 6.Install IRST Driver > Yes.

Click Next > Yes > Next > Next.

Click Finish to restart the computer (you will need to restart the system
again after the computer has rebooted).

.|
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Chapter 8: Troubleshooting

Overview

Should you have any problemswith your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’'t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautionsin the preface.
If al elsefails, talk to your service representative. Y ou should also make a record of what happened and what
remedies you tried.

Of course, if something goeswrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you' ve tried everything, and the system still won't cooperate, try turning it off
for afew minutes and then rebooting. Y ou will lose any unsaved data, but it may start working again. Then call
your service representative.

. |
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Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working.

Power - Isthe computer actually plugged into aworking electrical outlet? If plugged into apower strip,
make sureit is actually working. Check the LED Power & Communication Indicators (see” LED Indica-
tors’ on page 1 - 11) to see the computer’s power status.

Connections - Check al the cables to make sure that there are no loose connections anywhere.

Power Savings - Make sure that the system is not in Hiber nate or Sleep mode by pressing the keys config-
ured in your Power Options (see “ Power-Saving States” on page 3 - 6), the Fn + F4 key combination, or
power button to wake-up the system.

Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
Ness.

Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive
(thisis acommon cause of the message “I nvalid system disk - Replace the disk, and then press any key” /
“Remove disks or other media. Press any key to restart”).
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Backup and General Maintenance

» Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don't forget to note the serial numbersif you are storing them out of their original cases, e.g. inaCD wal-
let.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.

» Write down your passwords and keep them safe (away from your computer). Thisis especially important if
you choose to use a Super visor password for the BIOS (see “ The Setup Utility” on page5 - 2).

» Keep copiesof vital settingsfiles such as network, dialup settings, mail settings etc.(even if just brief notes).

N2
2

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
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Viruses

Install an Anti-Virus program and keep the definitionsfile (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tionsfile updates are usually downloadable directly from the internet.

Be careful when opening e-mail from sources you don’'t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

Keep a“Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS's documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such adisk (or at
least instructions on how to make one).
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Upgrading and Adding New Hardware/Software

* Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.

» Don’'t open your computer or undertake any repair or upgrade work if you are not comfortable with what
you are doing.

» Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

* When installing a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.

» Make sureyou haveinstalled the driversfor any new hardware you have installed (latest driver filesare
usually available to download from vendor’s websites).

.|
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» Thoroughly check any recent changes you made to your system as these changes may affect one or more
system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.

» Don't over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of aproblem. Try disconnecting all of the devices and
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and

removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power but it doesn't | Battery missing / incorrectly installed. Check the battery bay, make sure the
work. battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator , is | Low Battery. Plug in the DC power source. If the computer doesn’t start up
blinking orange. immediately, turn it off then on again.

You are losing battery power too quickly. | The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 4) check its settings. You may also be using a
USB device/external device that is drawing a lot of power.

Actual battery operating time is shorter | The battery has not been fully discharged before being recharged. Make sure
than expected. the battery is fully discharged and recharge it completely before reusing (see
“Battery Information” on page 3 - 11).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/lUSB device is consuming a lot of power. Turn off/fremove
the unused device to save power.

. |
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Problem Possible Cause - Solution

The computer feels too hot. Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn't sitting on a thermal surface (see
“Overheating” on page 1 - 24). Make sure you're using the correct adapter.

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen. The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F4 (see “Configuring the Power Buttons” on page 3 - 8).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you're connected to an external monitor, make sure
it's plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the Touchpad.

No image appears on the external | You haven't installed the video driver and configured it appropriately from the
monitor | have plugged in and powered | Control Panel. See Appendix C for instructions on installing and configuring
on. the video driver.

. |
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Problem

Possible Cause - Solution

You forget the boot password.

If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

AN
Ik

Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows taskbar, or use the key combination Fn + F5 and
F6 (see “Function/Hot Key Indicators” on page 1 - 15) to adjust.

The CD/DVD cannot be read.

The CD/DVD is dirty. Clean it with a CD/DVD cleaner kit.

The CD/DVD tray will not open when
there is a disc in the tray.

The CD/DVD is not correctly placed in the tray. Gently try to remove the disc
using the eject hole (see “Loading Discs” on page 2 - 3).

The DVD regional codes can no longer
be changed.

The code has been changed the maximum 5 times. See “DVD Regional
Codes” on page 2 - 5.

Unwelcome numbers when

typing.

appear

If the LED El is lit, then Num Lock is turned ON. (see “LED Indicators” on
page 1 - 11).
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Problem Possible Cause - Solution

4

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not
work.

The system freezes or the screen goes | The system’s power saving features have timed-out. Use the AC/DC adapter,

dark. press the sleep (Fn + F4) key combination, or press the power button if no LEDs
are lit.

The system never goes into a power | Power Options features are not enabled. Go to the Windows Power Options

saving mode. menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 6). Make sure you have enabled Hibernate mode from the control
panel.

The Wireless LAN or Bluetooth modules | The modules are off. Check the LED indicator and/or function key indicator to
cannot be detected. see if the WLAN/Bluetooth module is on or off (see “LED Indicators” on
page 1 - 11). If the LED indicator is off, then press the Fn + F11 (WLAN) or Fn +
F12 (Bluetooth) key combination(s) in order to enable the modules (see
Table 1 -5, on page 1 - 15).
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Problem

Possible Cause - Solution

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function/Hot Key Indicators” on page 1 - 15). Run the camera
application to view the camera picture.

The PC Camera module does not display
the LED light when the camera is in use.

You are using a 300K or 1.3M camera in the Windows 8 OS. The Windows 8
OS does not support 300K or 1.3M cameras, and therefore the LED light will not
display.

The Wireless LAN/Bluetooth/ PC
Camera modules cannot be configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Modules & Options” on page 7 - 1).

A file cannot be copied to/from a

connected Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the device to your computer until
the file transfer process from the computer has been completed.

The Bluetooth module is off after

resuming from Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep
power-saving state. Use the key combination (Fn + F12) to power on the
Bluetooth module after the computer resumes from Sleep.

| am sliding my finger up and down on the
right side of the Touchpad to scroll a
Window and the Touchpad does not
respond.

There are different Touchpad versions available on this computer, and this
version requires tapping/holding to scroll. Either tap repeatedly, or hold the
finger down, at the top or bottom right of the Touchpad (depending on the
scrolling direction required) to scroll the window.
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Bluetooth Connection Problems

If you are experiencing problems connecting to some Bluetooth devices (in particular certain mobile phones and
headsets) it maybe necessary to download and install the Windows Mobile Device Center software (for Win-
dows Vista and Windows 7). Go to the Microsoft website and search for the Micr osoft Windows Device Center
Driver for Windows Vista (64-bit or 32-bit) and Windows 7 (64-bit or 32-bit), and then download the driver.

Install the Microsoft Windows Device Center Driver as appropriate for your operating system.

Windows Vista will automatically configure the driver for you, however Windows 7 requires further configuration.
Make sure the Bluetooth device is powered on.

Go the Windows 7 control panel and double-click Device Manager (Hardware and Sound > Devices and
Printers).

Bluetooth Peripheral Device(s) will be listed under Other Devices (note this will only be listed if you have
connected, or tried to connect to, a Bluetooth device previously).

PwDNPE

o

2¥ MNetwork adapters /
'3 Atheros ARS007EG Wireless Network Adapter
l&-"‘ Bluetooth Device (Personal Area Network)
5;-“ Bluetooth Device (RFCOMM Protocol TDI)

A

Bluetooth Peripheral Devices

l;‘ Marvell Yukon 88E8040 PCI-E Fast Ethernet Contreller You will need to repeat the procedure
4-llp Other devices : listed here for all Bluetooth Peripher-
i 4|7 Bluetooth Peripheral Device q A q

W PCIFLASH Memory .a| DeV|.ces listed under Other Devices
o) Processors i.e. until there are no more Bluetooth
>~ Sound, video and game controllers Peripheral Devices listed under this
P - Storage controllers menu heading_

ol Suertarn Asicar

Figure 8 - 1 - Device Manager

. |
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6. Right-click Bluetooth Peripheral Device and click on Update Driver Software.

7. Click Browse my computer for driver software.
8. Click Let Me pick from a list of device drivers on my computer.

Figure 8 - 2 - Browse my computer.../Let me pick from...

9. Select Bluetooth Radios from the list.

>

Figure 8 - 3 - Select Bluetooth Radios
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10. A list of drivers will appear with Manufacturer on one side and Model in the other.
11. Choose Microsoft Corporation (make sure you choose the full name Microsoft Corporation and do not

choose Microsoft - Note that you must have installed the Microsoft Windows Device Center Driver for
Microsoft Corporation to appear in the list).

12. Select Windows Mobile-based device support from the Model list.

@ | Update Driver Software - Bluetooth Peripheral Device

Select the device driver you want to install for this hardware.

Select the manufacturer and model of your hardware device and then click Mext. If you have a
disk that centains the driver you want to install, click Have Disk.

Manufacturer “ || Model
Wwice support

Make sure you select

Microsoft Corporation

| This driver is digitally signed.

Tell me why driver signing is important
Ciiet ] cona

Figure 8 - 4 - Select Device Driver

13. Click Next > Yes and the driver will install.
14. Click Close to complete the installation.
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15. The Device Manager should now display the Windows Mobile-based device support under Bluetooth

Radios.
16. You will need to repeat the process for any other Bluetooth Peripheral Devices listed under Other Devices.

>

Figure 8 - 5 - Device Manager - Bluetooth Radio

. |
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Resolving the “Insert a SIM” issue with the 3G Module (Windows 8)

1. IfaPIN was set for the EM820W 3G module, you have then switched Mobile broadband off (or put the system

in Airplane Mode) under Wireless in PC Settings, and the system has just resumed from a power-saving state
the following error may occur.

PC SettlﬂgS Airplane mode

Turn this on to stop wireless communication

Search off |

Share Wireless devices

Genefal Mobile broadband \
off [ |

Privacy
Off

Devices

Mobile broadband hardware

Huawei Technologies

Ease of Access

Figure 8 - 6 - PC Settings (Charms Bar) - Wireless (Mobile Broadband Off)

2. Onresuming from the power-saving state the standard procedure would be to go to PC Settings in the Charms
Bar and turn on Mobile broadband under Wireless > Wireless Devices.
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Go to the Charms Bar.

Select Settings and you will then note that the WiFi icon will read Unavailable.
Standard procedure would be to click the connection and enter the PIN number to unlock the connection.
In this instance you will note that the Mobile broadband connection will read Insert a SIM.

o0k w

(© Networks

Airplane mode

off N

Mobile broadband

Insert a SIM

Figure 8 - 7 - Mobile Broadband (Insert a SIM)
7. In this case you will need to restart the computer.
8. After system restart you can then connect to the Mobile Broadband as normal.
9. To fully resolve this issue it is recommended that you do not Enable a PIN for the EM820W 3G module.
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Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give aquick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.
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Notebook Ports and Jacks

Item

Description

Card Reader Port

The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

DC-In Jack

Plug the supplied AC/DC adapter into this jack to power your computer.

External Monitor (VGA)
Port

This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or
simultaneous display on the LCD and external monitor/FPD.

HDMI-Out Port

The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or
Flat Panel Display etc. as a display device by means of a HDMI cable. Note that HDMI carries
both audio and video signals.

Headphone-Out Jack

Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.
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Item Description
Microphone-In Jack Plug an external microphone in to this jack to record on your computer.
RJ-45 LAN Jack This port supports LAN (Network) functions.

Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

USB 2.0/1.1 Ports These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into
USB 3.0 Port the computer, and unplugged from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure you use the power supply which
comes with the device).

The USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black. USB
3.0 will transfer data much faster than USB 2.0, and is backwards-compatible with USB 2.0.

Note that the USB 3.0 ports require a driver installation (see “USB 3.0 (Win 7 Only)” on page 4
- 7) for Windows 7 (Windows 8 does not require a driver) and do not support wake on USB.
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Appendix B: Control Center

Overview

Thefollowing chapter will give aquick description of the functions of the Control Center. The Control Center
givesquick accessto frequently used controls, power management features and enables you to quickly turn mod-
ules on/off. Click the Control Center iconsto toggle the appropriate function, or hold the mouse button down
and move the slider where applicable. Certain functions will automatically be adjusted when a power mode is
selected. The Control Center in Windows 8 works under the Desktop app (see “ Function/Hot Key I ndicators

& Control Center” on page E - 15) and not under the Start screen, and does not feature the wirel ess/Bluetooth
buttons and Airplane Mode etc.

Figure B - 1 - Control Center
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Power Modes
Y ou can set a Power M ode by clicking the appropriate icon at the top of the Control Center. Each power
mode will affect the power status of modules (e.g. WLAN, Bluetooth, 3G or Camera), screen brightness,

TouchPad power and Silent Mode.

You can click aControl Center icon to set an overall power mode and then click individual iconsin the
Control Center to power on/off any modules etc.

Thetableoverleaf illustrates the basic settingsfor each power mode. If you choose user defined the settings
will correspond to your selected system settings.

. |
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. Flight . . User
Modes Power Saving g Entertainment Quiet Performance .
(Win 7 Only) Defined
Icon ” '
*
Power Plan Power Saver Balanced Power Saving Power Saving High Performance
Power Conservation Mode Energy Star BIOS Default Energy Star Energy Star Performance
Brightness 14 42 100 42 100
WLAN
(Win 7 Only) OFF OFF ON ON ON c
o]
Bluetooth g
(Win 7 Only) BIOS Default .
(0]
(=8
3¢ OFF OFF OFF OFF OFF
(Win 7 Only)
PC Camera OFF OFF OFF ON ON
TouchPad ON ON OFF ON ON

Table B - 1- Power Modes

. |
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Power Status

The Power Status icon wiil show whether you are currently powered by the battery, or by the AC/DC adapter
plugged in to aworking power outlet. The power status bar will show the current battery charge state.

Brightness

The Brightness icon will show the current screen brightness level. You can use the slider to adjust the screen
brightness or the Fn + F8/F9 key combinations, or use the Fn+ F2 key combination to turn off the LED backlight
(press any key to turn it on again). Note that screen brightness is also effected by the Power M ode selected (see
TableB - 1, on page B - 3).

Volume
The Volume icon will show the current volume level. Y ou can use the slider to adjust the Volume or the Fn +
F5/F6 key combinations, or use the Fn+ F3 key combination to mute the volume.

Power Conservation

This system supports Ener gy Star power management features that place computers (CPU, hard drive, etc.) into
alow-power sleep modes after a designated period of inactivity (see“ Power Conservation Modes’ on page 3 -
10). Click either the Perfor mance, Balanced or Energy Star button.
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Sleep
Click the Sleep button to bring up the Hiber nate or Sleep buttons, and click either button to have the
computer enter the appropriate power-saving mode (see “ Power-Saving States” on page 3 - 6).

Display Switch
Click the Display Switch button to access the menu (or use the & + P key combination) and select the appro-
priate attached display mode (see page C - 10).

Time Zone
Clicking the Time Zone button will access the Date and Time Windows control panel.

Desktop Background
Clicking the Desktop Background button will alow you to change the desktop background picture.

TouchPad/PC Camera/Wireless LAN Module /Bluetooth/3.75G Module

Click any of these buttonsto toggle the TouchPad or modul €’ s power status. A crossed out icon will appear over
the top left of theicon when it is off. Note that the power status of a module, and TouchPad power, is also
effected by the Power Mode selected (see Table B - 1, on page B - 3). The WLAN, Bluetooth and 3G buttons
are not featured in the Windows 8 system.
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Silent Mode

Click the Silent M ode button toggles silent mode on/off. Y ou can use Silent M ode to reduce power consump-
tion and fan noise. Note that the Silent M ode effected by the Power M ode selected.

o Silent Mode is OFF

. Silent Mode is On

Note Silent M ode may reduce computer performance.

Caps Lock/Scroll Lock/ Number Lock 8 & &
Click the button to toggle the appropriate lock mode.
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Appendix C: Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features’ on
page 1 - 26. For information on the Windows 8 operating system see Appendix E.

Video Driver Installation

Make sureyou install the driversin the order indicated in Table 4 - 1, on page 4 - 3.

1. Insertthe Device Drivers & Utilities+ User’s Manual disc and click I nstall
Drivers (button).

2. Click 2.Install VGA Driver > Yes.

3. Click Next > Yes> Next > Next.

4. Click Finish to restart the computer.

Note: After installing the video driver go to the Display control panel to adjust the
video settings to the highest resolution.

Dynamic Video Memory Technology

Intel® DVMT automatically and dynamically alocates as much (up to 1748MB)
system memory (RAM) as needed to the integrated video system (the video driver
must beinstalled). DVMT returns whatever memory is no longer needed to the op-
erating system.

. |
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Video Card Options

Note that card types,
specifications and driv-
ers are subject to contin-
ual updates and
changes. Check with
your distributor/supplier
for the latest details on
video cards supported.

DVMT Notes

DVMT is not local video
memory.

DVMT will not function
in MS-DOS. DOS uses
the legacy memory indi-
cated.
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4

Application Mode

Note that all figures pic-
tured, and instructions
outlined here are based
on the Advanced Ap-
plication Mode.

FigureC-1
Intel® G&M
Control Panel

C - 2 Intel® Graphics

Intel® Graphics & Media Control Panel

Advanced video configuration options are provided by the Intel® Graphics and
Media Control Panel. To access the control panel:

1. Click Advanced settings in the Screen Resolution control panel in Windows.
2. Click the Intel(R)... tab and click Graphics Properties (button).

OR
3. Right-click the desktop and select Graphics Properties from the menu.

OR

4. Double-click the Intel(R) G&M control panel in Windows.

5. Choose the application mode (Basic, Advanced or Wizard) required (see
sidebar).

>

& Media Control Panel
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Y ou may make changes to any of the graphics properties by clicking the appropriate
menu tab on the left of the menu and adjusting the settings on the right. Z

Options & Support

Click Options & Sup-
port and select an item
from the sub-menu to
bring up the help and
support topics.

You will need to be con-
nected to the Internet to
access the key resource
links.

Multiple Display

At least one other dis-
play must be attached in
order to view multiple
display selection op-
tions.

FigureC- 2
Intel® G&M

Control Panel Tabs

Intel® Graphics & Media Control Panel C - 3
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Function Key
Combination

You can use the Fn + F7

key combination to tog-

gle through the display

options:

* Notebook Only

e External Display Only

* Notebook + External
Display

Make sure you give the

displays enough time to
refresh.

Note that HDMI sup-
ports video and audio
signals.

TableC-1
Display Modes

Display Devices & Options

Besidesthe built-in LCD you can also use an external monitor/flat panel display/TV
connected to the external monitor port or to the HDMI-Out port (High-Definition
Multimedia Interface) as your display device. The table below outlines the display
options.

Y
Attaching Displays

When you first attach an external display you may find that the desktop does not occupy
the full screen area. Use either the display’s auto adjust/configure controls, or the Intel(R)
G&M control panel to configure the full screen display.

Intel Display Mode Description

One of the connected displays is used as the display

Single Display device

Both connected displays output the same view and may

Clone Displays be configured independently

Both connected displays are treated as separate

Extended Desktop devices, and act as a virtual desktop

C - 4 Intel® Graphics & Media Control Panel
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Attaching Other Displays

4
If you prefer to use amonitor or flat panel display, connect it to the external monitor N
port or HDMI-Out port on the left of the computer. IR IR ]

At least one other dis-

To Clone Displays: play must be attached in

1. Attach your display to the external monitor port or HDMI-Out port, and turn it on. order to view Multiple
2. Gotothe Intel(R) G&M control panel and click Display > Multiple Displays. Display selection op-
3. Click Operating Mode and select Clone Displays from the menu. tions.

4. Click Apply, and OK to confirm the settings change.

5. You can switch the Primary/Secondary Display from the menu. General Settings

Click General Settings
to access settings the
options for any attached
display.

FigureC- 3
Display > Multiple

Displays (Clone)

Attaching Other Displays C - 5
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To Enable Extended Desktop:
4 1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.

: . 2. Gotothe Intel(R) G&M control panel and click Display > Multiple Displays.
Display Settings ; )
Extended Desktop 3. Click Operating Mode and select Extended Desktop from the menu.
4. Click Apply, and OK to confirm the settings change.

You can have different ] ) ]
Colors, Screen Area Click the appropriate monitor
and  Monitor Refresh icon and drag it to match the
Reize i et clgpey physical arrangement you
device provided your ish h d
monitor can support Wi .'[O use (e.g. the second-
them. ary display may be extended

_ left/right/above/below  the
You can drag the moni- . disol
tor icons to match the primary disp ay)
physical layout of your
displays. Icons and pro- Click Genera Settings to
grams may also be make any adjustments re-
dragged between the :

: quired.

displays.

C FigureC-4
Display > Multiple

Displays (Extended)

C - 6 Attaching Other Displays



Video Driver Controls

Display Profiles
Y ou can save display settings to be loaded at any time.

1. Goto the Intel(R) G&M control panel and click Display.

2. Configure the General Settings, Multiple Displays, Color Enhancement, Custom
Resolution & Monitor/TV Settings to your preferences.

3. Click Apply, and OK to confirm the settings change.

4. Click the Save button at the top of the General Settings, Multiple Displays or Color
Enhancement menus (under Display Profiles).

5. Type a name for the Profile and click OK.

6. The Profile will be listed under Display Profiles.

7. Select the profile from the pull-down menu and click Apply, and OK to confirm the
settings change.

FigureC-5
Intel® G&M
Profiles

.|
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4

Function Key
Combination

You can use the Fn +

F7 key combination to

toggle through the dis-

play options:

* Notebook Only

» External Display
Only

* Notebook + External
Display

Make sure you give the

displays enough time

to refresh.

Note that HDMI sup-
ports video and audio
signals.

FigureC-6
Screen Resolution
Multiple Displays

(Win 7)

Video Driver Controls

Configuring an External Display in Windows 7

Y ou can also use the Screen Resolution control panel in Windows 7 to configure an

external display.

1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.

2. Go to the Screen resolution control panel (see “Video Features” on page 1 -
26).

3. Click the Detect button.

4. The computer will then detect any attached displays.

C - 8 Configuring an External Display in Windows 7



Video Driver Controls

5. You can configure the displays from the Multiple Displays menu.

FigureC-7
Screen Resolution
Multiple Display

Options
(Win 7)
» Duplicate these displays - Shows an exact copy of the main display desktop on
the other display(s)
» Extend these displays - Treats both connected displays as separ ate devices

» Show desktop only on 1/2 - Only one of your displaysis used.

.|
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Video Driver Controls

Using the Windows Logo Key g + P Key Combination to Switch Displays

You can also usethe g + P key combination to quickly change display configura-
tion and modes (thisis particularly useful when attaching a projector) in Windows 7.

Attach your display to the external monitor port or HDMI-Out port, and turn it on.
Press the g + P key combination.

An on-screen menu will pop up.

Use the cursor keys (or & + P) to select the appropriate configuration from the
menu, and press Enter to confirm the selection.

PR

FigureC- 8
sz + P Display
Configuration
Selection
(Win 7)
Y ou can also use the Display Switch button inthe Control Center to accessthe
menu and select the appropriate attached display mode.

.|
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Video Driver Controls

HDMI Audio Configuration

HDMI (High-Definition Multimedia I nterface) carries both audio and video signals.
In some cases it will be necessary to go to the Sound control panel and manually
configure the HDMI audio output as per the instructions below.

1.
2.
3.

Click Start, and click Control Panel (or point to Settings and click Control Panel).
Click Sound  (Hardware and Sound) and click Playback (tab)

Depending on your display, the playback device may be selected, however in some
cases you may need to select the audio device and click Set Default (button).
Double-click the device to access the control panel tabs illustrated overleaf.

4

Volume Indicator

Click the taskbar volume
indicator ] when an
HDMI device is select-
ed, and you will note that
the icon at the top of the
volume level indicator
has changed.

FigureC-9
Sound - HDMI
Device (set Default)

HDMI Audio Configuration C - 11




Video Driver Controls

5. Double-click the connected HDMI device (or right-click and select Properties) to
adjust the HDMI settings from the control panel tabs.
6. Click OK to close the control panel (see notes overleaf).

FigureC- 10
HDMI Device
Properties

C - 12 HDMI Audio Configuration



Video Driver Controls

HDMI Notes

Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-
ing to play audio/video sources through the device.

To play audio sources through your external display’s (TV or LCD) speakers
you will need to go to the audio configuration control panel on the display and
configure the audio input accordingly (see your display device manual).

HDMI Video Configuration

1.
2.

3.

HDMI Audio Configuration C - 13

Connect an HDMI cable from the HDMI-Out port to your external display.
Configure your external display as per the instructions in “Attaching Other
Displays” on page C - 5.

Set up your external display (TV or LCD) for HDMI input (see your display device
manual).

You can now play video/audio sources through your external display.

4

Other Applications

If you are using a third
party application to
play DVDs etc. from
any attached DVD de-
vice, you will need to
consult the applica-
tion’s documentation
to see the appropriate
audio configuration
(the application must
support digital to ana-
log translation).



Video Driver Controls

C-14



Specifications

Appendix D: Specifications
e

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your distributor/supplier for details.

.|
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Specifications

Intel® Pentium® B980 (2.4GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Pentium® B970 (2.3GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Pentium® B960 (2.2GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Pentium® B950 (2.1GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Pentium® B840 (1.90GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Celeron® B820 (1.70GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Celeron® B815 (1.60GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Celeron® B810 (1.60GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Celeron® B730 (1.80GHz)
1.5M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Celeron® B720 (1.70GHz)
1.5M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Mobile Intel® HM70 Express Chipset

Dual Channel DDRIII (DDR3)

Two 204 Pin SO-DIMM sockets
supporting DDR3 1333MHz / 1600MHz
(real operational frequency depends on
the FSB of the processor)

Memory Expandable up to 8GB (using
1GB/2GB/4GB SO-DIMM Modules)

Model A:

14.0” / 35.56cm HD (1366 * 768), 16:9
Backlit Panel

Model B:
15.6" / 39.62cm HD (1366 * 768) / HD+
(1600 * 900)16:9 Backlit Panel

Model C:
17.3"/ 43.94cm HD+ (1600 * 900), FHD
(1920 * 1080), 16:9 Backlit Panel

Intel® HD Graphics
(GPU is Dependent on Processor):

Dynamic Frequency

Intel Dynamic Video Memory Technology
up to 1.7GB

Microsoft DirectX®10 Compatible
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One Changeable 12.7mm(h) Super Multi/
Blu-ray Combo Optical Device Drive with
SATA Interface (Factory Option)

One Changeable 2.5"/ 9.5 mm (h) HDD
with SATA (Serial) Interface

Dummy Optical Device Drive (Factory
Option - for some Model designs in this
series)

Built-in Touchpad with Multi-Gesture
Functionality

Model A Only:

Isolated OR Floating A4 Size Keyboard
(Design Style Dependent)

Three Instant Buttons:

WWW/ E-Mail / Silent

OR

WWW/ E-Mail / WLAN ON/OFF
(Design Style Dependent)

Models B & C:

Isolated A4 Full Size Keyboard with
Numeric Keypad

High Definition Audio Interface
Built-In Microphone
2 * Built-In Speakers

One USB 2.0 Port

Two USB 3.0 Ports

One External Monitor Port

One HDMI-Out (High-Definition
Multimedia Interface) Port (with HDCP)
One Headphone-Out Jack

One Microphone-In Jack

One RJ-45 LAN Jack

One DC-In Jack

Embedded Multi-In-1 Card Reader

- MMC/ RS MMC

- SD/ Mini SD / SDHC/ SDXC

- MS/ MS Pro/ MS Duo

Note: Some of these cards require PC
adapters that are usually supplied with
the cards.

Specifications

Models A & B:

Two Mini-Card Slots with PCle & USB
Interfaces:

Slot 1 for WLAN Module

Slot 2 for 3G Module (Factory Option)

Model C:

One Mini-Card Slot with PCle & USB
Interfaces:

Slot 1 for WLAN Module

Built-In 10/100/1000Mb Base-TX
Ethernet LAN

Intel® Centrino® Wireless-N 2230 2*2
(802.11 b/g/n) Half Mini-Card PCle
WLAN + Bluetooth Combo Module
(Factory Option)

Intel® Centrino® Wireless-N 135 (1*1
802.11 b/g/n+) Half Mini-Card PCle
WLAN & Bluetooth Combo Module
(Factory Option)

(Continued overleaf)
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Specifications

3rd Party Combo WLAN (802.11b/g/n)
and Bluetooth v4.0+HS Half Mini-Card
Module with PCle Interface (Factory
Option)

3rd Party WLAN 802.11b/g/n Half Mini-
Card Module (Factory Option)

Model A:

300K / 1.3M Pixel or 2.0M HD PC Video
Camera Module with USB interface
(Factory Option)

Models B & C:

2.0M HD PC Video Camera Module with
USB interface (Factory Option)

Models A & B Only:

UMTS/HSPDA OR UMTS/HSPDA+
based 3G Module with Mini-Card
Interface (Factory Option)

Quad-band GSM/GPRS (850 MHz, 900
MHz, 1800 MHz, 1900 MHz)

UMTS WCDMA FDD (2100 MHz)

Note that UMTS modes CAN NOT be
used in North America

Supports Wake on LAN
Supports Wake on USB

Full Range AC/DC Adapter

AC input 100 - 240V, 50 - 60Hz,

DC Output 19V, 3.42A or 18.5V, 3.5A (65
Watts)

Removable 6 Cell Smart Lithium lon
Battery Pack 48.84WH

Removable 6 Cell Smart Lithium lon
Battery Pack 62.16WH (Factory Option)

LED Indicators - Power/Suspend,
Battery, HDD/ODD, Bluetooth/Wireless
LAN, Num Lock, Caps Lock, Scroll Lock,
CCD

Model B & C Computers:
Camera LED located on camera module

For Model A Computers:
Camera LED located on Power/Suspend
LED

For some Model A designs in this series:
Power/Suspend, Battery, HDD/ODD,
Bluetooth/Wireless LAN

Windows® 7 with Service Pack 1
Windows® 8

48Mb SPI Flash ROM
AMI BIOS

Security (Kensington® Type) Lock Slot
BIOS Password
Trusted Platform Module V1.2

IMR (Injected Molded Resin) LCD Back
Covers (For some Model designs in this
series)

Painted Style (For some Model designs
in this series)

Magic Of Film Art Il Changeable LCD
Back Covers (For some Model designs
in this series)
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Temperature

Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C
Relative Humidity

Operating: 20% - 80%
Non-Operating: 10% - 90%

Model A (Design Style Dependent):
340mm(w) * 238mm(d) * 26.25-34.7mm(h)
2.2 kg with 48.84WH Battery & ODD

OR

341mm(w) * 238.5mm(d) * 16-34mm (h)
2.2 kg with 48.84WH Battery & ODD

OR

340mm(w) * 238mm(d) * 12-30.2mm(h)
2.15 kg with 48.84WH Battery & ODD

Model B (Design Style Dependent):
374mm(w) * 250mm(d) * 14.3-34.1mm(h)
2.3 kg with 48.84WH Battery & ODD

OR

374mm(w) * 250mm(d) * 20-37.2mm(h)
2.6 kg with 48.84WH Battery & ODD

Model C:
413mm(w) * 270mm(d) * 14-40.5mm(h)
2.9 kg with ODD & 48.84WH Battery

Specifications
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Windows 8

Appendix E: Windows 8

Overview

This Appendix contains information (including control panel information, driver installation etc.) for users of
the Windows 8 OS.

Y ou can refer to the main manual for details of driversrequired, audio & video information, BIOS, modules etc.
However any information specific to Windows 8 will be included in this Appendix, as well as details on how to
navigate the Windows 8 M etro User Interface to access the applications, control panels, taskbar etc.

4

Windows 7/8 OS

In order to run Windows 7 or 8 (32 Bit) without limitations or decreased performance, your computer requires a minimum
1GB of system memory (RAM), however if you are running Windows 7 or 8 (64 bit) your computer requires a minimum
2GB of system memory (RAM).
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Windows 8

Windows 8 Start Screen & Desktop

The Apps, control panels, utilities and programs within Windows 8 are accessed from the M etr o user interface’s
Start screen and/or Windows Desktop. The Desktop (which runs as an app within the Start screen) can be ac-
cessed from the Desktop iteminthe Start screen (or by using the Windows L ogo Key 5@ + D key combination).

Figure E - 1 - Windows Start Screen

E - 2 Windows 8 Start Screen & Desktop



Windows 8

Apps & Tiles

The Windows 8 Start screen will contain a number of Apps, and many more will be installed as you add more
applications etc. Not all of these apps can fit on one screen so you will often need use the slider at the bottom of
the screen in order to view al the necessary apps.

Accessing Pining/Unpinning All Apps

Y ou can add and remove the tiles for apps and control panelsin the Start screen. Right-click on a blank area of
the Metro Ul Start screen and you will seethe All Appsicon. Click the All Appsiconto display al theinstalled
applications etc. Right-click any icon to bring up the menu at the bottom of the screen. Y ou can then click the
appropriate icon to pin the app to (or unpin from) the Start screen, or to the taskbar in the Desktop applica-
tion.

® @ ® @ 6

Pin to Start Pin to taskbar Uninstall Open new n as n file
window admlm strator Iccatlon

Figure E - 2 - All Apps

Windows 8 Start Screen & Desktop E - 3
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Windows 8

Desktop Application

When the Desktop app is running (click the app in the Start screen or use the Windows L ogo Key g@ + D key
combination) you can use lower left hot corner to switch between the Start screen and the Windows Desktop.
To do so move your mouse to hover over the bottom left corner of the screen and click the pop-up.

When you move to the lower left hot corner in the Start screen itself it will take you back to your most recently
used app.

Move the mouse to the bottom left of the screen and click to switch
back to the Start screen.
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Figure E - 3 - Desktop

.|
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Windows 8

When the Desktop app is running you can right-click the lower left hot corner (or use

the Windows L ogo Key g@ + X key combination) to bring up an advanced context Y

menu of useful features such as Control Panel, Programs and Features, Power Op-

tions, Task Manager, Search, Windows Explorer, Command Prompt, Device Man- Display Most
Recently Used

ager and Network Connections etc.

Programs and Features
Meobility Center

Power Options

Event Viewer

System

Device Manager

Disk Management
Computer Management
Command Prompt

Command Prompt (Admin}

Task Manager
Control Panel
File Explorer
Search

Run

Desktop

Move the mouse to the bottom left of the screen

and right-click to access the menu.

Figure E - 4 - Advanced Context Menu (Right-Click lower left hot corner)

Windows 8 Start Screen & Desktop E-5

Apps

If you are in the Start
screen, Desktop or an
app you can move your
mouse to the upper left
corner of the screen to
get back to the most re-
cently used app.

To view all the most re-
cently used apps hover
over the top left of the
screen and then move
the mouse down along
the left side of the
screen to display the
list.
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Windows 8

Windows 8 Charms Bar

Theright side of the screen displays the Windows 8 Charms Bar. The Charms Bar contains the Sear ch, Share,
Start, Devices and Settings menus. To access up the Charms Bar move the cursor to the upper or lower right
corners of the screen, and then hover over one of the itemsin the Charms Bar to activate it (the bar will be black
when it is active), or use the Windows L ogo Key g@ + C key combination.

Figure E - 5 - Start Screen with Charms Bar

E - 6 Windows 8 Start Screen & Desktop



Windows 8

Charms Bar Items

* Search E: You can search for any file, application, apps and control panel settings with instantaneous
results.

« Share@): Thisbutton is used to share information with people viamail or social networks.

 Sart .: Click to bring up the Start Menu (the same function as pressing the Windows Logo Key or click-
ing the bottom left of the screen).

. Devices: Click this button to change connected peripheral device settings e.g. an external display.

o Setti ngsE]: This button gives instant access to the computer settings, such as Network, Audio, Brightness,
Notifications, Power and Keyboard (click Change PC Settings to activate the PC Settings menu).

124 i) -O: 4
Upiprmriids & ) s Charms Bar - TouchPad Access

To quick access the Charms Bar using the TouchPad:

1. Place your finger off the TouchPad (slightly to the right of
Notifications Power Keyboard the pad resting on the computer).

2. Move your finger across to the left on to the TouchPad.

3. The Charms Bar will then pop-up.

Change PC settings
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Figure E - 6 - Settings Menu

Windows 8 Start Screen & Desktop E-7



Windows 8

Windows 8 Control Panel
In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is much the same as that in Windows 7, however it can be accessed in a number of waysin Windows 8.

* Click Search inthe Windows Charms Bar (see previous page) and the search pane will pop out. Type
Control Panel and select it from the results to the | eft.

Figure E - 7 - Search (Control Panel)

* Click on Computer inthe Start screen, click on Computer in the top menu and select Open Contr ol
Panel from the ribbon.
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Figure E - 8 - Open Control Panel (Computer)
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Windows 8

* Whenin the Desktop app (this does not apply to the Start screen) click on Settingsin the Windows
Charms Bar and select Control Panel from the menu.

Settings

’ & i )
wntrol Panel

q

Figure E - 9 - Settings Charms Bar (Desktop App Only)

* Right-click on a blank area of the Metro Ul Start screen, click the All Appsicon and click Control
Panel.
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Figure E - 10 - All Apps - Control Panel
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Windows 8

» Right-click the lower left hot corner to bring up the menu and select Control Panel (see Figure E - 4 on
pageE - 5).

4

Keyboard Shortcut to Control Panel

You can also use keyboard shortcuts to access the Control Panel. Press the Windows logo key § and X to bring up
the context menu, and then press P to bring up the Control Panel. Alternatively press the Wlndows Iogo key & and R
to bring up the Run dialog box, and then type “Control Panel” and press Enter to access the Control Panel.
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Windows 8

Windows 8 Taskbar

In many instances throughout this manual you will see an instruction to access the notification ar ea of the task-
bar. In Windows 8 the taskbar is accessed from the Desktop application. If you are in the Start screen you will
need to click the Desktop app to switch to the Desktop.

The taskbar is displayed in much the same way as it wasin Windows 7, and you can see the notification area of
the taskbar in the bottom right of the screen. Some of the Control Panels and applications referred to during the
course of this manual can be accessed from here.

Figure E - 11 - Desktop Taskbar

Y ou can pin/unpin apps to/from the taskbar in much the same way as you can to the Start screen (see“ Accessing
Pining/Unpinning All Apps’ on pageE - 3).
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Windows 8

LED Indicators

Icon Color Description
The LED indicators on the computer display helpful . .
. . The (optional) Wireless LAN Module
information about the current status of the computer. Green is Powered On
Win 7 - The (optional) Bluetooth
Icon Color Description Module is Powered On
Orange DC Power is Plugged In Orange | win 8 - The (optional) Bluetooth
_ Module is Installed (this is not a
Green The Computer is On power on/off indicator in Windows 8)

The Computer is in Sleep

Blinking Green Mode Green Hard Disk Activity
The PC Camera is In Use Green Number Lock Activated
Blinking Orange | (for 14.0” / 35.56cm Model A
computers only) Green Caps Lock Activated
Orange The Battery is Charging
) Green Scroll Lock Activated
Green The Battery is Fully Charged
The Battery Has Reached Table E - 2 - LED Status Indicators

Blinking Orange Critically Low Power Status

Table E - 1 - LED Power Indicators
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Keyboard - Windows 8

The main difference between the Windows 7 & Windows 8 keyboardsisin the func-
tion of theWindows L ogo Key & Menu/Application Key (inthe Start screen), oth-
erwise the keyboard functions are identical (see “Keyboard - Model A” on page 1 -
13/*Keyboard - ModelsB & C” on page 1 - 14).

Windows Logo Key

Menu/Application Key

Figure E - 12 - Keyboard - Model A

The function/hot key indicators function in the same manner as outlined for Windows
7 on “Function/Hot Key Indicators’ on page 1 - 15. However the indicators work
under the Desktop App (see“ Desktop Application” on page E - 4) and not under the
Start screen.

Keyboard - Windows 8 E - 13

Windows 8

4

Windows Logo
Keyboard Shortcut

Use the Windows logo
key 3@ + D key com-
bination to switch be-
tween the Start screen
and Windows Desktop
(see Table E - 3 over-
leaf for further informa-
tion).

Menu/Application
Keyboard Shortcut

When the Desktop app
iS running you can use
the Menu/Application
key [Z] on the key-
board to display the
context menu as per a
mouse right-click. In
the Start screen this
function is useful to
quickly display the All
Apps icon.
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Windows 8

Keyboard Shortcuts
Thefollowing Windows L ogo Key (Winkey) keyboard shortcuts are useful for navigation/operation in Windows 8.

Windows Logo =@ Key + Description
Tap Winkey Toggle between the Start screen and the foremost running app or the Windows Desktop
C Display Charms menu
D Switch to the Windows Desktop and toggle show Desktop
E Switch to the Windows desktop and launch Windows Explorer with Computer displayed
F Display file Search

I Open the Settings charm

Open the Connect charm

Lock the computer and display the Lock screen

Display the Second Screen menu (see Figure E - 14 on page E - 16)

Switch to the Windows Desktop and display the Run dialog box

N| 0| O | X

Access the App Bar (see Figure E - 4 on page E - 5)

Table E - 3 - Keyboard Shortcuts
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Windows 8

Function/Hot Key Indicators & Control Center

The function/hot key indicators and Control Center function in the same manner as outlined for Windows 7 in
“Function/Hot Key Indicators’ on page 1 - 15 and “ Control Center” on page 1 - 16. However both of these
functionswork under the Desktop app (see“ Desktop Application” on page E - 4) and not under the Start screen,
and the Control Center does not feature the wireless/Bluetooth buttons and Airplane Mode etc.

4

Control Center

Click on any button to turn any of the modules (e.g. Touch-
Pad, Camera) on/off.

Click on the power conservation modes to switch between
Performance, Balanced or Energy Star modes (see page 3
- 10). To remove the Power Conservation Modes screen
just click in a blank area of the icon or press a key on the
keyboard.

Click on the buttons (or just click and hold the mouse but-
ton) to adjust the slider for Brightness/Volume.

Click on Display Switch and click to choose a display mode
from the menu (see page C - 10).
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Figure E - 13 - Control Center
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Windows 8

Video Features

Y ou can switch display devices, and configure display options, from the Display control panel (in Appear ances
and Per sonalization) in Windows 8 in the same manner as Windows 7 running the Desktop app (see “ Desktop
Application” on page E - 4 and Appendix C). In Windows 8 it is possible to quickly configure external displays
from the Devices menu item in the Charms Bar (see “Windows 8 Charms Bar” on pageE - 6).

To Configure Displays from Devices (Charms Bar):

Attach your display to the appropriate port, and turn it on.

2. Gotothe Charms Bar and select Devices.

3. Click Second Screen.

4. Click on any one of the options from the menu to select Duplicate, Extend or a Single display.

L

Devices

Start

There’s nothing to send right now.

I:T Second screen
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Figure E - 14 - Second Screen (Devices)
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Windows 8

Power Options

Power Options can be accessed from the Control Panel in the same manner as Windows 7 from the Desktop app.
The Power item in Settingsin the Charms Bar in Windows 8 may be used to Shut down, Restart or send the

computer to Sleep.

Shut Down, Restart or Sleep

1. Gotothe Charms Bar and click Settings.
2. Click Power .

3. Select Sleep, Shut Down or Restart.

Sleep

0—] Shut down 2
Fau o

-b'd

LEVETEL  Restart Brightness

2 O

Natifications Power Keyboard

Change PC settings
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Figure E - 15 - Power (Settings)
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Windows 8

Ctrl + Alt + Delete Key Combination
You canusethe CTRL + ALT + DEL key combination from almost any of the Windows 8 interfaces/apps to
bring up afull-screen displaying L ock, Switch User, L og off, Change a password and Task M anager options.
If you click the Power iconin the lower right corner of the screen a power management option menu appears to
display Sleep, Shut down, and Restart.

Figure E - 16 - CTRL + ALT + DEL Menu

To fully control al the power options (including Hibernate mode) go to the Power Options control panel and
configure the power button, sleep button and lid (see Figure E - 17 on page E - 19) to perform the function se-
lected.

E - 18 Power Options



Windows 8

Wake On LAN Settings

If you require your computer to wake up from network activity in Windows 8 then 7\£l/<
make sure that the computer is either in Sleep or Hiber nate. The power/sleep button Wake On LAN
(Fn + F4 key combo) and closed lid may be set to send the computer in to a power- Support

saving state. Click Choose what the power buttons do on the left menu in Power (Windows 8)
Optionsto bring up the menu.

Wake-On-LAN is only
supported from Sleep or

Hibernate states in
Windows 8.

Wake-On-LAN is not
supported from Shut-
down states in Win-
dows 8.
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Figure E - 17 - Power Options Define Power Buttons
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Running Metro Ul Apps

. To run Apps in the Metro Ul in Windows 8 you will need to check that the Screen
Screen Resolution Resol uti dUser A t Control ti atible with th <
for Metro Style Apps esolution and User Account Control Settings are compatible with the system re-

(Windows 8) quirements:

e tide @ Screen Resolution Settings

LETEERVEIGEEIERE 1. Switch to the Windows Desktop (click the App or use the Windows logo key 2@ + D
apps will  run is key combination).

1024x768. 2. Right-click a blank area of the Windows Desktop and select Screen Resolution.

3. Adjust the Resolution to make sure that it is at least 1024 * 768, although preferably

U e ) 1366 * 768 or above (see sidebar).
required to support all

the features of Windows
8 (including multitasking
with snap) is 1366x768.

SN
ALK

These specs are the
minimum screen resolu-

tion that supports all the
features of Windows 8 | |
on a useful physical

size.
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Figure E - 18 - Screen Resolution
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User Account Control Settings

If your computer meets the minimum screen resolution requirements, and still you can't run Metro Apps, then
that you have to check the status of User Account Control (UAC). Metro Apps may fail to open whenthe UAC
isturned off. To check whether the UAC is on or off, follow the instructions below.

1.
2.

3.

Open the Control Panel (see “Windows 8 Control Panel” on page E - 8).

Click on User Accounts and then click on Change User Account Control settings (or click System and
Security and click Change User Account Control Settings under Action Center).

If the slider is in the Never notify position, then the UAC is disabled.

To enable or turn on the UAC, move the slider to Always notify or Notify me when apps try to make changes
to my computer (default) position, and then click OK.
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Figure E - 19 - User Account Control
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Drivers & Utilities

Make sure you install all the driversand uti lites for your system. Follow the instructionsin Chapter 4 “ Drivers
& Utilities” on page 4 - 1/“Modules & Options” on page 7 - 1 for installing al the basic system drivers and
module drivers for Windows 7 & 8.

However note that the USB 3.0 and 3G driver Sapplicationsarenot required for Windows 8, and that the PC
Cameradriver isonly required for 14.0” / 35.56cm Model A computers.
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Driver Installation (Windows 8)

1. Insert the Device Drivers & Utilities + User’s Manual disc into the computer’s DVD drive.
2. Click the message “Tap to choose what happens with this disc.”
3. Click Run autorun.exe.

BD-RE Drive (E:) My Disc

Tap to choose what happens with this disc.

4

Driver Installation

If you miss the message above you can eject the De-
vice Drivers & Utilities + User's Manual disc and then
reinsert it.

Alternatively double-click the disc icon in Comput-
er (use the Windows logo key == + E key combina-
tion to go to Computer in Windows Explorer).

Figure E - 20 - Autorun Driver Installation Disc

4. Click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

5. Check the driver installation order from Table E - 4, on page E - 24 (the drivers must be installed in this
order) which is the same as that listed in the Drivers Installer menu below.

6. Click to select the driver you wish to install, (you should note down the drivers as you install them).

7. Follow the instructions for each individual driver installation procedure as listed on the appropriate pages.
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Win 7 SP1/Win 8 Driver Page # Win 7 SP1/Win 8 Driver Page #

PC Camera Module (see page E - 25)
Chipset Page 4 -6 (Only 14.0” / 35.56cm Model A computers Page 7 -2
require a camera driver for Windows 8)

Video (VGA) Page 4 -6 Wireless LAN Module (see page E - 30) Page 7 - 10

LAN Page 4- 6 Bluetooth & WLAN Combo Module (see Page 7 - 31
page E - 37)

CardReader Page 4 -6 The USB 3G driver is not required for Windows 8 (see page E - 42)

Touchpad Page 4 -6 Trusted Platform Module Page 7 - 64

Hot Key Page 4 - 7 Intel Rapid Storage Technology Page 7 - 78

(required for hard disks in AHCI mode)

The USB 3.0 driver is not required for Windows 8 | All drivers provided are for Windows 7 with Service Pack 1
Page 4 -7 or Windows 8.

MEI Driver

Audio Page 4 -7

Table E - 4 - Driver Installation

Note that you need to install both the WLAN & Bluetooth driversfor the Intel and 3rd party WLAN & Blue-
tooth Combo modules.
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PC Camera (Windows 8)

Usethe Fn + F10 key combination (see“ Function/Hot Key I ndicators’ on page 1 - 15) or Control Center but-
ton to toggle power to the PC Camera module.

A PC Camera driver is only required if you have aModel A computer with a 14" /35.56cm screen (see “ PC
Camera Driver Installation” on page 7 - 4). Model B & C computers do not requireany driver installation.

When the 14" /35.56cm screen Model A PC Camerais in use the power LED indicator will blink orange (see
Tablel- 2, onpagel-11).

When the M odel B/C PC Cameraisin usethe LED indicator to the left of the camerawill beilluminated in red
(see @ Figurel-4onpagel- 9/Figurel-5on pagel- 10).

Note that you need to use the Camera App in Windows 8 to take pictures and capture video (the camera appli-
cation listed in Chapter 7 isfor Windows 7 only).

.|
PC Camera (Windows 8) E - 25
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Metro Ul Camera App

1. Make sure the PC Camera is turned on by using the Fn + F10 key combination (or Control Center button).
2. Run the Camera App from the Metro Ul by clicking on the Camera App icon @

3. The camera interface is a translucent app bar with three buttons.

Figure E - 21 - Camera App Bar
» Cameraoptions.. Click this button to open a window with three main options:

el Camera options
Camera Options o .
Photo resolution
» Resolution (determined by the camera spec) 0.TMP (4:3) v
» Audio device (select microphone to use) Audio device
) - ) Microphone (Realtek High Defin.. w
* Video Sabilization (atoggle based on spec of
the Camera) Video stabilization
off i

More
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Figure E - 22 - Camera Options
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You can aso click on Moreto adjust Brightness, Contrast and Flicker (if you find that the video screen in
the camera program is flickering, you can try to adjust the setting here),

More options

oo

3.
i<}
0

=3
]
i
@

Contrast

Flicker

60 Hz v

50 Hz

Figure E - 23 -More Camera Options

» Timer: Thisbutton will start athree second countdown before the system takes a still photo or video record-
ing starts.

* Video Mode: This button toggles between still photo mode (transparent button m) and video recording
mode (highlighted white button g ).

PC Camera (Windows 8) E - 27
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Taking Pictures/Capturing Video

Make sure the PC Camera is turned on by using the Fn + F10 key combination (or Control Center button).
Run the Camera App from the Metro Ul by clicking on the Camera App icon @

Click to select the timer if you require a countdown before capture.

Click to select either photo or video modes.

Click in the main window to take a picture or start video capture (if video capture begins a timer will appear in
the bottom right corner of the screen).

To stop video capture click the main window again.

Captured photos and videos will be saved to a Camera Roll folder within the Picture folder in Libraries.

agrwnE

N o
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Figure E - 24 - Libraries - Pictures
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10.

11.
12.
13.

14.

Windows 8

A scroll arrow will appear on the left side of the screen after any pictures/videos have been captured.

Click the arrows (on either side of the screen) to browse through the captured photos/video, and back to the
Camera App.

Clicking on a captured photo will bring up an App bar with Crop and Delete buttons.

Figure E - 25 - Crop & Delete Buttons (for Still Photos)

Use the handles to Crop any captured picture, and click OK to save the changes made.
Click Delete to delete any captured photo (note that no prompt will appear to confirm the delete).
Right-click any captured video to bring up app bar with Trim and Delete buttons.

Figure E - 26 - Trim & Delete Buttons (for Video Files)

Use the buttons at either end of the slider to adjust the video length and click OK to save the changes made.

=
>
Q
o
=
(9]
0

PC Camera (Windows 8) E - 29



Windows 8

Wireless LAN Settings (Windows 8)

If you have included an Intel® or 3rd Party WirelessLAN (or WLAN & Bluetooth combo) modulein your pur-
chase option, make sure that the WLAN module is on before installing the driver.

Usethe Fn + F11 key combination (see“ Function/Hot Key Indicators’ on page 1 - 15) or Control Center but-
ton to toggle power to the Wireless LAN module. Make sure you install the drivers in the order indicated in
Table4 - 1, on page4 - 3. See “ 3rd Party 802.11b/g/n Driver Installation (for WLAN Module)” on page 7 - 12/
“3rd Party 802.11b/g/n Driver Installation (for Combo Modules)” on page 7 - 13 or “Intel® WLAN Driver In-
stallation” on page 7 - 14 for driver installation information, however see overleaf for WL AN configuration in-
formation in Windows 8.

Note that you need to install both the WLAN & Bluetooth driversfor the Intel and 3rd party WLAN & Blue-
tooth Combo modules.
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WLAN Configuration in Windows 8

Y ou can configure a wireless connection using one of the following options, however make sure the Wireless
LAN moduleisturned on (and not in Airplane Mode) before configuration begins.

Charms Bar

1. Go to the Charms Bar.

2. Select Settings and then click the WiFi icon (it should read Available under the icon and Airplane mode
should be Off).

3. Alist of available access points will appear.

(®© Networks

vl Airplane mode
% \ I") ',O; off [ |
]

Available 67 Brightness
Wi-Fi

Guest 2

= | d) RD113-DIR825-2.4GHZ

Notifications Power Keyboard DA EAD RS AR
Openfly
Guest
Change PC settings RDTH4-E
CLEVO-RD18-WRT300N2
pda-rd112-2.4GHz-50Mb
Chamber12

Hidden network
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Figure E - 27 - WiFi Settings (Charms Bar) & Networks
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Double-click an access point to connect to it (or click it and click Connect).
Enter a network security key (password) if required, and click Next.

You can choose to share or connect to devices or not.

When you are connected to the network access point it will display the Connected icon .
Select any connected network and click Disconnect to disconnect from a connected access point.

(© Networks Networks

Airplane mode
Airplane mode Off [ |

Off 0

©No A

Wi-Fi

Wi-Fi RD13-DIR.. DIR.. Connected il

RD113-DIR... Connected il

Figure E - 28 - Networks Connected / Disconnect
9. You can click the Airplane Mode button to turn the mode On or Off.
10. If you click on Change PC Settings (at the bottom of Settings in the Charms Bar) you can turn Wireless or
Airplane Mode On/Off (see over).
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PC settings

Activate Windows
Personalize

Users
Notifications
Search

Share

General

Privacy

Devices

WEESS

Airplane mode

Turn this on to stop wireless communication

off

Wireless devices

Wi-Fi

on

Figure E - 29 - PC Settings (Wireless)

Windows 8

11. You need to either use Airplane Mode, or to turn the WLAN module off aboard aircratft.

N /
Z &
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft

is usually prohibited.

Make sure the module is
either OFF or in Air-
plane Mode (for Win-
dows 8 only) if you are
using the computer
aboard aircraft.
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Desktop Mode

Switch to the Windows Desktop (click the App or use the Windows logo key == + D key combination).
Click the wireless icon [ in the notification area of the taskbar.

A list of available access points will appear.

Double-click an access point to connect to it (or click it and click Connect).

Enter a network security key (password) if required, and click Next.

You can choose to share or connect to devices or not.

Select any connected network and click Disconnect to disconnect from a connected access point.

Nogh,~wdhE

(© Networks

Airplane mode

ot i
Wi-Fi
NEWTIIS Guest 2

Airplane mode
RD113-DIR855-2.4GHZ-6

off [ |

Openfly
Guest

Wi-Fi RD114-E
CLEVO-RD18-WRT300N2

RD113-DIR... DIR.. Connected il R EAERETD

Chamber 12
Hidden network

Figure E - 30 - Windows Desktop Taskbar Notification Area WLAN Connection
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Control Panel
If you arein Category View do the following (see over for Icon View):

1. Open the Control Panel (see “Windows 8 Control Panel” on page E - 8).
2. Click the Network and Internet control panel.
3. Click Connect to a network.

Figure E - 31 - Network and Internet Control Panel

A list of available access points will appear.

Double-click an access point to connect to it (or click it and click Connect).

Enter a network security key (password) if required, and click Next.

You can choose to share or connect to devices or not.

Select any connected network and click Disconnect to disconnect from a connected access point.
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If you arein Icon View do the following:

1. Open the Control Panel (see “Windows 8 Control Panel” on page E - 8).
2. Click Network and Sharing Center.
3. Click Change Adapter Settings.
4. Double-click Wi-Fi.
s
=1 Figure E - 32 - Network and Sharing Center Control Panel
% 5. Alist of available access points will appear.
s 6. Double-click an access point to connect to it (or click it and click Connect).
» 7. Enter a network security key (password) if required, and click Next.
oo 8. You can choose to share or connect to devices or not.
9. Select any connected network and click Disconnect to disconnect from a connected access point.
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Bluetooth Settings (Windows 8)

If your purchase option includes the Combination Wireless LAN & Bluetooth module (either Intel® or 3rd
Party) then install the driver asinstructed in Chapter 7 (seelinks below).

Usethe Fn + F12 key combination or Control Center button to toggle power to the Bluetooth module.

4

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in
one direction only (simultaneous data transfer is not supported). Therefore if you are copying a
file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Blue-
tooth enabled device to your computer until the file transfer process from the computer has been com-
pleted.

* For 3rd party Bluetooth modules see” 3rd Party Bluetooth (VV4.0) Combo Driver | nstallation” on page 7
-33.

* For Intel Bluetooth combo modules see the installation procedure see “ I ntel Bluetooth Combo Driver
Installation” on page 7 - 34.
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Bluetooth Configuration in Windows 8
Y ou can configure a Bluetooth connection as bel ow, however make sure the Bluetooth moduleis turned on (and
not in Airplane Mode) before configuration begins.

Desktop Mode

1. Switch to the Windows Desktop (click the App or use the Windows logo key &@ + D key combination).

2. Click the notification area of the taskbar and double-click the Bluetooth icon E (or click and select Show
Bluetooth Devices).

3. The Devices item in PC Settings will appear.
OR

Charms Bar

1. Go tothe Charms Bar.

2. Select Settings and then click Change PC Settings.

3. The Devices item in PC Settings will appear.

* .6,

. .
D)

Available Brightness

Notifications Power Keyboard

Change PC settings

Figure E - 33 - Bluetooth Taskbar Icon & Change PC Settings (Charms Bar -Settings)
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4. Click Add a Device.
5. Double-click the device you want to pair with the computer.

Figure E - 34 - PC Settings (Devices) - Add A Device
6. On first connection the computer will provide you with a pairing code to be entered onto the device.

Figure E - 35 - Enter the Passcode
7. Enter the code into your Bluetooth enabled device and click Yes on the computer to complete the pairing.
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8. You need to either use Airplane Mode, or to turn the Bluetooth module off aboard aircratft.

PC settings

Activate Windows
Personalize

Users
Notifications
Search

Share

General

Privacy

Devices

Ease of Access

Sync your settings

Figure E - 36 - PC Settings (Wireless)
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Airplane mode

Turn this on to stop wireless communication

off

Wireless devices

Mobile broadband

on |
Wi-Fi

on L__ |
Bluetooth

on L |

Mobile broadband hardware

Chunghwa Telecom

N /
2§
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft

is usually prohibited.

Make sure the module is
either OFF or in Air-
plane Mode (for Win-
dows 8 only) if you are
using the computer
aboard aircraft.
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To Make your Computer Discoverable to Bluetooth Devices

1.
2.
3.

4.

Switch to the Windows Desktop (click the App or use the Windows logo key == + D key combination).

Click the notification area of the taskbar, click the Bluetooth icon E and click Open Settings.

Click Options, and make sure that Allow Bluetooth devices to find this computer check box (Discovery)
has a tick inside it.

Make sure that the Alert me when a new Bluetooth device wants to connect check box (Connections) has
a tick inside it, if you want to be notified when a Bluetooth device wants to connect.
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Figure E - 37 - Bluetooth Settings
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3G Settings (Windows 8)

(For ModelsA & B Only)

If you have included an optional UMTS/HSPDA OR UM TS/HSPDA+ based 3G Module (Universal Mobile
Telecommunications System or High Speed Packet Access) module (see “ Communication” on page D - 3 for
specification details) in your purchase option, you do not require a driver/application installation for Windows
8. Follow the instructions on page 7 - 40 to install the USIM card (which will be provided by your service pro-
vider), and then use the Charms Bar Wireless icon to access the 3G network in the same manner as the
WLAN (see overleaf).

SN
ALK

Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module and the Bluetooth/Wireless LAN
modules at the same time as this may disrupt radio frequency, and cause interference. When the 3.75G/HSPA module is
powered on, make sure that the Bluetooth/Wireless LAN modules are powered off.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited.

Make sure the module is either OFF or in Airplane Mode (for Windows 8 only) if you are using the computer aboard aircraft.
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3G Configuration in Windows 8

Y ou can configure a 3G connection as below, however make sure the 3G module is turned on by pressing the
Fn+  key combination (give the module about 10 seconds to power on) or Control Center button (and not in
Airplane Mode) before configuration begins.

Charms Bar

1. Go tothe Charms Bar.

2. Select Settings and then click the WiFi icon (it should read Available under the icon and Airplane mode
should be Off).

3. Alist of available access points will appeatr.

(© Networks

Airplane mode
* ‘0"

Off [ |
Available

" Mobile broadband

E Chunghwa Telecom

Notifications Power Keyboard

Change PC settings
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Figure E - 38 - WiFi Settings (Charms Bar) & Networks (with Mobile Broadband)
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o

Any 3G service provider (connection information is usually stored on the USIM card) will appear under Mobile
Broadband.
Double-click any connection icon under Mobile Broadband (or click and click Connect).

Maobile broadband

Chunghwa Telecom

. Connect automatically

Figure E - 39 - Mobile Broadband (Connect)

The system will connect to your network.
A Connected will appear alongside the 3G connection (click the connection to view the timer which indicates
your connected time for the current session).

Mobile broadband

Chunghwa Telecom Connected ?'f:|||

Figure E - 40 - Mobile Broadband (Disconnect)
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8. You can then access the internet, download e-mail etc. as per any internet connection.

9. To disconnect you can select the connection and click Disconnect .
10. You need to either use Airplane Mode, or to turn the Mobile Broadband module off aboard aircraft.

PC Settlﬂgs Airplane mode ﬁ

Turn this on to stop wireless communication W| rel ess Dev| ce
i i off :
Activate Windows Operation Aboard
Personalize Wireless devices Aircraft
Users Mabile broadband The use of any portable
- on electronic transmission
Notifications WiFi devices aboard aircraft
Search on is usually prohibited.
Bluetooth
Share on — Make sure the module is
) either OFF or in Air-
General Mobile broadband hardware plane Mode (for Win-
Privacy Chunghwa Telecom dows 8 only) if you are
using the computer
Devices aboard aircraft.

Wireless

Ease of Access

Sync your settings
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Figure E - 41 - PC Settings (Wireless)
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EM820W 3G Module PIN Code & Power-Saving

Note that there may be some issues when a PIN Code is set for the EM820W 3G module (if you are unsure of
your module version contact your distributor/supplier) in Windows 8, Mobile Broadband has been turned off,
and the system has resumed from a power-saving state. To prevent any issues it is recommended that you
simply do not enable a PIN for the EM820W 3G module. The following provides instructions for disabling
the PIN code; for specific instructions on resolving the issue where “Insert a SIM” appears in the connection
see“ Resolving the “Insert a SIM” issue with the 3G Module (Windows 8)” on page 8 - 16.

Disabling a PIN code for a 3G Module

1. Go tothe Charms Bar.
2. Select Settings and then click the WiFi icon.
3. Right-click the 3G connection and select View connection properties.

€) Networks
W\ ¢ o ©
Chunghwa 100 Brightness Hide estimated data usage

Set as non-metered connection

B3 O

Motifications Power Keyboard Forget this network

L View connection properties .
Change PC settings . : prop ‘ ‘ TI“
i

Figure E - 42 - WiFi Settings (Charms Bar) & Right-Click Connection to View Properties
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4. Click Security (tab) and click Disable PIN.
5. Enter the PIN number and click Disable PIN and click OK to confirm.
6. Itisrecommended that you do not Enable a PIN for the EM820W 3G module.

Unnamed Mobile Broadband Properties

Subscription IPrcﬁIe Security

Dizabling the PIN will make the device Disable PIN
less secure.,

The PIM has been successfully disabled.

To change the PIN, dick Change FIN. Change PIN

["show characters

Tries left: 3
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Figure E - 43 - Disable PIN
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Preface

Notice

The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.

©June 2013

Trademarks
Intel, Pentium and Intel Core are trademarks/registered trademarks of Intel Corporation.



Preface

R&TTE Directive
Thisdeviceisin compliance with the essential requirements and other relevant provisions of the R& TTE Direc-
tive 1999/5/EC.

Thisdevice will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.

ErP Off Mode Power Consumption Statement:
Thefigures below note the power consumption of thiscomputer in compliance with European Commission (EC)
regulations on power consumption in off mode

« Off Mode <0.5W
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CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters“CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark

is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R& TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and hasissued afavorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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FCC Statement

(Federal Communications Commission)

Y ou are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limitsfor aClass B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonabl e protection against harmful interferencein
aresidential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, thereisno guarantee that interference will not occur in aparticular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on acircuit different from that to which the receiver is connected.
» Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the
device.
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FCC RF Radiation Exposure Statement:
1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator

and your body.

\ A/
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Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.

If your purchase option includes both Wireless LAN and 3.G modules, then the appropriate antennas will be installed. Note
that In order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate in
conjunction with any other antenna or transmitter.

Important Notice - 3G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G module and the Bluetooth/Wireless LAN modules
at the same time as this may disrupt radio frequency, and cause interference. When the 3G module is powered on, make
sure that the Bluetooth/Wireless LAN modules are powered off.
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed bel ow, to reduce therisk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.

4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.

5. This product is intended to be supplied by a Listed Power Unit with an AC Input of 100 - 240V, 50 - 60Hz, DC
Output of 19V, 3.42A or 18.5V, 3.5A (65 Watts) minimum AC/DC Adapter.

This Computer’s Optical Device is a Laser Class 1 Product

Vi



Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions.

1.

Preface

Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Do not expose the computer
to any shock or vibration.

surface.

Do not placeit on an unstable

Do not place anything heavy
on the computer.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-

aged.

Do not expose it to excessive
heat or direct sunlight.

Do not leaveit in a place
where foreign matter or mois-
ture may affect the system.

Don't use or store the com-
puter in a humid environment.

Do not place the computer on
any surfacethat will block the
Vents/Fan Intakes.

Vi
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Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other
strong magnetic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don'’t forget

to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power
until you properly shut down
all programs.

Do not turn off any peripheral
devices when the computer is
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance
on your computer.

VIiI

Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.




Power Safety

The computer has specific power requirements:

* Only use a power adapter approved for use with this computer.

* Your AC/DC adapter may be designed for international travel but it still requiresa
steady, uninterrupted power supply. If you are unsure of your local power specifications,

consult your service representative or local power company.

» The power adapter may have either a 2-prong or a 3-prong grounded plug. The third
prong is an important safety feature; do not defeat its purpose. If you do not have access

to acompatible outlet, have a qualified electrician install one.

*  When you want to unplug the power cord, be sure to disconnect it by the plug head, not

by itswire.

* Make sure the socket and any extension cord(s) you use can support the total current

load of all the connected devices.

» Before cleaning the computer, make sure it is disconnected from any external power

supplies (i.e. AC/DC adapter or car adapter).

cord if you are wet.

Do not plug in the power

Do not use the power cord if
it is broken.

Do not place heavy objects
on the power cord.

Preface
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Power Safety
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines and

power cord).

You must also remove
your battery in order to
prevent accidentally
turning the machine
on. Before removing
the battery discon-
nect the AC/DC
adapter from the
computer.
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Polymer Battery Precautions
Note the following information which is specific to polymer batteries only, and where applicable, this overrides
the general battery precaution information overleaf.

» Polymer batteries may experience aslight expansion or swelling, however thisis part of the battery’s safety mecha-
nism and is not a cause for concern.

e Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient tempera-
ture environments, and do not store unused batteries for extended periods.

See a'so the general battery precautionary information overleaf for further information.
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Battery Precautions

Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.

Do not remove any batteries from the computer while it is powered on.

Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
resultinfire.

If you do not use the battery for an extended period, then remove the battery from the computer for storage.
Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

K eep the battery away from metal appliances.

Affix tape to the battery contacts before disposing of the battery.

Do not touch the battery contacts with your hands or metal objects.

SN
ALK

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
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Cleaning

Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

*  When the power cord or AC/DC adapter is damaged or frayed.

 If the computer has been exposed to rain or other liquids.

 |If the computer does not work normally when you follow the operating instructions.

 If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
» If thereisan unusual odor, heat or smoke coming from your computer.

S
&
Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before restoring power to the system.

Also note the following when the cover is removed:

e Hazardous moving parts.
* Keep away from moving fan blades.

Xl
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Travel Considerations

Packing
Asyou get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.

The AC/DC adapter uses voltages from 100 to 240 volts so you won't need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both
hardware and software. Make sure your documents are prepared.

SN
ALK

Power Off Before Traveling

agprwbPE

N o

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your

computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.

X1l
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On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these pointsin mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’'t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Bewar e of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
Theserestrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power whereyou can - If an electrical outlet isavailable, usethe AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from acold to awarm location, water vapor can condense inside the computer.
Wait afew minutes before turning it on so that any moisture can evaporate.

XV
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Developing Good Work Habits

Developing good work habitsisimportant if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

Adjust the height of the chair and/or desk so that the keyboard is at or dightly below the level
of your elbow. Keep your forearms, wrists, and hands in arelaxed position.

Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a
footrest if necessary.

Use a chair with aback and adjust it to support your lower back comfortably.

Sit straight so that your knees, hips and elbows form approximately 90-degree angles when
you are working.

Take periodic breaks if you are using the computer for long periods of time.

Remember to:

Alter your posture frequently.

Stretch and exercise your body several times a day.

Take periodic breaks when you work at the computer for long periods of time. Frequent and
short breaks are better than fewer and longer breaks.

XV
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatiguein your neck and
shoulders.

Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
Position the display directly in front of you at a comfortable viewing distance.

Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image per sistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

Set the Windows Power Plansto turn the screen off after afew minutes of screenidle time.

Use arotating, moving or blank screen saver (this prevents an image from being displayed too long).
Rotate desktop background images every few days.

Turn the monitor off when the system isnot in use.

LCD Electro-Plated Logos

Note that in computers featuring araised LCD electro-plated logo, the logo is covered by a protective adhesive.
Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may develop sharp
edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated
logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during
transport. If any such wear and tear devel ops contact your service center.

XVI
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Quick Start Guide

Chapter 1. Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

e Chapter 2 A guideto using some of the main features of the computer e.g. the stor age devices (hard disk,
optical device, card reader), Touchpad & Mouse & Audio.

e Chapter 3  The computer’s power saving options.

e Chapter 4 Theinstalation of the driversand utilities essential to the operation or improvement of some of the
computer’s subsystems.

» Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).

» Chapter 6 Instructionsfor upgrading your computer.

» Chapter 7 A quick guide to the computer’s PC Camera, WirelessL AN, Combo Bluetooth & WLAN and
3G modules (some of which may be optional depending on your purchase configuration).

e Chapter 8 A troubleshooting guide.

« Appendix A Definitions of the interface, ports/jackswhich allow your computer to communicate with external
devices.

» Appendix B Information on Control Center.

» Appendix C Information on the video driver controls.

» Appendix D The computer’s specification.

» Appendix E Information related to the Windows 8 operating system.

Overview 1 -1
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Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
torefer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “ Upgrading The Computer” on
page 6 - 1 inthe reminder of the User' sManual. Y ou may also find the notes marked with a# of interest to you.

Beginners and Not-So-Advanced Users

If you are new to computers (or do not have an advanced knowledge of them) then
4 the information contained in the Quick Start Guide should be enough to get you up
Notes and running. Eventually you should try to look through all the documentation (more
Check the light colored detailed descriptions of the functions, setup and system controls are covered in the
boxes with the mark | remainder of the User's Manual), but do not worry if you do not understand every-
above to find detailed in- = thing the first time. Keep this manual nearby and refer to it to learn as you go. You
utors foatiroe. <™ | may find it useful to refer to the notes marked with a s indicated in the margin,
For amore detailed description of any of the interface ports and jacks see “ I nterface

(Ports & Jacks)” on page A - 1.

Warning Boxes

No matter what your level please pay careful attention to the warning and safety information indicated by the
2 symbol. Also please note the safety and handling instructions as indicated in the Preface.

1-2 Overview
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Not Included

Operating Systems (e.g. Windows 7) and applications (e.g. word processing, spreadsheet and database programs)
have their own manuals, so please consult the appropriate manuals.

4

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “ Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If
your system hasn't been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your com-
puter to communicate with external devices, connect to the internet etc.

. |
Overview 1 -3
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System Startup

Remove all packing materials.

Place the computer on a stable surface.

Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an
outlet, and connect the AC power cord to the AC/DC adapter.

Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 130 degrees); use the other
hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by
the lid/LCD).

PobNPE

o

4

Shutdown

Note that you should al-
ways shut your comput-
er down by choosing the
Shut Down command
from the bottom right of
the Start menu in Win-
dows. This will help
prevent hard disk or
system problems.

130°

Figure 1 - 1 - Opening the Lid/LCD & Computer with AC/DC Adapter Plugged-In

1 -4 System Startup
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System Software

Y our computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the Windows 7 (with Service Pack 1 in-
stalled) and Windows 8 operating systems are supported.

The majority of this menu covers information covers information related to the Windows 7 operating system,
however for specific information on the Windows 8 operating system see Appendix E.

Note: In order to run Windows 7 (SP1) without limitations or decreased performance, your computer requires a
minimum 1GB of system memory (RAM).

4

Windows 7/8 OS

In order to run Windows 7 or 8 (32 Bit) without limitations or decreased performance, your computer requires a minimum
1GB of system memory (RAM), however if you are running Windows 7 or 8 (64 bit) your computer requires a minimum
2GB of system memory (RAM).

System Startup 1 -5
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Model Differences
This notebook seriesincludesthr ee different models that vary slightly in design style (M odels A and B include

two distinct design styles), color, general appearance and features supported. Note that your computer may ook
dlightly different from that pictured throughout this manual.

Feature Model A Model B Model C
Display 14.0" / 35.56cm HD (1366 * 768), 16:9 15.6"/ 39.62cm HD (1366 * 768) / HD+ | 17.3"/ 43.94cm HD+ (1600 * 900),
Type Backlit Panel (1600 * 900), FHD (1920 * 1080), FHD (1920 * 1080),
Supported 16:9 Backlit Panel 16:9 Backlit Panel
Dimensions See “Dimensions & Weight” on page D - 6.
& Weight

See “ Specifications” on page D - 1 for full details.

Table 1 - 1 - Model Differences

1 -6 System Startup



System Map: LCD Panel Open - Model A Design |

N /
2§
Wireless Device

Operation Aboard
Aircraft

The use of any portable elec-
tronic transmission devices
aboard aircraft is usually pro-
hibited. Make sure the mod-
ule(s) are OFF if you are
using the computer aboard
aircraft.

Use the key combinations to
toggle power to the 3G/
WLAN/Bluetooth modules,
and check the LED indicator
or on-screen icon to see if the
modules are powered on or
not (see

/
).

Note that the Touchpad and Buttons valid operational area is that indicated within the red dotted lines

indicated on the right.

=

N o

ahrwN
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Figure 1 -2

LCD Panel Open -

Model A Design |

Built-In PC Camera
(Optional)

LCD

Power Button

Hot Key Buttons
LED Status
Indicators
Keyboard

Built-In Microphone
Touchpad &
Buttons

©
X A

Touchpad Buttons

(valid operational area)

System Map: LCD Panel Open - Model A Design 11-7
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Figure 1 - 3 System Map: LCD Panel Open - Model A Design |l

LCD Panel Open -

i N/
Model A Design Il o 7@‘
1. Built-in PC Camera Wireless Device
(Optional) Operation Aboard
2. LCD Aircraft
3. Power Button The use of any portable electronic
4. LED Status 9 transmission devices aboard air-
. craft is usually prohibited. Make
Indicators sure the module(s) are OFF if you
5. Keyboard are using the computer aboard
: . aircraft.
6. Built-In Microphone

Use the key combinations to tog-

7. TOUChpad & gle power to the 3G/WLAN/Blue-
Buttons tooth modules, and check the
e e LED indicator or on-screen icon to
see if the modules are powered on
e or not (see
I

)-

Touchpad Buttons e
(valid operation area)

Note that the Touchpad and Buttons valid operational area is that indicated within the red dotted lines
indicated on the left.

1 - 8 System Map: LCD Panel Open - Model A Design I
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System Map: LCD Panel Open - Model B Figure 1- 4

LCD Panel Open

9 o ﬁ Model B

4 \

=

I Built-in PC Camera
Operation Aboard (Optional)

@ Aircraft 2. PC Camera LED
Th f table electroni 3. LCD
e use of any portable electronic
transmission devices aboard air- 4. Power Button
craft is usually prohibited. Make 5. LED Status
sure the module(s) are OFF if you .
are using the computer aboard Indicators
et 6. Keyboard
Use the key combinations to tog- 7. Built-In Microphone
gle power to the 3G/WLAN/Blue- 8 Touchpad &

e tooth modules, and check the

LED indicator or on-screen icon Buttons

to see if the modules are powered

on or not (see
6 ’ (8]

).

o
o ® e

Note that the Touchpad and Buttons valid operational area is that indicated within the red dotted lines
indicated on the right.

System Map: LCD Panel Open - Model B 1-9
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Figure 1-5
LCD Panel Open
Model C

1. Built-In PC Camera
(Optional)

PC Camera LED
LCD

Power Button

LED Indicators
Keyboard

Built-In Microphone
Touchpad &
Buttons

©NOOALON

18]

Note that the Touchpad and
Buttons valid operational area
is that indicated within the red
dotted lines above.

System Map: Model C - LCD Panel Open

® o

18]

1-10 System Map: Model C - LCD Panel Open

2§
Wireless Device

Operation Aboard
Aircraft

The use of any portable elec-
tronic transmission devices
aboard aircraft is usually pro-
hibited. Make sure the mod-
ule(s) are OFF if you are
using the computer aboard
aircraft.

Use the key combinations to
toggle power to the WLAN/
Bluetooth modules, and
check the LED indicator or
on-screen icon to see if the
modules are powered on or
not (see




LED Indicators
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Icon Color Description
The LED indicators on the computer display helpful . .
information about the current status of the computer Green | 1" (0ptional) Wireless LAN Module
n P : is Powered On
T Win 7 - The (optional) Bluetooth
Orange DC Power is Plugged In Orange Win 8 - The (optional) Bluetooth
- Module is Installed (this is not a
Green The Computer is On power on/off indicator in Windows 8)
. The Computer is in Slee
Blinking Green pMode P Green Hard Disk Activity
The PC Camerais In Use Green Number Lock Activated
Blinking Orange | (for 14.0” / 35.56cm Model A
computers only) Green Caps Lock Activated
Orange The Battery is Charging
Green The Battery is Fully Charged Green Scroll Lock Activated
Blinking Orange The Battery Has Reached Blue Power Button

Critically Low Power Status

Table1-2-LED

Power Indicators

Table 1 - 3 - LED Status Indicators

LED Indicators 1 - 11
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Hot Key Buttons - Some Model A Design Styles

These buttons give instant access to the default Internet browser and e-mail program, and allow you to toggle
the Silent M ode on/off with one quick button press.

Hot Key Function

® 2] o

Toggle *Silent Mode (for power saving)
OR
WLAN ON/OFF

OR

Activate the Default Internet Program

Activate the Default E-Mail Browser (Note that this button has no function in Windows
7 without Outlook/Outlook Express installed. If Outlook/Outlook Express are installed
then the button will activate the application)

®  ®© 0O

Table 1 - 4 - Hot Key Buttons - Some Model A Design Styles

*When enabled, Silent M ode will reduce fan noise and save power consumption. Note this may reduce comput-
er performance.

1-12 Hot Key Buttons - Some Model A Design Styles
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4

Other Keyboards

Keyboard - Model A

The keyboard has an embedded numerical keypad for easy numeric data input, and
function keys to change operational features instantly. See Table1 - 5, on page 1 -

15 for function key details and Appendix E for Windows 8 keyboard information. If your keyboard is dam-
aged or you just want to

make a change, you can

use any standard USB

keyboard. The system will
detect and enable it auto-
matically. However spe-
cial  functions/hot-keys
unique to the system'’s
regular keyboard may not
work.

NumLk & ScrLk

NumLk &
Play/Pause Key ScrLk Keys
3G Module

Power
Toggle Key

Numerical Keypad

Hold down the Fn Key
and either NumLk or

Figure 1 - 6 - Keyboard - Model A ScrLk to enable number
or scroll lock, and check

the LED indicator for sta-

4 tus.

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

Keyboard - Model A 1- 13
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4

Other Keyboards

If your keyboard is dam-
aged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it auto-
matically. However spe-
cial  functions/hot-keys
unique to the system'’s
regular keyboard may not
work.

NumLk & ScrLk

Hold down the Fn Key
and either NumLk or
ScrLk to enable number
or scroll lock, and check
the LED indicator for sta-
tus.

Keyboard - Models B & C

The keyboard has an embedded numerical keypad for easy numeric data input, and
function keys to change operational features instantly. See Table1 - 5, on page 1 -
15 for function key details and Appendix E for Windows 8 keyboard information.

| Function Keys

NumLk &
ScrLk Keys

Play/Pause Key

3.G Module Numerical
Power Keypad
Toggle Key

(For Model B only)

[ ]

Fn Key
Figure 1 - 7 - Keyboard - Models B & C

4

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

1-14 Keyboard - Models B & C
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Function/Hot Key Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility isinstalled.

Keys Function Keys Function
Fn+~ Play/Pause (in Audio/Video Programs) Fn + F8/F9 Brightness Decrease/Increase
Silent Mode Toggle (for some
3G Module Power Toggle ) ”
Fn + (Models A & B Only) Model A Designs Only - see
page 3 - 2)
Fn+F1 TouchPad Toggle Fn + F10 PC Camera Power Toggle
Turn LCD Backlight Off
Fn+F2 (Press a key to or use TouchPad to turn on) Fn+F1l WLAN Module Power Toggle
Fn+F3 Mute Toggle Fn + F12 Bluetooth Module Power Toggle
Fn+F4 Sleep Toggle Fn + NumLk Number Lock Toggle
Fn + F5/ Volume Decrease/ Fn + ScrLk Scroll Lock Toggle
F6 Increase
Fn+F7 Display Toggle Caps Lock Caps Lock Toggle

Table 1 -5 - Function & Hot Key Indicators

Function/Hot Key Indicators 1 - 15
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Control Center

Press the Fn + Esc key combination, or double-click the icon E in the notification area of the taskbar to
toggle the Control Center on/off. The Control Center gives quick access to frequently used controls and en-
ables you to quickly turn modules on/off (see Appendix B for full details). The Control Center in Windows 8
works under the Desktop app and not under the Start screen, and does not feature the wirel ess/Bluetooth buttons
and Airplane Mode (see page E - 15 for Windows 8 information).

4

Control Center

Click on any button to turn any of the modules (e.qg.
TouchPad, Camera) on/off.

Click on the power conservation modes to switch be-
tween Performance, Balanced or Energy Star modes
(see page 3 - 10). To remove the Power Conservation
Modes screen just click in a blank area of the icon or
press a key on the keyboard.

Click on the buttons (or just click and hold the mouse
button) to adjust the slider for Brightness/Volume.

Click on Display Switch and click to choose a display
mode from the menu (see page C - 10).

Figure 1 - 8 - Control Center

1 - 16 Control Center
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System Map: Front & Left Views - Models A & B Figure 1- 9

Front & Left Views

o Models A & B
1. LED Power Indi-
cators
2. DC-InJack
G 3. External Monitor
Port
@ 4, RJ-45 LAN Jack
5. HDMI-Out Port
(2] ® 4 © © © (8] 6. USB 3.0 Port
7. Vent/Fan Intake/
Outlet
8. Multi-in-1 Card
(6] @ Reader
e ®© 0o © @ e}

Multi-In-1 Card Reader
The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / RSMMC
SD (Secure Digital) / Mini SD / SDHC / SDXC
MS (Memory Stick) / MS Pro / MS Duo

System Map: Front & Left Views - Models A& B 1- 17



Quick Start Guide

Figure 1 - 10
Front & Left Views
Model C

=

LED Indicators
DC-In Jack
External Monitor
Port

RJ-45 LAN Jack
HDMI-Out Port
USB 3.0 Port
Vent/Fan Intake
Multi-In-1 Card
Reader

wnN

©NoaA

System Map: Front & Left Views - Model C

Multi-In-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / RS MMC
SD (Secure Digital) / Mini SD / SDHC / SDXC
MS (Memory Stick) / MS Pro / MS Duo

USB 3.0 Port OR USB 2.0 Port

This model includes USB 3.0 ports on the left side of the computer. USB 3.0 ports are de-
noted by their blue color; USB 2.0 ports are colored black. Note that the USB 3.0 ports
require a driver installation for Windows 7 (Windows 8 does not require a driver) and do
not support wake on USB.

1-18 System Map: Front & Left Views - Model C
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System Map: Right & Rear Views - Models A & B Figure 1- 11

Right & Rear Views
Models A & B

1. Microphone-In
o 9 9 9 @ Jack
2. Headphone-Out
Jack
3. USB 2.0 Port
4. Optical Device

@ 9 9 9 Drive Bay (for CD/

DVD Device)
5. Security Lock Slot
6. Battery

4

Battery Information

Always completely dis-
charge, then fully charge, a
new battery before using it.
Completely discharge and
charge the battery at least
once every 30 days or after
about 20 partial discharges.
See “Battery Information”
on page 3 - 11 for full in-
structions.

System Map: Right & Rear Views - Models A & B 1-19



Quick Start Guide

Figure 1 - 12 System Map: Right & Rear Views - Model C

Right & Rear Views -
Model C

1. Headphone-Out
Jack 00 o (4] (5
2. Microphone-In
Jack
3. USB 2.0 Port
4. Optical Device

Drive Bay @
5. Security Lock Slot
6. Battery

Z

Battery Information

Always completely dis-
charge, then fully charge, a
new battery before using it.
Completely discharge and
charge the battery at least
once every 30 days or after
about 20 partial discharges.
See “Battery Information”
on page 3 - 11 for full in-
structions.
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Disk Eject Warning

Don't try to eject a CD/DVD while the system is ac-
cessing it. This may cause the system to “crash”. Stop
the disk first then eject it, or press the stop button
twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to
an unexpected power interruption) you may push the
end of a straightened paper clip into the emergency
eject hole. Do not use a sharpened pencil or any ob-
ject that may break and become lodged in the hole.
Don't try to remove a floppy disk/CD/DVD while the
system is accessing it. This may cause the system to
“crash”.

Quick Start Guide

4

Changing DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code
(see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.

.|
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Figure 1 - 13 System Map: Bottom View - Model A
Bottom View
I:/fodeIA o

=

Battery
2. Component Bay

Cover @

3. Vent/Fan Intake/

Outlet 9 9
4. Hard Disk Bay

Cover
5. 3G USIM Card (3]

Cover (Optional)

CPU

The CPU is not a user
serviceable part.

Overheating H

To prevent your comput- S

er from overheating Bottom Covers

make sure nothing blocks If your model includes the 3G option then a small cover 5 to enable you to access the

the Vent/Fan Iptgke while module’s USIM card will be included (see ).
the computer is in use.
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System Map: Bottom View - Model B Figure 1 - 14
Bottom View - Model B
1. Battery
0 2. Component Bay
Cover
9 3. Vent/Fan Intake/
Outlet

4. Hard Disk Bay

9 9 Cover

6 6 5. 3G USIM Card
Cover (Optional)
6. Speakers

CPU

The CPU is not a user
serviceable part.

7 \

'IX' Overheating

To prevent your comput-

Bottom Covers er from overheating

If your model includes the 3G option then a small cover 5 to enable you to access the make sure nothing blocks

module’s USIM card will be included (see ). the Vent/Fan Intake while
the computer is in use.
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Figure 1 - 15 System Map: Bottom View - Model C

Bottom View
Model C o
1. Battery
2. Component Bay e
Cover
3. Fan Intake/Vent e
4. Hard Disk Bay (2]
Cover e
5. Speakers

4

Battery Information

Always completely dis-

charge, then fully el
charge, a new battery ’Q‘
before using it. Com- CPU
pletely discharge and
charge the battery at
least once every 30 days Overheating

or after about 20 partial To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake
discharges. while the computer is in use.

The CPU is not a user serviceable part.
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Quick Start Guide
Windows 7 Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows 7 are accessed from the Start menu (see Ap-
pendix E for information on the Windows 8 OS). When you install programs and utilities they will be installed
on your hard disk drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click
the Start menuicon , and then select Properties to customize the appearance of the Start menu.

Click here to toggle Category View

Figure 1 - 16 - Start Menu & Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
inWindows (e.g. power, video, network, audio etc.). Windows 7 provides basic controls for many of the features,
however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all
controls it may be necessary to toggle off Category View to view the control panel icons.

System Map: Bottom View - Model C 1 - 25
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Video Features

Y ou can switch display devices, and configure display options, from the Display control panel (in Appear ances
and Personalization) in Windows 7 (see over). For more detailed video information see “ Video Driver Con-
trols’ on page C - 1. To access Display (Control Panel) and Screen Resolution in Windows:

Click Start and click Control Panel.

Click Display (icon) - In the Appearances and Personalization category.

Click Adjust Screen Resolution/Adjust resolution.

Alternatively you can right-click the desktop and select Screen resolution.

Use the dropbox to select the screen Resolution @ (Figure 1 - 17).

Click Advanced settings @ (Figure 1 - 17) to bring up the Advanced properties tabs.

ok wbNpE

Figure 1 - 17 - Screen Resolution

1 - 26 Video Features



Quick Start Guide

To access the I ntel (R) Graphics and Media Control Panel:

1. Click Advanced settings @ (Figure 1 - 17 on page 1 - 26) in the Display Settings control panel in Windows.
2. Click Graphics Properties (button) @ (Figure 1 - 18) in the Intel Graphics & Media Control Panel tab.

OR

3. Right-click the desktop and select Graphics Properties from the menu.

OR

4. Click the icon E e (Figure 1 - 18) in the taskbar and select Graphics Properties from the menu.
OR

5. Access the Intel(R) Graphics and Media Control Panel from the Windows control panel in Classic View.

o )

C )

Figure 1 - 18 - Intel Graphics and Media Control Panel

Video Features 1 - 27
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Power Options

The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 24 or see Ap-
pendix E for information on the Windows 8 OS) allows you to configure power management features for your
computer. Y ou can conserve power by means of power plans and configure the options for the power button,
sleep button, computer lid (when closed), display and sleep mode from the left menu. Note that the Power
saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create anew plan. Click Change plan settings and click Change advanced power settingsto access further con-
figuration options. Pay attention to the instructions on battery care in “ Battery I nformation” on page 3 - 11.

Figure 1 - 19 - Power Options

.|
1 - 28 Power Options



Features & Components

Chapter 2. Features & Components

Overview

Read this chapter to learn more about the following main features and components
of the computer:

Hard Disk Drive

Optical (CD/DVD) Device
Multi-In-1 Card Reader
TouchPad and Buttons/Mouse
Audio Features

For information on the Windows 8 operating system see Appendix E.

. |
Overview 2 - 1



Features & Components

Hard Disk Drive

SN
'Ll\ The hard disk drive is used to store your data in the computer. The hard disk can be
Power Safety taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height

Before attempting to ac- of 9.5 mm.

cess any of the internal . .
Selae e e era  Thehard disk isaccessible from the bottom of your computer as seen below. For fur-

oA CERERENENTNE  ther details see “ Upgrading the Hard Disk Drive” on page 6 - 5.
that the machine is not

connected to the AC

power, and that the ma-

chine is turned off. Also -
ensure that all peripher-

al cables, including

phone lines, are discon-

nected from the comput-

er.

Figure2-1
Hard Disk Location

2 - 2 Hard Disk Drive
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Optical (CD/DVD) Device

Thereisabay for a5.25" optical (CD/DVD) device (12.7mm height). The actual de- Z

vice will depend on the module you purchased (see “ Storage” on page D - 4). The Sound Volume
optical device is usualy labeled “Drive D:” and may be used as a boot device if Adjustment
properly set inthe BIOS (see “Boot Menu” on page5 - 16). How high the sound vol-

ume can be set depends

Loading Discs on the setting of the vol-
ume control within Win-

Toinsert aCD/DVD, press the open button @ and carefully place aCD/DVD onto | gows. Click the Volume
thedisc tray with label-side facing up (usejust enough forcefor thedisctoclick onto | icon on the taskbar to
the tray’ s spindle). Gently push the CD/DVD tray in until itslock “clicks’ and you | check the setting (see
are ready to start. The busy indicator @ will light up while datais being accessed, | Audio Features™ on

or while an audio/video CD, or DVD, isplaying. If power isunexpectedly interrupt- page 2- 12).
ed, insert an object such as a straightened paper clip into the emergency gject hole
© to open thetray. :
Figure2 -2

Optical Device

Optical (CD/DVD) Device 2 - 3
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Handling CDs or DVDs

7\[:1'( Proper handling of your CDS/DVDs will prevent them from being damaged. Please
follow the advice bel ow to make sure that the data stored on your CDS/DV Ds can be

CD Emergency Eject
accessed.

If you need to manually

SEei R RETERCRE - Note the following:

an unexpected power

LIEER RS GIER EVAl  » Hold the CD or DVD by the edges; do not touch the surface of the disc.
EERER I ESE o Use aclean, soft, dry cloth to remove dust or fingerprints.
f;{g'g::i?ﬁgrgg?grejﬂg « Do not write on the surface with a pen.

T EENEE e ¢ Do not attach paper or other materials to the surface of the disc.
SNeRRTEEE R ET Rl o Do not store or place the CD or DVD in high-temperature areas.
SRS EIEE o Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
SRS EECS . Do not bend the CD or DVD.

db lodged i .
ﬁ]ne hoﬁfome =S8 . Donot drop or subject the CD or DVD to shock.

Disk Eject Warning

Don't try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.

.|
2 - 4 Optical (CD/DVD) Device
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DVD Regional Codes

To change the DVD regional codes: Z

1. Go to the Control Panel DVD Region Note
2. Double-click Device Manager (Hardware and Sound), then click the + next to DVD region detection is
DVD/CD-ROM drives. device dependent, not
3. Double-click on the DVD-ROM device to bring up the Properties dialog box, and 0S-dependent. You can
select the DVD Region (tab) to bring up the control panel to allow you to adjust the select your module’s re-
regional code. gion code 5 times. The
) fifth selection is perma-
* Region 1-USA & Canada nent. This cannot be al-

« Region 2 - Western Europe, Japan tered even if you change
' ’ your operating system

South Africa, Middle East & Egypt ST LEE e e i
* Region 3- South-East Asia, Taiwan, another computer.
South Korea, The Philippines, Indo-
nesia, Hong Kong
* Region 4 - South & Central Amer-
ica, Mexico, Australia, New Zealand
* Region 5- N Korea, Russia, Eastern
Europe, India& Most of Africa _
+ Region 6 - China Figure2- 3
DVD Region Codes

Optical (CD/DVD) Device 2 - 5
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Card Reader Cover

Make sure you keep the
rubber cover provided in
the card reader when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the card reader.

Figure2-4
Left View

1. Card Reader

Multi-In-1 Card Reader

The card reader alows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the card reader driver (see
“ CardReader” on page 4 - 6.

« MMC (MultiMedia Card) / RSMMC
» SD (Secure Digital) / Mini SD / SDHC/ SDXC
* MS(Memory Stick) / MSPro/ MS Duo

Note: Some of these cards require PC adapters that are usually supplied with the
cards.

o

2 - 6 Multi-In-1 Card Reader
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TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add a mouse to _
your computer through one of the USB ports. The TouchPad buttons function in Mouse Driver
much the same way as a two-button mouse. If you are using an ex-

ternal mouse your op-
erating system may be
able to auto-configure

your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’'s user docu-
mentation for details.

TouchPad and Buttons/Mouse 2 - 7
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Once you have installed the TouchPad driver (see “ Touchpad” on page 4 - 6) you
can configure the functions from the Mouse control panel in Windows, or by double-
TouchPad Scrolling clicking the TouchPad driver icon  in the notification area. Y ou may then config-
ure the TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options

phis computer model se- 1y vy preferences. Y ou will find further information at www.synaptics.com.

ries may feature different
TouchPad versions.

These TouchPads may
differ in their vertical
scrolling function in most
scrollable windows.

Some TouchPads require
sliding the finger up and
down on the right of the
TouchPad to scroll the
window. Other versions
require  tapping/holding
down the finger at the top
right or bottom right of the
TouchPad to scroll the
window.

Figure2-5
Mouse Properties

2 - 8 TouchPad and Buttons/Mouse
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Gestures and Device Settings

The Synaptics Gestures Suite application allows you to use a specific gesture (ac-
tion) on the surface of the TouchPad to perform specific actions to manipul ate doc-
uments, objects and applications.

Y ou can configure the settings from the Device Settings tab in M ouse Properties:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Mouse (Hardware and Sound).

3. Click Device Settings (tab) and click Settings.

4. Use the menu tree on the left to access the user configurable settings.

-
@

TouchPad and Buttons/Mouse 2 - 9

4

Show Video

You can get a clearer
view of the gestures in-
volved by clicking the
Show Video option for
each gesture item.

Select the gesture (Pinch
Zoom, Rotating, Three
Fingers Down and
Three Finger Flick) in the
Device Settings > Set-
tings left tree menu

and click the Show Video
button to see the demon-
stration video.

For more details on any of
the gestures see the help
in the lower part of the
right menu window.

Figure2-6
Mouse Properties -
Device Settings
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Scrolling

The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and verticaly. Place two fingers, slightly separated, on the
TouchPad surface and slide both fingers in the direction required (in a straight con-
tinuous motion).

Figure2-7
Scrolling Gesture

Zooming

The Pinch Zoom gesture can be used to perform the same function as a scroll wheel
in Windows applications that support CTRL + scroll wheel zoom functionality.
Place two fingers on the TouchPad (for best results use the tips of the fingers) and
dlide them apart to zoom in, or closer together to zoom out.

Figure2-8

Zooming Gesture

2 - 10 TouchPad and Buttons/Mouse
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Rotating

Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments.
Place a finger down on the left “target” zone and keep it stationary. Place another

finger near the middle of the TouchPad and slide it in a circular motion around the

stationary finger (clockwise or counterclockwise) to rotate the object.

Figure2-9
Rotating Gesture

Three Finger-Flick/Three Fingers Down (Press)

The Three Finger-Flick gesture may be used to enhance navigation with avariety of
applications such as browsing the Internet or scrolling through a photo viewer. The
Three Fingers Down gesture may be used to launch user-sel ectable applications.

Figure2- 10
Flick/Press
Gesture

. |
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Audio Features

Y ou can configure the audio options on your computer from the Sound  control
panel in Windows, from the HD V Deck icon on the desktop or VIA HD Audio
Deck control panel 2| via +p Audio Deck .

4

Sound Volume
Adjustment

The sound volume level

is set using the volume | The volume may also be adjusted by means of the Fn + F5/F6 key combination.
control within Windows

(and the volume func-

tion keys on the comput-

er). Click the volume

icon in the taskbar to

check the setting.

Figure2- 11
VIA HD Audio Deck

2 - 12 Audio Features
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Expert Mode will alow you to access more advanced configuration menus for "
Speaker, Microphone and Stereo Mix. ZX

Syncing Left & Right
Volume
Balance

If you wish to adjust the left
and right channel volume
levels separately, you will
need to adjust this from the
VIA HD Audio Deck in Ex-
pert Mode.

Click Speaker in VIA HD
Audio Deck (in Expert
Mode) and click the Sync
Left and Right volume
button (see left). You can
then adjust the volume slid-
ers independently (this set-
ting also controls the
Balance setting in the Win-
dows Sound control pan-
el).

Figure2- 12
VIA HD Audio Deck
(Expert Mode)

Audio Features 2 - 13
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Power Management

Chapter 3. Power Management P

Overview OS Note

To conserve power, especially when using the battery, your computer power man- | Power  management

. . functions will vary slight-
agement conserves power by controlling individual components of the computer ly depending on_ your

(the LCD and hard disk drive) or the whole system. This chapter covers: operating system. For
more information it is

« The Power Sources best to refer to the user’s

* Turning On the Computer ENE ©F o EREE:
ing system.

« Power Plans

» Power-Saving States (Note: All pictures used

» Configuring the Power Buttons on the following pages

are from the Windows 7

* Power Conservation Modes
0S))

» Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OSto set devicesinto low-power states based on user set-
tings and information from applications.

For information on the Windows 8 operating system see Appendix E.

. |
Overview 3 - 1
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4

Silent Mode
(For Some Model A
Designs Only)

Use the (W key to tog-
gle Silent Mode to re-
duce fan noise and save
power consumption.
Note this may reduce
computer performance.

The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Useonly the AC/DC adapter that comeswith your computer. Thewrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.

2. Plug the AC power cord into an outlet, and then connect the AC power cord to the
AC/DC adapter.

3. Raise the lid/LCD to a comfortable viewing angle.

4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet isunavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely beforerecharging (see“How do | completely discharge the battery?”

on page 3 - 15).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “ Battery Information” on page 3 - 11.

3 - 2 The Power Sources
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Turning On the Computer P

Now you are ready to begin using your computer. To turnit on simply pressthe pow-
er button on the front panel. Forced Off

; ; If the system “hangs”,
When the computer is on, you can use the power button as a Stand by/Hibernate/ i s G 2 T ]

Shut_down hot-key button when it is pressed_for I&es than 4 seconds (pressing and | .y combination doesn't
holding the power button for longer than this will shut the computer down). Use || work, press the power
Power Optionsin the Windows control panel to configure this feature. button for 4 seconds, or

longer, to force the sys-
tem to turn itself off.

4
Power Button as
Shut Down Stand by or

Note that you should always shut your computer down by choosing the Shut Down com- Hibernate Button

mand from the bottom right of the Start menu in Windows. This will help prevent hard disk You can use the OS’s

or system problems. Power Options control
panel to set the power
button to send the sys-
tem into Stand by or Hi-
bernate mode (see your
OS’s documentation, or
“Configuring the Pow-
er Buttons” on page 3
- 8 for details).

Turning On the Computer 3 - 3



Power Management

4

Resuming
Operation

See Table3 - 1, on
page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure3-1
Power Plan
Advanced Settings
(Win 7)

Power Plans

The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity.

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

3 - 4 Power Plans
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. Thisisworth bearing in mind if you are experiencing
any reduced performance (especialy under DC/battery power).

Choose High performance (you may need to click Show additional plansto view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered. The recommended Balanced power plan will balance power saving and per-

formance.
Figure3-2
Click to Show/Hide Power Plans
additional
power plans

. |
Power Plans 3 - 5
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Power-Saving States

Y ou can use power-saving states to stop the computer’ s operation and restart where
you left off. Win 7 uses the Sleep, Hiber nate and Shut Down power-saving states.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save al the
information to the hard disk and shut the computer down before the battery becomes
depleted.

3 - 6 Power-Saving States



Hibernate

Hiber nate uses the least amount of power of al the power-saving states and saves
al of your information on a part of the hard disk before it turns the system off. If a
power failure occursthe system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. Y ou should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut down

Y ou should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from Shut down takes longer than
from Sleep or Hibernate.

-

Power-Saving States 3 - 7
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4

Silent Mode
(For Some Model A
Designs Only)

You can use Silent
Mode to reduce power
consumption and fan
noise.

Use the Silent Mode

hot key (N to toggle
this mode on/off.

On screen visual indica-
tors will display the Si-
lent Mode status (see
Table 1 -5, on page 1 -
15).

Note Silent Mode may
reduce computer perfor-
mance.

Figure3-3
Lock Button menu
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Configuring the Power Buttons

Z The power/seep button (Fn + F4 key combo) and closed lid may be set to send the
Password computer in to a power-saving state. Click Choose what the power buttons do on
PTHEERT the left menu in Power Options to bring up the menu.

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure3-4
Power Options
Define Power
Buttons

.|
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Resuming Operation

Y ou can resume operation from power-saving states by pressing the power button,

or in some cases pressing the sleep button (Fn + F4 key combo).

Orange (AC/DC adapter)

Power Status Icon Color To Resume
Power Off Off Press the Power Button
Press the Power Button
Sleep Blinking Green
Press the Sleep Button (Fn + F4 Key Combo)
Off (battery)
Hibernate Press the Power Button

Display Turned Off

Green

Press a Key or Move the Mouse/Touchpad

4

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).

Configuring the Power Buttons 3 - 9

Power Management

4

Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Table3-1
Resuming
Operation
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Power Conservation Modes

g This system supports Energy Star power management features that place comput-
3 Power Conservation ers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period
Modes of inactivity. Adjust Power Conservation Modes from the Control Center:

The Energy Star setting 1. Pressthe Fn + Esc key combination to toggle the Control Center on/off.
will result in maximum & 2 Click either the Performance, Balanced or Energy Star button.
power saving, but with 3. Click in a blank area of the icon or press a key on the keyboard to exit Power

the possible loss of Conservation Mode without making any changes.
some performance.

Setting the mode to Bal-
ance will give power
saving matched with
performance.

Performance will give
optimum computer per-
formance but with less
power conservation.

Figure3-5

Control Center

3 - 10 Configuring the Power Buttons
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Battery Information
Follow these simple guidelines to get the best use out of your battery.

Low Battery
Battery Power Warning

Y our computer’s bqttery power _is depender_n upon many factors, includi ng the pro-  BEVFESS i G
grams you are running, and peripheral devices attached. You can set actions to be B ETA e e
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from FeeliiEes G Aelb/e
power plan Change plan settings > Change advanced power settings (see Figure JaSaiaafe R Eliiey

_ _ or save your work, oth-
3-1onpage3 4)' erwise, the unsaved

data will be lost when
the power is depleted.

Click the battery icon  [d in the taskbar to see the current battery level and charge
status.

Figure3-6
Battery Icon
(Taskbar) & Battery
Advanced Settings

.|
Battery Information 3 - 11
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Conserving Battery Power

Z » Useapower plan that conserves power (e.g Power saver), however note that
Windows Mobility this may have an affect on computer performance.
Center « Lower the brightness level of the LCD display. The system will decrease LCD
The Windows Mobility brightness slightly to save power when it is not powered by the AC/DC adapter.

gf)r\],tigés Z%merglsy ppa:)r;ﬁ: * Reduce the amount of time before the display is turned off.

of access forinformation | « Close wireless, Bluetooth, modem or communication applications when they are

on battery status, power not being used.

plans used and wireless ] _ )

device status etc. » Disconnect/remove any unnecessary external devices e.g. USB devices,
ExpressCards etc.

Figure3-7
Windows Mobility
Center

.|
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Battery Life

Battery life may be shortened through improper maintenance. To optimize the life
and improveits performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason (e.g. long term storage) see“ Removing the Battery”
on page6 - 4.

New Battery

Always completely discharge, then fully charge, a new battery (see “ Battery FAQ”
on page 3 - 15 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hoursto fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery chargetimeisless. (Refer to“LED Indica-
tors’ on page 1 - 11 for information on the battery charge status, and to “ Battery
Information” on page 3 - 11 for more information on how to maintain and properly
recharge the battery pack.)

.|
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Power Management

Proper handling of the Battery Pack
?ﬁl’: * DO NOT disassemble the battery pack under any circumstances
* DO NOT expose the battery to fire or high temperatures, it may explode
* DO NOT connect the metal terminals (+, -) to each other

Caution

Danger of explosion if
battery is incorrectly re-
placed.

2AN\Z
I

Damaged Battery Warning

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer

down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.

.|
3 - 14 Battery Information



Power Management

Battery FAQ

How do | completely discharge the battery?

Use the computer with battery power until it shuts down due to alow battery. Don't

turn off the computer even if amessage indicates the battery iscritically low, just let
the computer use up al of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

Figure3-8
Power Plan Create
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3. Click Change plan settings (after creating it) and click Change plan settings >
Change advanced power settings.

Figure3-9
Change Plan
Settings / Change
Advanced Power
Settings

.|
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

Figure3- 10
Power Options
Advanced Settings -
Battery

* Low battery levels= 0%

» Critical battery Levels=1%

* Low battery action = Do Nothing

 Critical battery action (On battery) = Shut Down
» Critical battery action (Plugged in) = Do Nothing

.|
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How do | fully chargethe battery?
When charging the battery, don’t stop until the LED charging indicator light changes

from orange to green.
How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

.|
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Chapter 4: Drivers & Utilities

This chapter dealswith installing the drivers and utilities essential to the operation or
improvement of some of the computer’s subsystems. The system takes advantage of
some newer hardware components for which thelatest versions of most avail able op-
erating systems haven't built in drivers and utilities. Thus, some of the system com-
ponents won't be auto-configured with an appropriate driver or utility during
operating system installation. Instead, you need to manually install some system-re-
quired drivers and utilities.

See Appendix E for specific information on the Windows 8 operating system.

What to Install

TheDeviceDrivers& Utilities+ User’sManual disc containsthe driversand util-
ities necessary for the proper operation of the computer. Table4 - 1, on page4 - 3
listswhat you need toinstall and it isvery important that thedriversareinstalled
in the order indicated.

Module Driver Installation

The proceduresfor installing driversfor the PC Camera, WirelessL AN, Bluetooth
& WLAN Combo and 3G modulesare provided in“ Modules & Options’ on page 7
-1

What to Install 4 - 1

Drivers & Utilities

\ 7/
L&
Driver Installation &
Power

When installing driv-
ers make sure your
computer is powered
by the AC/DC adapter
connected to a work-
ing power source.
Some drivers draw a
significant amount of
power during the instal-
lation procedure, and if
the remaining battery
capacity is not adequate
this may cause the sys-
tem to shut down and
cause system problems
(note that there is no
safety issue involved
here, and the battery will
be rechargeable within 1
minute).




Drivers & Utilities

Driver Installation

Insert the Device Drivers & Utilities+ User’s Manual
discand click Install Drivers (button), or Option Driv-
ers (button) to access the Optional driver menu.

Figure4 - 1- Drivers Installer Screen 1

Check the driver installation order from Table 4 - 1,
on page 4 - 3 (the drivers must be installed in
this order) which is the same as that listed in the
Drivers Installer menu below.

Click to select the driver you wish to install, (you
should note down the drivers as you install them).
Follow the instructions for each individual driver
installation procedure as listed on the following
pages.

Figure4 - 2 - Install Drivers
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Win 7 SP1/Win 8 Driver Page # Win 7 SP1/Win 8 Driver Page #

PC Camera Module
Chipset Page 4 -6 (Only 14.0” / 35.56cm Model A computers Page 7 -3
require a camera driver for Windows 8)

Video (VGA) Page 4 -6 Wireless LAN Module Page 7 - 11
LAN Page 4 -6 Intel® Wireless Display Application Page 7 - 32
CardReader Page 4 -6 Bluetooth & WLAN Combo Module Page 7 - 37
3G Module (for Models A & B only)

Touchpad Page 4-6 No driver required for Windows 8 Page 7-44
Hot Key Page 4 -7 Trusted Platform Module Page 7 - 91
USB 3.0 (Win 7 Only) i Intel Rapid Storage Technology i
(Not required for Windows 8) Page 4-7 (required for hard disks in AHCI mode) Page 7-105
MEI Driver Page 4 -7 Intel® Smart Connect Technology Page 7 - 106
Audio Page 4 -7

Table 4 - 1 - Driver Installation
All drivers provided are for Windows 7 with Service Pack 1 or Windows 8 (see Appendix E for Win 8 infor-
mation).

Note that you need to install both the WLAN & Bluetooth driversfor the Intel and 3rd party WLAN & Blue-
tooth Combo modules.

. |
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Manual Driver Installation

Click Browse CD/DVD (button) inthe Driversinstall-
er application and browse to the executable file in the
appropriate driver folder.

Windows Update

After installing all the drivers make sure you enable
Windows Updatein order to get all the latest security
updatesetc. (all updateswill includethelatest hotfixes
from Microsoft). See “Windows Update” on page 4 -
8 for instructions.

Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if itisnot listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+” to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.
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User Account Control

If aUser Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow theinstallation procedure as direct-
ed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

Y ou will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

Drivers & Utilities

New Hardware Found

If you see the message “New Har dwar e Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.

4

Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter
(and in Chapter 7 Options & Modules), are accurate at
the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.

Make sure any modules (e.g. PC Camera, WLAN or 3G)
are ON before installing the appropriate driver.

Driver Installation 4 - 5
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Driver Installation Procedure

Insert the Device Drivers & Utilities+ User’s Manual
disc and click Install Drivers (button).

Chipset

1. Click Llnstall Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

Video (VGA)

1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

Note: After installing the video driver go to the Dis-
play/Display Settings control panel to adjust the vid-
€0 Settings to the highest resolution.

LAN

1. Click 3.Install LAN Driver > Yes.
2. Click Next > Install.

3. Click Finish.

CardReader
1. Click 4.Install Cardreader Driver > Yes.
2. Click Finish.

Touchpad

1. Click 5.Install Touchpad Driver > Yes.

2. Click Next.

3. Click the button to accept the license agreement
and click Next.

4. Click Finish > Restart Now to restart the com-
puter.
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Hot Key

1. Click 6.Install Hotkey AP > Yes.
2. Click Next > Next.

3. Click Finish > Finish to restart the computer.

USB 3.0 (Win 7 Only)

(Not required for Windows 8)

1. Click 7.Install USB 3.0 Driver > Yes.
2. Click Next > Yes> Next > Next.

3. Click Finish to restart the computer.

MEI Driver

1. Click 8.Install MEI Driver > Yes.
2. Click Next > Yes> Next.

3. Click Finish.

Drivers & Utilities

Audio

1. Click 9.Install Audio Driver > Yes.

2. Click Next.

3. Click the button to agree to the license and
click Next.

4. Click Next > Next > Next.

5. Click Finish to restart the computer.

Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, gect
the Device Drivers & Utilities + User’s Manual disc
and thenreinsert it (or double-click thedisciconinMy
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.

It isrecommended you now also install the Intel Rap-
id Storage Technology driver (see“|RST Driver In-
stallation” on page 7 - 105 - required for AHCI mode
hard disks).

(see over)
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4
Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Click Start, and click Control Panel (or point to
Settings and click Control Panel).

2. Click Windows Update (System and Security/
Security).

3. Click Check for updates (button).

4. The computer will now check for updates (you
need to be connected to the internet).

5. Click Install now (button) to begin checking for the
updates.

6. Click Install updates (button) to install the
updates.

Windows Experience Index

After the drivers are installed follow this procedure to

ensure an accurate rating from the Windows Experi-

ence I ndex (make sure the AC/DC adapter is plugged
in):

1. Click Sart, and click Control Panel.

2. Click Performance Information and Tools
(System and Security > System > Check the
Windows Experience I ndex).

3. Click “Ratethis computer/Refresh Now/Re-
run the assessment”.

4. The computer will take afew minutesto assess
the system performance.

5. Close the control panel.
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Optional Drivers

See the pagesindicated for the driver installation procedures for any modules included in your purchase option.

Figure 4 - 3 - Option Drivers

Note that you need to install both the WLAN & Bluetooth driversfor the Intel and 3rd party WLAN & Blue-
tooth Combo modules.
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BIOS Utilities

Chapter 5: BIOS Utilities "

Overview BIOS Screens

This chapter gives a brief introduction to the computer’ s built-in software: i e e B
screens  pictured on

. these pages are intend-
If your computer has never been set up, or you are making important changesto the BESEERIREREE IRE

system (e.g. hard disk setup), then you should review this chapter first and note the B FSEeNIE S R
original settings found in Setup. Even if you are abeginner, keep arecord of the set-  JHEISES
tings you find and any changes you make. This information could be useful if your

- BIOS versions are sub-
system ever needs servicing. ject to constant change

and revision, therefore
Thereis one general rule: Don’t make any changes unless you are sure of what you VSISl lE]

. . . : screens may appear
aredoing. Many of the settings are required by the system, and changing them could slightly _ different _from

cause it to become unstable or worse. If you have any doubts, consult your service  BEFSEE IS T
representative. pages.

. |
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BIOS Settings
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Pre-
vious Values with
<F2>, or Optimized De-
faults with <F3>.

UEFI Boot & POST

When UEFI Boot is en-
abled, then the prompts
to press F2 or F7 will
not appear. However
you can still press F2 to
enter the setup, or F7 to
choose the preferred
boot device, if you press
the key immediately the
system boots up.

The Setup Utility

Each time you turn on the computer the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

Asthe POST proceeds, the computer will tell you if thereisanything wrong. If there
isaproblem that prevents the system from booting, it will display asystem summary
and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can't get into Setup without rebooting.

The Aptio Setup Utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

To enter Setup, turn on the computer and press F2 (give the system a few seconds
to enter Setup). If the Boot L ogo is enabled the F2 on screen will be highlighted to
illustrate that the system is processing the request during the POST (or press F7 for
boot options). If you get a*“Keyboard Error”, (usually because you pressed F2 too
quickly) just press F2 again.

If the computer is aready on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

To see the boot options press F7 and choose your preferred boot device.
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Failing the POST
Errors can be detected during the POST . There are two categories, “fatal” and “non-
fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) and you can then press F7 (the F7 on screen
will be highlighted to illustrate that the system is processing the request) for boot
options.

Press F2 (give the system a few seconds to enter Setup; the F2 on screen will be
highlighted to illustrate that the system is processing the request) to run the Setup
program and try to correct the problem. If you still get an error message after you
change the setting, or if the “cure” seems even worse, call for help.
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4

Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer's menus will
indicate the configura-
tion appropriate for your
model and options.

Figure5-1
Navigation Menu

Setup Screens

The following pages contain additional advice on portions of the Setup. Along the
top of the screen is a menu bar with menu headings. When you select a heading, a
new screen appears. Scroll through the features listed on each screen to make chang-
esto Setup.

Instructions on how to navigate each screen are in the box at the bottom right side of
the screen.

If these tools are confusing, press F1 to call up aGeneral Help screen, and then use
the arrow keysto scroll up or down the page.

Theltem Specific Help onthe upper right side of each screen explainsthe highlight-
ed item and has useful messages about its options.

If you see an arrow p next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.
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Main Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

System Date

Figure5-2
Main Menu

System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @@ = midnight; 13 = 1 pm). If you
can change the date and time settingsin your operating system, you will aso change
these settings. Some applications may also alter data files to reflect these changes.
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SATA Port # (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a optical Device/
HDD on the computer’s SATA Ports.

System/Extended Memory: (Main Menu)
Thisitem contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

MB Series/ BIOS Revision / KBC/EC firmware Revision
This item contains information on the BIOS version etc., and is not user configu-
rable.
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Advanced Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

Figure5- 3
Advanced Menu

P Advanced Chipset Control

Advanced Chipset Control (Advanced Menu)
The sub-menu here alows you to adjust the Bluetooth Power Setting.
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Bluetooth Power Setting (Advanced Menu > Advanced Chipset Control)

Y ou can adjust the Bluetooth module power setting to your preference. The default
setting (Disabled) will see the Bluetooth module powered off when the system is
started up or restarted. Enabling the power setting will have the module retain the
last power status (on or off) before any restart or shut down.

Intel Smart Connect Technology (Advanced Menu)

Smart Connect is a technology that makes checks on web applications that are
open, when the computer isin Sleep mode, and thus all ows updates to be made with-
out the need to turn the computer on. The sub-menus here alow you to enable/dis-
able the technology. See“ Intel® Smart Connect Technology” on page 7 - 106.

Intel Anti-Theft Technology (Advanced Menu)

Anti-Theft Technology, which is built-in to the processor of the computer, allows
system administrators to render your computer useless to thieves by sending a poi-
son pillencrypted SM S message over a 3G network etc. Administrators can also re-
motely unlock a recovered computer quickly, or direct the system to send location
information (GPS coordinates) back to a central server.
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SATA Mode Selection (Advanced Menu) "
Y ou can configure SATA (Serial ATA) control to operate in | DE (native/compati- 7£,1<
ble), AHCI (Advanced Host Controller Interface) modes from this menu. The SATA Mode
SATA Mode should be set BEFORE installing an oper ating system, and after you Selection

have backed up all necessary files and data (see sidebar).

If you have installed the

Windows 7 operating
Boot Logo (Advanced Menu) system with either IDE

Use this menu item to enable/disable the Boot L 0go screen at system startup. If you  Bel@ANzelRy el ERElElEeE
disable the Boot L ogo you will not see the F2 Enter Setup or F7 Boot Options JE s SAREIECEIERGIES S
prompts on the screen, however you can still press these keys, while the boot screen ?tfl’:eﬂ(]';y::t Wr:: dteo S(’;
is displayed, to perform the Enter Setup or Boot Option functions. ol ezl i retreEll e
Windows 7 OS).
Power On Boot Beep (Advanced Menu)

Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep: (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
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Security Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

4

Security Menu

The changes you make
here affect the access
to the Setup utility itself,
and also access to your
machine as it boots up
after you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in your
software OS.

Secure Boolt Mode [8tandard]

Secure Boot Mode
standard
Custom

Figure5-4
Security Menu
(With Windows 8 as
Selected OS & UEFI
Boot Enabeld)

Set Supervisor Password (Security Menu)
You can set a password for access to the Aptio Setup Utility. This will not affect
access to the computer OS (only the Aptio Setup Utility).
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Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Set User Password (Security Menu)

Y ou can set a password for user mode access to the Aptio Setup Utility. Thiswill
not affect access to the computer OS, (only the Setup utility) unless you choose to
set a Password on Boot (see below). Many menu items in the Aptio Setup Utility
cannot be modified in user mode.

Note: You can only set the user password after you have set the supervisor pass-
word.

Password on boot: (Security Menu)

Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is“Disabled”.

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Security Menu 5 - 11
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Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled’), NEVER
forget your password.

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
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Secure Boot (Security Menu)

Secure Boot prevents unauthorized operating systems and software from loading
during the startup process. Secure Boot is available as a menu option if you have
Windows 8 set as your operating sytem, and have enabled UEFI Boot (see “ Boot
Menu” on page 5 - 16). Enabling Secure Boot will bring up the Secure Boot M ode
menu to enable you to configure Secure Boot as Standar d (with afixed secure boot
policy), or Custom (which enables you to make changes to the | mage Execution
Policy and Key Management database).
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TPM Configuration (Security Menu)

This sub-menu will allow you to enable/disable Trusted Platform Module (TPM)
support, and to configure the TPM State. Select TPM Configuration and press En-
ter to access the sub-menu. Press Enter to accessthe TPM Support menu and select

Enable to display the full TPM configuration menu (see “ Trusted Platform Mod-
ule” on page 7 - 77 for details).

Bptio Setup Utility — Copyright (C) 2012 American Megatrends Inc. Flgure 5 - 5

TPM Support

TPM SUPPORT [Disable]

Security Menu 5 - 13



BIOS Utilities

TPM Sate (Security Menu > TPM Support Enabled)
Select TPM State, press Enter and select Enable to change the TPM state to en-
abled. Y ou will then need to press F4 to save the changes and restart the computer.

Aptioc Betup Utility — Copyright {(C) 2012 American Megatrends Inc.

Flgure 5 - 6 TPM SUPPORT [Enable]
TPM State (Enabled)

Asthe computer restarts press F2 to enter the BIOS again and go to the TPM Con-
figuration menu.
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Pending TPM operation (Security Menu > TPM Support & TPM Sate Enabled)
Select Pending TPM operation, press Enter and select the option you require (if
you areinitializing TPM you should select Enable Take Owner ship). You will then
need to press F4 to save the changes and restart the computer. Y ou can now install
the TPM driver (see “Trusted Platform Module (TPM) Driver Installation” on
page 7 - 80) and then initialize the TPM.

Aptioc Setup Utility — Copyright (C) 2012 American Megatrends Inc.

Pending TPM operation [Hone]

Pending TPM operation
None
Enable Take Owmership
Disable Take Ownership
TPM Clear

BIOS Utilities

Figure5-7
Pending TPM
operation
(Enable Take
Ownership)
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Boot Menu

Aptio Setup Ttility — Copyright (C) 2012 American Megatrends Inc.

Figure5- 8 o
Boot Menu

Boot Option #1 [Windows Boot Manager]

2NZ
Z &

BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore

your computer’'s actual A . .
A When you turn the computer on it will look for an operating system (e.g. Windows

slightly different from 7) from the devices listed in this menu, and in this priority order. If it cannot find
LRSSl the operating system on that device, it will try to load it from the next device in the
pages. order specified in the Boot Option Priorities. Item specific help on the right is
available to help you move devices up and down the order.

. |
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Boot Option Priorities (Boot Menu)

Usethearrow keysto move up and down the menu, and press Enter to select adevice
from the Boot Option #list. Y ou can go to either Network Device BBS Priorities,
CD/DVD ROM DrivePrioritiesor Hard Drive BBS Priorities and use the + and
- keys to move the device' s boot priority up and down the list (the selected device
will be highlighted in white).

OS Salect (Boot Menu)
This item tells allows you to set the operating system you intend to use. This item
should be set before you install an operating system.

UEFI Boot (Boot Menu)

Enable/disable UEFI Boot from this menu. The Unified Extensible Firmware Inter-
face (UEFI) specification provides a clean interface between operating systems and
platform firmware at boot time. In contrast to BIOS, UEFI defines a set of standard
boot and runtime services (you can configure the UEFI Secure Boot options from
the Security Menu - see “ Secure Boot (Security Menu)” on page 5 - 12).

|
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Exit Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

Figure5-9 —
Exit Menu

Save Changes and Reset

Click Save Changes and Reset to save al changes made. Choosing to Discard
Changes, or Exit Discarding Changes, will wipe out any changes you have made
to the Setup. Y ou can also choose to restore the original Setup defaults that will re-
turn the Setup to its original state, and erase any previous changes you have madein
aprevious session.

. |
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Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problemsyou can con-
tact your service representative for further help. Before you begin you will need:

» A small crosshead or Phillips screwdriver
* A small regular slotted (flathead) screwdriver
e Anantistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

* Removing the Battery

» Upgrading the Hard Disk Drive

» Upgrading the Optical (CD/DVD) Device
» Upgrading the System Memory (RAM)

Please make surethat you review each procedur e before you perform it.

N2
2

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
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When Not to Upgrade
7£l< These procedures involve opening the system’ s case, adding and sometimes replac-
Power Safety Warning ing parts.

el e EREIE] Y ou should not perform any of these upgradesif:

any upgrade proce-

AU ELE SRRl ¢ Your system is still under warranty or a service contract
VELEVERCIG GRSl «  You don't have all the necessary equipment
SOUEEEEEEEEEE . You're not in the correct environment

ed all peripherals and
cables (including tele- [N You doubt your abilities

PRONEHINES GNCIROWEES g any of these conditions, contact your service representative to purchase or re-

place the component(s).

cord).

You must also remove
your battery in order to
prevent accidentally
turning the machine on.
Before removing the
battery disconnect the
AC/DC adapter from
the computer.

2N
2L &
Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before restoring power to the system.

Also note the following when the cover is removed:

e Hazardous moving parts.
» Keep away from moving fan blades.

. |
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Upgrading The Computer

Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with afast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.

Overview 6 - 3



Upgrading The Computer

SN
L&

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure6-1
Battery Removal

Removing the Battery

If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery.

1.

2.
3.
4

Turn the computer off, and turn it over.

Slide the latch @ in the direction of the arrow.

Slide the latch @ in the direction of the arrow, and hold it in place.
Slide the battery out in the direction of the arrow @.

6 - 4 Removing the Battery
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Upgrading the Hard Disk Drive

\N A/
The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard ’Ll\
disk drives with a height of 9.5mm (h) (see“ Storage” on page D - 4). Follow your HDD System
operating system’ sinstallation instructions, and install all necessary driversand util- SUELLIRE
ities (see “ Driver Installation” on page 4 - 2), when setting up a new hard disk. New HDD's are blank. Be-

fore you begin make sure:
You have backed up any
data you want to keep from
your old HDD.

You have all the discs re-
quired to install your oper-
ating system and
programs.

If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

Upgrading the Hard Disk Drive 6 - 5



Upgrading The Computer

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws @ & @.
3. Remove the hard disk bay cover @.

Figure6- 2
Hard Disk Bay
Cover Removal

@
®
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Upgrading The Computer

Slide the hard disk in the direction of arrow @.
Lift the hard disk out of the bay @. V4
Remove the screw(s) @ - € and the adhesive cover @.

Reverse the process to install a new hard disk drive (do not forget to replace all the Hard Disk Screws &
screws and covers). Cover

The hard disks and cov-
ers pictured here may
appear slightly different
from your model design
e (these designs are sub-

ject to change and up-
grade without notice).
Pay careful attention to
the screws (if included)
and cover orientation.

Figure6- 3
6 Hard Disk Removal
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Upgrading The Computer
Upgrading the Optical (CD/DVD) Device

The procedure for removing the optical device will depend upon your particular
computer model:

» See"Removing the Optical Device for Model A Computers’ on page 6 - 9.

» See“Removing the Optical Device for Model B & C Computers’ on page 6 -
11.

.|
6 - 8 Upgrading the Optical (CD/DVD) Device



Removing the Optical Device for Model A Computers

1.
2.
3.

4,

Upgrading The Computer

\ A/
Turn off the computer, and turn it over and remove the battery. 7&‘
Locate the component bay cover and remove screws @ - @. Fan Cable & Cover

Carefully (a fan and cable are attached to the under side of the cover) lift up

the bay cover.

Make sure you recon-

Carefully disconnect the fan cable @, and remove the cover @. nect the fan cable 5

(2]
®

before screwing down

the bay cover. Note the
information on replac-
ing the RAM & CPU
bay cover in

Figure6- 4
Removing the
Component Bay

6 Cover
(Model A

Computers)

Upgrading the Optical (CD/DVD) Device 6 - 9



Upgrading The Computer

5.  Remove the screw at point @), and use a screwdriver to carefully push out the
optical device at point @.
6. Reverse the process to install the new device.

Figure6-5
Removing the a
Optical Device @
(Model A
Computers)

6 - 10 Upgrading the Optical (CD/DVD) Device
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Removing the Optical Device for Model B & C Computers

1. Turn off the computer, and turn it over and remove the battery.

2. Remove the hard disk (see page 6 - 5)

3. Remove the screw at point 0 and use a screwdriver to carefully push out the
optical device at point @.

4. Reverse the process to install the new device.

5. Replace the hard disk bay cover.

Figure6- 6
Removing the a
- Optical Device
(Model B & C
o Computers)

2] 2]
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Upgrading The Computer
Upgrading the System Memory (RAM)

The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-
DIMM) DDRIII (DDR3) type memory modules (see “Memory” on page D - 3 for
details of supported module types).

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws @ - @.

(1) (1)
(2] (2]
(3] ®
Figure6-7 o (4]
Component Bay
Cover Screws
o
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Upgrading The Computer

3. Raise the bottom cover up and carefully (a fan and cable @ are attached to the
under side of the cover) lift up the bay cover @. DA
Model A Fan Cable
Make sure you recon-
@ nect the fan cable 5

before screwing down
the bay cover.

5] 5]

Model B

(5) © Figure6- 8
Component Bay
Cover Removal

Model C
(6]

Upgrading the System Memory (RAM) 6 - 13
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Figure6-9
RAM Module
Release Latches

SN
ALK

Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the cleanest
hands have oils which
can attract particles, and
degrade the module’s
performance.

Figure6 - 10
RAM Module
Removal

4.

5.

Gently pull the two release latches on the sides of the memory socket in the
direction indicated by the arrows (@ & @) in Figure 6 - 9.

(8]

The RAM module will @) pop-up, and you can remove it.

4

Single Memory Module
Installation

If your computer has a single memory
module, then insert the module into the
Channel 0 (JDIMM1) socket. In this
case this is the lower memory socket
(the socket closest to the mainboard).

6 - 14 Upgrading the System Memory (RAM)
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10.

11.

12.

.|
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Upgrading The Computer

Pull the latches to release the second module if necessary.

Insert a new module holding it at about a 30° angle and fit the connectors firmly
into the memory slot.

The module’s pin alignment will allow it to only fit one way. Make sure the module
is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit
without much pressure.

Press the module in and down towards the mainboard until the slot levers click into
place to secure the module.

Replace the bay cover by inserting it at an angle and aligning the cover pins (see
sidebar).

Make sure you reconnect the fan cable before replacing all the screws and
screwing down the bay cover.

Restart the computer to allow the BIOS to register the new memory configuration
as it starts up.

4

Cover Pins

Note that the computer
has four cover pins.
These pins need to be
aligned with slots in the
case to insure a proper
cover fit, before screw-
ing down the bay cover.

Figure6- 11
Cover Pin
Alighment
(One Model
Pictured)
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Chapter 7: Modules & Options %

Y/

\§

I Wireless Device
OverVIGW Operation Aboard
This chapter contains information on the following modules, which may come with Aircraft
your computer, depending on the configuration purchased. If you are unsure please B eSS el
contact your service representative. electronic transmission de-

vices aboard aircraft is usu-
* PC CameraModule e 3G Module ally prohibited. Make sure
« WirelessLAN Module * Trusted Platform Module ;';i ggduf;(g)thzriogggt;:
* Intel® Wireless Display Application < Intel Rapid Storage Technology T Y
* Bluetooth & WLAN Combo Module ¢ Intel® Smart Connect Technology

4

Driver Installation &
Module Power

For information on the Windows 8 operating system see Appendix E.

Make sure any modules
(e.g. WLAN, PC Camera &
Bluetooth modules) are ON
before installing the appro-
priate driver.

. |
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7 - 2 Overview

\ A/
2§
Important Notice
If your purchase option includes both Wireless LAN and 3G modules, then the appropriate
antennas will be installed. Note that In order to comply with FCC RF exposure compliance

requirements, the antenna must not be co-located or operate in conjunction with any other
antenna or transmitter.

Important Notice - 3G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G module and the
Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency, and
cause interference. When the 3G module is powered on, make sure that the Bluetooth/
Wireless LAN modules are powered off.




Modules & Options

PC Camera Module e

Before installing the PC Camer a driver, make sure that the optional PC Camerais -
on. Use the Fn + F10 key combination (see “Function/Hot Key Indicators’ on
page 1 - 15) or Control Center button to toggle power tothe PC Cameramodule.

Check the Device Driv-

Notethat only 14.0" / 35.56cm Model A computersrequireacameradriver for ers & Utilities + User's
Windows 8. See “PC Camera (Windows 8)” on page E - 25 for Windows 8 con- Manual disc, and any

Latest PC Camera
Driver Information

figuration information. accompanying  insert

pages, for the latest up-
When the 14" /35.56cm screen Model A PC Cameraisin use the power LED indi- B EEEERRIeI R ETERReRTGLE
cator will blink orange (see Table1 - 2, on page 1 - 11). PC Camera driver,

which may override the
When the M odel B/C PC Cameraisin usethe LED indicator to the left of the camerawill be  JElSiiE sl eleliE ol
illuminated in red (see @ Figure 1 - 4 on page 1 - 9/Figure 1- 4 on page1- 9). I

Make sureyou install thedriversinthe order indicated in Table 4 - 1, on page 4 - 3. PC Camera Driver Un-
Make sure you access the application via the desktop shortcut. sz

If you need to uninstall

ﬁ the driver, then uninstall
o . the WebCam Installer

PC Camera Application and Power-Saving States item from the Programs

If the computer enters Sleep or Hibernate mode while running the camera application, the and Features control

program will stop running, and will need to be restarted when the system resumes from the panel in Windows.
power-saving state.

PC Camera Module 7 - 3
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PC Camera Driver Installation

ﬁ 1. Make sure the module is powered on, and then insert the Device Drivers &
PC Camera Screen Utilities + User’s Manual disc into the DVD drive.
Refresh 2. Click Option Drivers (button).
ey s ——— 3. Click 1.Install Webcam Driver > Yes.
it e | 4 Click Finish to restart the compuiter.
12 fps. If you find that OR
(S i =i 4. Click Next > Finish.
SEEERCREE TS 5. Run the camera application program from the desktop shortcut (if the hard-
S iz reduced_”‘et wareisturned off use the Fn + F10 key combination to turn it on again).
the OutLL Siae andlo See“PC Camera (Windows 8)" on page E - 25 for information on the cam-
put Size and/or L. .

sion.

To reduce Output Size
and/or Color Space
Compression run the
camera application,
click Options and select
Video Capture Pin. Ad-
just the settings from the
appropriate  pull-down
menu.

7 - 4 PC Camera Module
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).

2. Click Sound (Hardware and Sound).

3. Click Recording (tab).

4. Right-click Microphone (VIA High Definition Audio) and make sure the item is not
disabled.

5. Double-click Microphone (or select Properties from the right-click menu).

6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to

the level required.

7. Click OK and close the control panels.

Run the camera application program from the desktop shortcut.

9. Go to the Devices menu heading and select Microphone (VIA....) (it should have a
tick alongside it).

10. Go to the Capture menu heading and select Capture Audio (it should have a tick
alongside it).

®

. |
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Figure7-1
Audio Setup for PC
Camera

Right-click

7 - 6 PC Camera Module
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Camera Application
The cameraapplicationisavideo viewer for general purpose video viewing and test-
ing, and for capturing video filesto .avi format.

1. Runthe camera application from the desktop shortcut (it is recommended that you
set the capture file before the capture process - see Set Capture File below).

2. Goto the Capture menu heading (if you wish to capture audio check “PC Camera
Audio Setup” on page 7 - 5) and select Start Capture.

3. Click OK (the file location will be displayed in the pop-up box) to start capturing the
video, and press Esc to stop the capture (you can view the file using the Windows
Media Player).

Set Capture File

Prior to capturing video files you may select the Set Capture File... option in the
File menu, and set the file name and |ocation before capture (thiswill help avoid ac-
cidentally overwriting files). Set the name and location then click Open, then set the
“Capturefilesize:” and click OK. Y ou can then start the capture process as above.

Note the important information in “ Reducing Video File Size” on page 7 - 8 in or-
der to save file space, and help prevent system problems.

. |
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Reducing Video File Size

Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (goto My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to aremovable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows system requires a minimum of 15GB of free space on the C:
drive system partition. In order to prevent system problemsit is recommended that
you save the captured video file to alocation other than the C: drive (see“ Set Cap-
ture File” on page 7 - 7), limit the file size of the captured video or reduce video
resolution (see below).

To Reduce Video Resolution Qutput Size:

1. Run the camera application program from the desktop shortcut.

2. Go to Options and scroll down to select Video Capture Pin....

3. Click the Output Size drop box and select a lower resolution size in order to reduce
the captured file size.

4. Click OK.

7 - 8 PC Camera Module



Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to
adjust the setting in the Video Capture Filter options.

1. Run the camera application from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under PowerLine Frequency.

4

Camera Options

The video capture filter
figure pictured here may
appear slightly different
for some camera mod-
ules. To adjust the anti
flicker properties look un-
der the headings Anti
Flicker/Frequency/Pow-
erLine Frequency.

PC Camera Module 7 - 9

Modules & Options

\ A/

Z &
Latest PC Camera
Driver Information

Check the Device Driv-
ers & Utilities + User’s
Manual disc, and any
accompanying insert
pages, for the latest up-
dated information on the
PC Camera driver,
which may override the
information provided
here, including the fig-
ures pictured.

Figure7-2
Video Capture Filter



Modules & Options

Taking Still Pictures
& The camera application allows you to take still pictures.

Snapshot Folder 1. Run the camera application from the desktop shortcut.
The' Snapshot folder's 2. Goto Options and select Take Picture.
T 3. The picture (in JPEG format) will be placed in the Snapshot folder on the

desktop. Do not move desktop.
this folder or an error
may appear when you

try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.

. |
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Wireless LAN Module S

AN
If you haveincluded an Intel® or 3rd Party WirelessLAN (or WLAN & Bluetooth Wirele/fsl;evice
combo) module in your purchase option, make sure that the WLAN moduleison be- Operation Aboard
foreinstaling thedriver. See“ Wireless LAN Settings (Windows 8)” on page E - 30

k e ) Aircraft
for Windows 8 configuration information.
The use of any portable
o , . lectronic t ission de-
Use the Fn + F11 key combination (see “ Function/Hot Key Indicators’ on page 1 Siig’;f;ﬁ'gar?i;il”ﬁji'i‘;”usﬁ_
- 15) or Control Center button to toggle power to the Wireless LAN module. gl ChIiEEEECEEE
Make sure you install the driversin the order indicated in Table4 - 1, on page 4 - 3. A EEEEOREER
you are using the computer
aboard aircraft.

Note that you need to install both the WLAN & Bluetooth driversfor theIntel and
3rd party WLAN & Bluetooth Combo modules. Use the Fn + P11 key com-

bination or hot key button to

toggle power to the WLAN
module, and check the indi-
cator to see if the module is
powered on or not (see

/

Wireless LAN Module 7 - 11
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3rd Party 802.11b/g/n Driver Installation
If you see the message “Found New Hardwar e’ click Cancel to close the window.

1

agroLN

M ake surethe moduleis powered on, and then insert the Device Drivers
& Utilities + User’s Manual disc into the DVD drive.

Click Option Drivers (button).

Click 2.Install WLAN Driver > Yes.

Click Next.

Click Finish to restart the computer.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows (see page 7 - 14). See “ Wireless LAN Settings (Windows 8)” on page E - 30
for Windows 8 configuration information.

. |
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Intel® WLAN Driver Installation
If you see the message “Found New Hardwar €’ click Cancel to close the window.

1.

oOUhkwWN

Make surethe moduleis powered on, and then insert the Device Drivers
& Utilities + User’s Manual disc into the DVD drive.

Click Option Drivers (button).

Click 2.Install WLAN Driver > Yes.

Click Next > Next.

Click the button to accept the license and click Next.

Click (for some driver versions you will need to select Typical or Custom)
Next/Install > Next > Finish.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows (see overleaf). See “Wireless LAN Settings (Windows 8)” on page E - 30 for
Windows 8 configuration information.

Wireless LAN Module 7 - 13
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Connecting to a Wireless Network in Windows 7
e Make sure the Wireless LAN moduleis turned on.

Network and 1. Click the taskbar wireless icon I, and then double-click an access point to con-
Sharing Center nect to or click to Open Network and Sharing Center if you do not see a network
you want to connect to in the taskbar menu (a list of options will appear allowing

oL el el U e bl setting changes, and creating a new network).

work and Sharing Cen-

ter control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure7-3
Click Taskbar Icon
Menu & Network
and Sharing Center
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2. You may need to enter a security key for any access point to which you are trying to
connect.

3. Click to select a network location (e.g. Home, Work or Public).

4. Click “View or change settings in Network and Sharing Center” to access further
options for the connection.

Figure7-4
Network Location
Set

Wireless LAN Module 7 - 15
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5. Click the taskbar icon 4| to see any currently connected networks.
\ A/ . . . . R
ﬂ: 6. To disconnect from the wireless network you can click the taskbar wireless icon i,

. click the active connection and then click Disconnect (button).
Security Enabled

Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure
networks may allow unau-
thorized access to your
computer, documents,
websites and files etc.

Figure7-5
Click Taskbar Icon
Menu - Disconnect
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Intel® My WiFi Configuration

Intel® My WiFi Technology uses your WLAN (for Intel WLAN modules only) a
module to allow you to connect up to eight other WiFi enabled devices (e.g. digital Intel® My WiFi
. y WiFi Help
cameras, other computers, cell phones, handheld devices etc.) to your computer
(similar to Bluetooth), while still connecting to the I nternet through your WiFi wire- | To get help on Intel®

less connection. Intel® My WiFi Technology offers greater range and speed than || MY WiFi configuration
and settings, access the

other personal area networks, and does not require an access point. Intel® My WiFi Utility
from the Start menu
(Start > Programs/All
Programs > Intel PRO-
Set Wireless > Intel My
WiFi Technology), or by
clicking the taskbar icon
. Click the Help icon
and select a
help topic from the Con-
tents menu.

Wireless LAN Module 7 - 17
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Intel® My WiFi Configuration
Y ou can configure the My WiFi settings as follows.

1. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by double-
clicking the taskbar icon

2. Click Enable (on the first run of the program there will be no connected
devices listed).

Figure7-6 O

Intel® My WiFi
Utility
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3. Click Start and click Control Panel.
4. Click Network and Sharing Center (Network and Internet).
5. Click Change adapter settings.

Figure7-7

> Network and

Sharing Center

Click Change

adapter settings
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6. Right-click Wireless Network Connection and select Properties.

Figure7-8
Network
Connections

Right-click Wireless Network
Connection and select Proper-
ties.
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7. Click Sharing (tab) and select “Allow other network users to connect through
this computer’s Internet connection”.

Select Wireless Network Connection under Home networking connection.

9. Click OK.

o]

Click “Allow other network
users to connect through
this computer’s Internet
connection”.

Select Wireless Network
Connection. \ Figure7-9
Wireless Network
Connection
Properties -

Sharing
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10. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by double-
clicking the taskbar icon

11. Click Profiles

Figure7 - 10
Intel® My WiFi
Utility - Profiles
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12. Click Profiles, click Intel Wireless PAN and click Edit or New (Note that all preset
settings may not be editable - see sidebar).

Figure7-11
Profiles

4

Profile Settings

OO

13. You can change the Profile Name and Network Name to your personal preferences Profiles that are preset
in General (tab). may not be fully edit-
able. To edit all the

profile settings, click
Profile and Network Names

New to create a new
profile and adjust the
settings to your prefer-

The Profile Name is the name as dis- ElEES

played on your computer in the Net-

work Connections control panel
(see Figure 7 - 13 on page 7 - 24).

. Figure7 - 12
The Network Name (SSID) is the Intel® My WiFi
name the devices see when they try Profile Settings -
to connect to your computer. General g
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14. Click Security (tab).
15. Change the Security Type to WEP and the Encryption Type to 64bit.
16. Enter a password (8 characters long) in the Password box.

S
e —

Figure7 - 13
Intel® My WiFi

Profile Settings -
Security ©
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17. Click Sharing (tab).
18. It is recommended that the Filter Network Traffic and DHCP and DNS Server are
Disabled.

0

Figure7- 14
Intel® My WiFi

Profile Settings -
Sharing

0
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19. Click Advanced (tab).
20. Itis recommended that the Default Channel is set to Channel 1, 6 or 11.
21. Click OK to save the settings.

Figure7- 15 Q

Intel® My WiFi
Profile Settings -

Advanced —_
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22. Double-click Wireless Network Connection in Network Connections.
23. Click Details to display the Network Connection Details.

Figure7- 16
Wireless Network
Connection Details

>
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24. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking
the taskbar icon

25. To add a new device follow the instructions in the devices’ user guide for connecting
to a WiFi network.

26. Click Add New Device in Intel® My WiFi Utility to confirm the security settings
detail.

Figure7- 17 ©
Intel® My WiFi
Utility
(Add New Device)

7 - 28 Wireless LAN Module



Modules & Options

Intel WLAN & Bluetooth Combo Module High-Speed Data

Transfer Configuration

Y ou will need to configure the following settings to enable high-speed wireless data
transfer as supported by Intel WirelessLAN & Bluetooth Combo modules (note this
information applies to Intel WLAN & Bluetooth Combo modules only).

1. Go the Windows control panel and double-click Device Manager (in Hardware
and Sound under Devices and Printers).

S—

Figure7-18
Devices and
Printers
(Device Manager)

. |
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Figure7-19
Intel WiFi Link
Properties
(Advanced)

NG AWN

Click Network adapters to expand the sub-menu.
Double-click the Intel WiFi Link .... module.

Click Advanced (tab).

Click 802.11n Channel Width for band 2.4 under “Property:”.
Click the pull-down menu under “Value:”

Click to select Auto.

Click OK and close the control panels.

-

D
>
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Windows Mobility Center

The Windows Maobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:

1. Click Start, and click Control Panel (or point to Settings and click Control
Panel).

2. Double-click Windows Mobility Center (Mobile PC).

3. Click the button to Turn wireless off/on, or click the icon  to access the network
menu.

Figure7 - 20
Windows Mobility
Center
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Intel® Wireless Display Application

Z The Intel® Wireless Display Application (requires Intel® Centrino WLAN/

Compatible Combo module), in conjunction with acompatible video adapter (purchased sep-

Adapters arately), allows you to display the contents of the notebook display on another dis-

For a list of compatible | play (e.9. HDTV) without the need to have cables stretching across aroom. Y ou can

display and audio adapt- || then play games, browse the internet, display videos or photo slide shows on your
ers check the Intel web- | T\//external display without using HDMI or A/V cables.

site, or your service
center. . . o~ . . .
Before configuring the Intel® WiDi application you will need to set up your com-

patible adapter with your display/speakers. Connect the adapter using an HDMI or
A/V cable and turn on the display (or in the case of speakers connect them to the
wireless speaker adapter with the cables provided with the adapter), and then set the
display to the appropriate input channel (see the documentation supplied with your
compatible adapter for full details).

Intel® WiDi also incorporates Intel® Wireless Music which allows you to wire-
lessly stream audio from your computer to speakers connected to a compatible
wireless speaker adapter (purchased separately).
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Intel® WiDi Application Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD
drive.

Click Option Drivers (button).

Click 3.Install WiDi AP > Yes.

Click Next.

Click the button to accept the license and click Next.

Click Finish.

Intel® Wireless Music Driver Installation

If you wish to use your system to stream wireless audio to speakers connected to a
compatible wireless speaker adapter you will need to install the Intel(R) Wireless
Music Driver.

oOUhkwN

1. Insert the Device Drivers & Utilities + Usaer’s Manual disc into the DVD

drive.

2. Click Browse and browse to the driver location (X: denotes your DVD
drive):

o X:\Options\02WL AN\Intel_WiDi_Music\autor un.exe

3. Click Next.

4. Click the button to accept the license and click Next.

5. Click Finish.

6. Follow the procedure overleaf to setup WiDi or Wireless Music.

.|
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Intel® WiDi Application Configuration
1. Click Start > All Programs > Intel Corporation > Intel(R) Wireless Display >
Intel(R) Wireless Display, or double click the icon on the desktop.

2. Click I agree to the terms of this license (button).
3. The application will scan for any connected compatible adapters (or you can click
the Scan for available adapters button to enable Intel My WiFi Technology).

7 Figure7-21
Intel® WiDi Scan

>
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Click to select and detected adapters, and click Connect.

The system will then prompt you to enter the 4-digit security code which will be
displayed on the external TV Screen (or press the connect button on the wireless
speaker adapter).

6. Enter the code for the video adapter and click Continue.

a s

Figure7 - 22
Intel® WiDi Connect
& Enter Security
Code

.|
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7. You will then be prompted to enter a name for the video adapter and click Continue.
/ \ 8. Click Finished to complete the setup.

Test Audio Adapter

To verify a successful
audio connection (for In-
tel® Wireless Music),
select the “Test your
audio connection” link
or select “Finished” to
bypass the test.

You can select “Play Q O

Sample” to play an au-
dio test sample from
your adapter to the con-
nected speaker set.

Figure7- 23
Intel® WiDi
Connected
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Bluetooth & WLAN Combo Module

AL
If your purchase option includes the Combination Wireless LAN & Bluetooth . ’Q\ .
module (either Intel® or 3rd Party) then install the driver as instructed overleaf Wireless Device
(see“ Bluetooth Settings (Windows8)” on page E - 37 for instructions on Bluetooth Operit;?cr: ﬁftboard
settings for Windows 8).
The use of any pprtable
Usethe Fn + F12 key combination or Control Center button to toggle power to st EiauEsBIEs
vices aboard aircraft is usu-
the Bluetooth module. ally prohibited. Make sure
the module(s) are OFF if
4

Bluetooth Data Transfer

you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the LED indicator to
see if the module is pow-
ered on or not (see

/

).

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in

one direction only (simultaneous data transfer is not supported). Therefore if you are copying a
file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Blue-
tooth enabled device to your computer until the file transfer process from the computer has been com-
pleted.

» For 3rd party Bluetooth modules see the information provided overleaf on the
driver provided.

» For Intel Bluetooth combo modules see the installation procedure see “ 3rd
Party Bluetooth (V4.0) Combo Driver Installation” on page 7 - 38 and “ Stan-
dard Bluetooth Configuration in Windows 7" on page 7 - 40.
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3rd Party Bluetooth (V4.0) Combo Driver Installation

1

Beforeinstalling thedriver make surethe Bluetooth moduleispowered
on (use Fn + F12 key combination), then insert the Device Drivers & Utili-
ties+ User’'s Manual disc into the CD/DVD drive. If aFound New Hard-
ware window appears, click Cancel in al windows that appear, and then
proceed to install the driver as below.

Click Option Drivers (button).

Click 4.Install Combo BT Driver > Yes.

Click Next (if aprompt appearsto ask you to turn the Bluetooth power on,
pressthe Fn + F12 key combination to do so, otherwise the driver will not
be installed).

Click Finish to restart the computer.

See* Standard Bluetooth Configuration in Windows 7” on page 7 - 40 for
configuration instructions. See “ Bluetooth Settings (Windows 8)” on

page E - 37 for Windows 8 configuration information.

. |
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Intel Bluetooth Combo Driver Installation

Notethisdriver isrequired only for the I ntel combo Bluetooth and WLAN module
only.

1.

NoOrWN

Bluetooth & WLAN Combo Module 7 - 39

Beforeinstalling thedriver make surethe Bluetooth moduleis powered
on (use Fn + F12 key combination), then insert the Device Drivers & Utili-
ties+ User’'s Manual disc into the DVD drive. If aFound New Hardware
window appears, click Cancel in al windows that appear, and then proceed
to install the driver as below.

Click Option Drivers (button).

Click 4.Install Combo BT Driver > Yes.

Click Next > Next.

Click the button to accept the license and click Next.

Click Next > Finish.

See over for configuration instructions. See “ Bluetooth Settings (Windows
8)” on page E - 37 for Windows 8 configuration information.

Modules & Options

4

High Speed Bluetooth
Data Transfer

The Combination Wire-
less LAN & Bluetooth
module supports high
speed data transfer. How-
ever to achieve such
transfer speeds, both de-
vices must support
high speed data trans-
fer.

To obtain high speed
data transfer make sure
that both the WLAN and
Bluetooth modules are
powered on.

Check your Bluetooth
compatible device’'s doc-
umentation to confirm it
supports high speed data
transfer.
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Standard Bluetooth Configuration in Windows 7

el Setup your Bluetooth Device so the Computer Can Find it
Add a Device 1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.

Click Start, and click Con- 2. Make the device discoverable (to do this check your device documentation).

trol Panel and then click § 14 (- the Bluetooth Module On
Devices and Printers

(Hardware and Sound). 1. Pressthe Fn + F12 key combination to power on the Bluetooth module.
Click Add a device to 2. A Bluetooth icon EJ will appear in the taskbar notification area.

search for any available = 3 You can then do any of the following to access the Bluetooth Devices control panel.
Bluetooth devices.

¢ Double-click the taskbar icon E to access the Bluetooth Devices control panel.
Bluetooth Module & «  Click/Right-click the taskbar icon [ and choose an option from the menu.
Resuming From Sleep
Mode

The Bluetooth module’s de-
fault state will be off after
resuming from the Sleep
power-saving state. Use
the key combination (Fn +
F12) to power on the Blue- H

tooth module after the com-
puter resumes from Sleep.
Add a device

Right-Click Taskbar Icon
Figure7-24
Bluetooth Devices &
Click Icon Menu
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To Add a Bluetooth Device

1. Access the Bluetooth Devices control panel and click Add a device. /
2. Double-click the device you want to pair with the computer.

Pairing Options

If a device has been pre-
viously connected then
the pairing option menu
will appear when you at-
tempt subsequent con-
nections. You can choose
to have the computer cre-
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

Figure7 - 25

. . ) ) ) . Add a Device
3. On first connection the computer will provide you with a pairing code to be entered

onto the device.
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4. Enter the code into your Bluetooth enabled device and follow any on-screen
instructions to complete the pairing.

Figure7 - 26 -
Pairing Code Pairing Codes

Example The example outlined here shows a connection to

a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
dure, and may require you to confirm a pairing
code is correct on both devices. Follow the on-
screen instructions to complete the pairing.

o

Windows will check to see if any drivers are required to complete the pairing.

6. Follow any on-screen instructions on the computer if device drivers are required to
be installed.

7. Click Close.

Figure7 - 27
Pairing Complete &
Bluetooth Device
Enabled
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To Change Settings for the Bluetooth Device
1. Click the taskbar icon and select Show Bluetooth Devices. 4
2. Right-click on the device you want to change and click Properties to:

* Change the name of the device (click Bluetooth, type a new name and click OK).
» Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

Bluetooth Help

To get help on Bluetooth
configuration and set-
tings, select Help and
Support from the Start

To Make your Computer Discoverable to Bluetooth Devices
1. Click the taskbar icon and select Open Settings.

2. Click Options, and make sure that Allow Bluetooth devices to find this computer menu. Type Bluetooth in
check box (Discovery) has a tick inside it. the Search Help box, and
3. Make sure that the Alert me when a new Bluetooth device wants to connect select an item from the re-
check box (Connections) has a tick inside it, if you want to be notified when a turned search results to
Bluetooth device wants to connect. get more information.
Figure7 - 28
Bluetooth Settings -
Options
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3G Module

Z (For ModelsA & B Only)
3G Module Options If you have included an optional UMTS/HSPDA OR UMTS/HSPDA+ based 3G
There are three optional Module (Universal MobiIeT_equommunications System or _I—!igh_ Speed I_Dacl_<et Ac-
3.G modules available for || CeSS) module (see” Communication” on page D - 5 for specification details) in your
this series of computer | pyrchase option, you will have the appropriate application (Wireless Manager,
i it the sporepri. | AirCard Watcher or Mobile Partner) provided for Windows 7 (see “ 3G Settings
ate application software. (Windows 8)” on page E - 42 for information on Windows 8 as no driver/application
installation is required). Follow the instructions on page 7 - 45 to install the USIM

card (which will be provided by your service provider), and then install the applica-

The module type supplied
may depend upon the com- ’
puter model purchased. tion.
Check with your service
center for details.

2AN\Z
I

Important Notice - 3G & Bluetooth/Wireless LAN Modules

Install the driver from the
Drivers Installer menu and
check the instructions for
the appropriate application
on the following pages.

In order to comply with FCC regulations you should NOT operate the 3G module and the
Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency, and
cause interference. When the 3G module is powered on, make sure that the Bluetooth/
Wireless LAN modules are powered off.
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=

Turn off the computer, and turn it over and remove the battery (see page 6 - 4).
2. Locate the 3G USIM card cover and loosen screw @, and then remove the USIM
card cover @.
Figure7-29
USIM Card Cover
a Removal

\ A/
PR
Power Safety

9 Warning

Before you undertake any

Insert the USIM card as you would into your mobile phone. installation -~ procedures,
make sure that you have

Slide the SIMLOCK towards the hinge in order to release the lock and lift it up. turned off the power, and

Insert the USIM card as illustrated in (Figure 7 - 30) and close the SIMLOCK. disconnected all peripher-
als and cables (including
telephone lines). It is advis-
able to also remove your
battery in order to prevent
accidentally turning the ma-
chine on.

ok w

Figure7 - 30
Insert the USIM Card
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6. Lock the SIMLOCK by pushing it in the direction of the arrow in Figure 7 - 31 until it
clicks into the lock position.

Figure7 - 31
SIMLOCK Lock

4

3G Modules &
System Wake Up

Note that the 3G modules
DO NOT support system
wake up on 3G modem
activity.

. |
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Beforeinstalling theapplication, makesurethat the 3G moduleisON (installing
the driver with the modul e off will not allow the software to detect the module hard-
ware correctly). UsetheFn +  key combination (see Table 1 - 5, on page 1 - 15)
or Control Center button to toggle power to the 3G module. Make sure you install
the driversin the order indicated in Table 4 - 1, on page 4 - 3. Note that exiting the
application does NOT turn off the 3G module.

* Wireless Manager - See “Wireless Manager Installation” on page 7 - 48 for
driver installation information and “ Wireless Manager Application” on page 7
- 49 for instructions on using Wireless M anager.

* AirCard Watcher - See“ Sierra Wireless AirCard Watcher Installation” on
page 7 - 70 for driver installation information and “ AirCard Watcher Applica-
tion” on page 7 - 71 for instructions on using Air Card Watcher.

* MobilePartner - See “Mobile Partner Application Installation” on page 7 -
84 for driver installation information and “ Mobile Partner Application” on
page 7 - 85 for instructions on using M obile Partner.

* See" 3G Settings (Windows 8)” on page E - 42 for Windows 8 configuration
information.
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N /
2§
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + . key com-
bination to toggle power to
the 3G module, and check
the indicator to see if the
module is powered on or
not (see

/

Wireless Manager

With the 3G module and USIM card (supplied by your service provider) installed
you may then install the Wireless Manager application. The Wireless M anager
application alows you to directly access your HSPA internet service from the com-
puter.

Wireless Manager Installation

1

2.

w

NG~

Enable power to the module by pressingthe Fn +  key combination or
Control Center button (give the module about 10 seconds to power on).

If aFound New Hardware window appears, click Cancel (click Cancel for
al Found New Hardware windows that appear).

Insert the Device Drivers & Utilities + User’s Manual disc into your DVD
drive.

Click Option Drivers (button).

Click 5.Install 3G Driver > Yes.

Click Next > Next > Install.

Click Finish.

Access the Wireless Manager application from the Start menu or the desk-

top shortcut
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Wireless Manager Application

The connection information is stored on the USIM card supplied by the service pro- a
vider (where thisis not the case you may need to create a profile - see “ Creating a PIN Number
Profile” on page 7 - 55).

The PIN number for

1. Power on the 3G module using the Fn + key combination. your USIM card will be
2. Access the Wireless Manager application from the Start menu (Start > All supplied by your service
Programs > Wireless Manager > Wireless Manager) or the desktop shortcut . provider. You usually
3. You may be required to enter you PIN number and click OK. have a limited number of
4. Click the Connect | Connect | button (a Profile needs to be selected, and in attempts to enter the
most cases this will be pre-configured). correct PIN number.

If you fail to enter the
PIN number correctly
you will be blocked from
accessing the USIM
card and you will need a
PUK (Personal Un-
blocking Key), supplied
by your service provider,
to unlock it.

Figure7 - 32
Wireless Manager
(Not connected)
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5. The system will connect to your network.

6. Connected will appear above the timer icon (the timer will indicate your connected
time for the current session) ¢ .

Wireless Manager 7. You can then access the internet, download e-mail etc. as per any internet

Help connection.

To get help on Wireless
Manager configuration

and settings, click the
Help icon or press F1.

€9 Help

Figure7 - 33
Wireless Manager
(Connected)
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8. Click the Wireless Manager notification area icon to view the connection status,

or wireless icon[f] to view the Mobile Broadband Connection status.

Figure7- 34
Notification Area
Icons (Connected)

O 5 -

Notification Area

9. Theindicator _gll__ will display the signal strength and radio access technology. Icon

10. To disconnect f IyMTS service provider, click the Disconnect [ piscomez | button ) ) -
(note that if you click the close icon at the top right of the screen the application will Right-click the notification
minimize to the system tray, however the application will still be running; to exit the SUEal [0 U D L e

menu to Open/Exit Wire-
less Manager, Discon-
nect or Turn radio off.

application right-click the notification area icon and click Disconnect or Exit
Wireless Manager).

11. The program will disconnect from the service provider.

12. The module will still be on, and you will need to press the Fn + key combination
to turn it off.

13. If you are unsuccessful in connecting this way you may need to add a profile with
information provided by your service provider (see the following pages).
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Profiles

1. Access the Wireless Manager application from the Start menu (Start > All Pro-
grams > Wireless Manager > Wireless Manager) or the desktop shortcut

2. Click the Settings > Advanced.

3. Click the Profiles (tab).

Figure7 - 35
Advanced Settings -
Profiles

. |
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4. Multiple profiles may be available from the USIM card and the first time the
application starts it may require you to select a profile (Set Profile) to use for your
connection.

Multiple Profiles Found

Multiple profiles were found for this 3IM card. From
the list below, please select which profile to use for
connecticn.

Figure7 - 36
Multiple Profiles
Found

( Set Profile |

Automatic Profile Selection

If Automatic selection is chosen, then the application will search the operator pro-
file database for a profile that matches the details on your USIM card. If a correct
profileisfound it will be automatically selected as your profile.

Manual Profile Selection

If Manual selection is chosen, then you can select a profile from the applications’'s
operator profile database, or you can create a new profile.
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Selecting a Profile

1. Click Manual selection (button).
2. Click the Filter to view the drop-down list.
3. Select the Profile you wish to use and click Apply to confirm the selection.

Figure7 - 37
Profile - Manual
Selection (Filter)

. |
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Creating a Profile

1. Click Manual selection (button). /

2. Click the New.

3. Enter a name you prefer for the profile. Deleting a Profile

4. Enter the Access Point Name (APN). Toldeleteraipionletcliek

5. Enter the User Name and Password if required (some service providers may not to select Manual selec-
require this information and the fields may then be left blank). tion and select the pro-

6. If your service provider requires IP address, DNS and Protocols to be entered, file and click Delete.
click the appropriate tab and enter the supplied information (otherwise leave blank).

7. Click Save to save the profile information.

Modifying a Profile

8. The profile will be stored under User defined in the Filter drop-down list.
To modify a profile click
to select Manual selec-
tion and select the pro-
file and click Edit.
Change the settings as
required and then click
Save (note that only
user defined profiles
may be edited).

Figure7 - 38
New Profile IP, DNS
& Protocols
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Figure7 - 39
Settings

Settings

The Settings tab allows you at adjust the application features. Click to put atick in
Launch Wireless M anager at Windows star tup to launch the application at Win-
dows Startup.

The Advanced settings allows more detailed configuration. To access the Ad-
vanced settings.

1. Access the Wireless Manager program from the Start menu (Start > All Pro-
grams > Wireless Manager > Wireless Manager) or the desktop shortcut

2. Click the Settings > Advanced.

3. Click the tab to edit any particular setting.
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SIM
Most USIM cards are protected by a Personal Identity Number (PIN). Y ou may turn 4
on or off the Request PIN at startup (click Apply to save any changes). You can

aso Change PIN (you will need to enter the new PIN in the two fields provided and PIN'Notes

click Apply to save any changes). You will have to enter
_ your current PIN to

Radio change the PIN settings.

Radio needs to be turned on before you can make any connection (note thisis not

. . . . Request PIN at startup
the same as powering the module off/on using the Fn +  key combination), but & & e g ey
you may turn it off when required. Automatic modeis the recommended setting for | have shut the computer
most 3G networks as it will use 3G where available. All Frequency bandsarese- | down and restarted it
lected as default (click Apply to save any changes). (not just restarted).

Radio & Power
Saving States

You can choose to have
the radio turned on or off
during Hibernate or
Sleep power saving
states.

Figure7 - 40
Advanced Settings
SIM & Radio
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Networks
S The mobile network list lists available networks at your location, and alows you to
Warning select a network which to connect. Y ou must disconnect before being able to select
anetwork.

Note that some applica-

tions automatically Connection
transmit data when con-

nected, and you may be

You can set the Wireless Manager to automatically connect at Windows startup
Sl e i ckice f (however the module must be powered on, and radio must be turned on). You can
(EnsiEp SRRl also automatically connect when resuming from a power-saving state (click Apply

connection/connection to save any changes). Click Default to return to the original default settings.
settings may lead to ex-

pensive roaming charg-

es.

Figure7-41
Advanced Settings
Networks &
Connection
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Text Messaging Service (SMS)

In addition to standard internet services you may also send and receive SMS text
messages using the Wireless Manager, if your service supports SMS.

SMS Utility

1. Access the Wireless Manager application from the Start menu (Start > All Pro-
grams > Wireless Manager > Wireless Manager) or the desktop shortcut

2. Click SMS and the SMS Utility will then start.

3. The indicator in the upper right corner will display if radio is currently on or off (radio
must be on in order to send/receive messages).

Figure7 - 42
SMS Utility Open
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Messages
Click the M essages tab to access the tabs displaying text messages. The tabs at the
top of the menu display the Inbox, Drafts, Outbox, Sent and Trash menus.

Inbox Drafts Outbox Sent Trash

Figure7 - 43
SMS Utility
Messages

Text messages are automatically saved to your computer and may be sorted in as-
cending or descending order by name or date.
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Sending a Text Message

1. Access the Wireless Manager application from the Start menu (Start > All Pro-

grams > Wireless Manager > Wireless Manager) or the desktop shortcut

Click SMS and the SMS Utility will then start.

Click the New Message tab.

4. Enter the phone number in the To field (multiple numbers may be entered separated
by a semicolon (;), or click the phonebook icon i to select a name from the
phonebook.

5. Select any contact’s phone number and click OK (you can click a check box to select
multiple contacts or more than one phone number for each contact).

6. Type the message body in the Message field (to a maximum of 160 characters).

wn

Figure7- 44
SMS Utility - New
Message
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Figure7 - 45
SMS Utility - Inbox &
New Message
Received
Notification

7. Click Send (= send Jto send the message or Save [ [g sawe | to save the message in

the Drafts folder. -

Clicking the Clear icon | & Cea | clears both the Message and To fields.

9. Ifradio is on then the message will be sent, however if the radio is off the message
will be stored in the Outbox.

o

Note that you do not have to connect to the network to Send/Receive SM S mes-
sagesaslong astheradioison.

Inbox

Any received text messages will be displayed in the Inbox. The number of unread
messages will be displayed in parenthesis in the inbox tab. Unread messages will be
displayed in a darker color then the read messages, and incoming messages will be
displayed briefly in the Notification Area.
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Messages
* Opening a text message: Double-click the message and the message will open
in anew window (to closeit click the close icon in the top right of the message).

Figure7 - 46
O4_/_Click to close the message Close Message

* Previewing atext message: Click the preview icon (& and the message preview
will open. Click the icon again to close the preview.

* Replyingto atext message: Double-click the message and click Reply. Type
the reply in the message field and click Send to send the message (or Save to
saveitin Drafts.

» Forwarding a text message: Double-click the message and click Forward.
Type the recipients namein the To field or click the icon i to select recipients
from the phonebook.

» Deleting a text message: Right-click the message select Delete selected. To
delete a messages in the folder right-click any message and select Delete All.
Holding down the Ctrl key and selecting messages allows you to multiple select
messages for deletion (choose Delete selected). Deleted message will be sent to
the Trash folder. To permanently delete messages right-click and select Delete
selected or Delete All (or you may choose to Recover/Recover All) and click
Yes to confirm.

. |
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Phonebook

The Phonebook allows you to view and edit all your frequently used contacts, and
is divided into Contacts f§j and Groups iﬁ To access the Phonebook:

1.

2.
3.

Figure7 - 47
SMS Utility -
Phonebook

(Contacts)

Access the Wireless Manager application from the Start menu (Start > All Pro-
grams > Wireless Manager > Wireless Manager) or the desktop shortcut
Click SMS and the SMS Utility will then start.

Click the Phonebook tab.
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New Contact: Click the New contact button [ & Newcontact.. | to create a contact.
Add the name and at least one phone number (M obile, Work, Home and Other
fields are available) for the contact. Click the &) icon to expand the number
details. Select Synchronize with SIM to synchronize the contact information

with your USIM card. Click the Saveicon [] to save the information.

Edit Contact: Click the edit icon ¢ to make changes to a contact detail, and
click save 5] to confirm the changes.

Delete Contact: Click the deleteicon [l to delete a contact from the phone-
book.
Send a message to a Contact: Click the message icon ] to send atext mes-

sage to any contact.

Modules & Options

4

Import/Export
Contacts

Import/Export Con-
tacts: Click the Import/
EXport |: Import.. | I: Export... |
buttons to import or ex-
port the list of contacts.

Figure7 - 48
SMS Utility
New Contact
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Figure7 - 49
SMS Utility
Groups

7 - 66 3G Module

Groups
Y ou can organize existing contacts into groups from the Groups tab.

« New Group: Click the New group button (& Newgreup..| to create agroup. Click
the (&) icon to expand the group details, and click acheck box to add at least one

phone number from the contacts for the group. Click the Save icon [£] to save
the information.

« Edit Group: Click the edit icon ¢ to make changesto a contact detail, and click
save 5] to confirm the changes, or close g3 to exit without making changes.
+ Delete Group: Click the delete icon [ to delete a group from the phonebook.

» Send amessage to a Group: Click the message icon [ to send a text message
to any group.
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SMS Settings
The SMS Utility Settingstab allows you at adjust the SM S features.

Figure7 - 50
SMS Utility Settings

SMS Settings

Message Length: You can
set the number of blocks
that can be sent (up to a
length of 10 blocks).

Message validity period:
This sets the period after
which the message will be

) ) ) ) deleted from the SMS cen-
The Advanced settings allows more detailed configuration. To access the Ad- || ter and therefore not for-

warded to the recipient(s)

when they come online.

1. Access the Wireless Manager application from the Start menu (Start > All Pro- Display information mes-
grams > Wireless Manager > Wireless Manager) or the desktop shortcut \S/vige?r?ér \t{g“a”‘;‘f,‘\'l‘ i:f';‘:lf’nie

2. Click SMS and the SMS Utility will then start. tion messages to automati-

3. Click the Settings > Advanced. cally appear on screen or

4. Click the tab to edit any particular setting. not.

vanced settings:
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Send

Click Delivery Report to automatically request areply from arecipient. If you click
to Send messagesin Outbox automatically upon connection then messages writ-
ten when theradio is off, will then be sent automatically the next timeradio isturned
on. You can also choose to I nclude original messagein reply.

Notification

Thismenu allows you to enable/disable Show animation on new messageto get an
animated notification of newly received messages. Enabling Play sound on new
message will play an audio notification upon receipt of new messages.

Figure7-51
SMS Utility -
Advanced Settings
Send & Notification

. |
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Number

Y ou can choose to Use default service center number or you can uncheck the box
and add your number manually if your service provider supplies a different number
(click Apply to save the change or Default to return to the default number).

Memory
Phonebook memory status displays the number of contacts displayed on the USIM
card.

Figure7 - 52
SMS Utility -
Advanced Settings
Number & Memory
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3G Module 7 - 69




Modules & Options

N /
2§
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + . key com-
bination to toggle power to
the 3G module, and check
the indicator to see if the
module is powered on or
not (see

/

Sierra Wireless AirCard Watcher

With the 3G module and USIM card (supplied by your service provider) installed
you may then install the Sierra Wireless AirCard Watcher application. AirCard
Watcher allows you to directly access your internet service from the computer.

Sierra Wireless AirCard Watcher Installation

1. Enable power to the module by pressingthe Fn +  key combination or
Control Center button (give the module about 10 seconds to power on).

2. If aFound New Hardware window appears, click Cancel (click Cancel for
all Found New Hardware windows that appear).

3. Insert the Device Drivers & Utilities + User’s Manual disc into your DVD
drive.

4. Click Option Drivers (button).

5. Click 5.Install 3G Driver > Yes.

6. Click Next > Install > Finish > Next > Finish.

7. Thehardware driver installation is now complete so select “ No, | will
restart my computer later” and click Finish (do not restart the computer).

8. Another window will now pop up to install the Air Card Watcher applica
tion.

9. Click Next, click the button to accept the license agreement and click Next.

10. Click Finish.

11. The Air Card Watcher application will now run, or you can click the desk-
top shortcut ~ or run it from the Sierra Wirelessitem in the Start menu.
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AirCard Watcher Application

The connection information is stored on the USIM card supplied by the service pro- a
vider (wherethisis not the case you may need to create aprofile - see” Profiles’ on PIN Number
page 7 - 77).
The PIN number for
1. Power on the 3G module using the Fn + key combination. your USIM card will be
2. Access the AirCard Watcher application from the Start menu (Start > All supplied by your service
Programs > Sierra Wireless > AirCard Watcher) or the desktop shortcut . provider. You usually
3. Ifyou need to set up a network operator (see page 7 - 76). have a limited number of
4. Click the Connect button (a Profile needs to be selected, and in most attempts to enter the
cases this will be pre-configured). correct PIN number.

If you fail to enter the
PIN number correctly
you will be blocked from
accessing the USIM
card and you will need a
PUK (Personal Un-
blocking Key), supplied
by your service provider,
to unlock it.

Figure7 - 53
AirCard Watcher
(Not connected)

3G Module 7 - 71



Modules & Options

5. The system will connect to your network.
/ 6. The iconIEWiII turn greenf (and the upload/download speeds will be indicated).
7. You can theh access the internet, download e-mail etc. as per any internet
AirCard Watcher connection.

Help Topics

To get help on AirCard
Watcher configuration
and settings, click the
Menu icon and select
Help Topics.

Always |

Help Topics

Figure7 - 54
AirCard Watcher
(Connected)
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8. When connected the uplink/downlink speeds will be indicated.

9. You can also click the Speed Graph icon to get a visual display of the uplink/ /
downlink speeds.

10. While connected you can also click the icon I in the notification area of the Roaming
taskbar to display the Windows 7 Mobile Broadband connection status. Notification

AirCard Watcher will
provide notification

when you connect to a
network other than your
service provider. This
can be turned on/off
from User Options >
General > Warning
Messages.

Figure7 - 55
AirCard Watcher
with Speed Graph
(Connected)
&
Taskbar Menu
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11. To disconnect from the service provider, click the Disconnect button
/ . (note that if you click the close [x] icon at the top right of the screen the application
will close however the connection will still be maintained).
Online Help 12. You can also click the icon n in the notification area of the taskbar to display the

connection status, click Connected, and then click the Disconnect button.
. The program will disconnect from the service provider.
14. The module will still be on, and you will need to press the Fn + key combination
to turn it off.

Click the Online Help 13

icon to access the
Sierra Wireless website
for further help if re-
quired.

Figure7 - 56
AirCard Watcher
Disconnect
&
Taskbar Menu
Disconnect
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Air Card Watcher Menu
Right-click the menu [&]| button at the top of the Air Card Watcher screen to bring 4
up the menu, and click to select any item required.

Airplane Mode

Click on the Airplane
Mode icon to turn the ra-
dio power off (e.g. if you
are aboard an aircraft).
You can turn the radio
on again by clicking the
Turn Radio On button.

Figure7 - 57
AirCard Watcher
Menu

. |
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4

Network Operator

If the network operator
is not listed then choose
Generic UTMS.

Figure7 - 58
Options - Firmware
(Network Operator)

Selecting a Network Operator/Service Provider

In most cases all your network operator/service provider details will be stored on
your USIM card, and will not need to be edited/modified. If you do need to set up a
network operator/service provider follow these instructions.

1.

2.

Eal

Access the AirCard Watcher application from the Start menu (Start > All Pro-
grams > Sierra Wireless > AirCard Watcher) or the desktop shortcut

Either click the menu [&] button and select Options, or click the Options button
from the main program window.

Click Firmware.

Click to select a Network Operator from the dropdown menu.

Click OK.
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Profiles

A profile containsinformation used to establish a data connection, and thisinforma-
tionisusually stored on the USIM card supplied by your service provider. However
you can create, edit or delete profilesif required.

Creating a Profile

1. Access the AirCard Watcher application from the Start menu (Start > All Pro-
grams > Sierra Wireless > AirCard Watcher) or the desktop shortcut

2. Make sure you are not connected to a network.

3. Either click the menu [=] button and select Connections, or click the Connections
button - from the main program window.

4. Click Profiles and click the Add new profile button and select Custom.

Figure7-59
Options - Profile

Add new profile
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5.  You will need to complete the fields for Profile name, Username, Password and

/ 3 Access Point Name (you will need to get the username and password details from
your service provider).
Edit or Delete 6. Once you have added the details above you can click the Profiles heading menu
Profiles and click to select the profile from the Selected Profile dropdown menu and then

Select anv existing bro- click OK to set the profile as the default connection.
files to egit or delgetg it 7. Select the profile and click Advanced to set the Autolaunch, TCP/IP and DNS
el Tan ek GI% tc; settings (check with your service provider for any specific requirements in these

confirm any changes fields).
made.

You can also change the
default profile from the
dropdown menu and then
click OK to confirm the
changes.

Figure 7 - 60
Profile - Advanced
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User Options
Y ou can configure User Options as follows.

1. Access the AirCard Watcher application from the Start menu (Start > All Pro-
grams > Sierra Wireless > AirCard Watcher) or the desktop shortcut

2. Either click the menu [E] button and select Options, or click the Options button
from the main program window.

3. Click on any of the menu headings on the left to access the options that may be
configured (note that not all options will be available to be configured as they may
depend on your USIM card settings).

Figure7- 61
User Options
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General - Thisitem allowsyou to set options for Sartup/Shutdown, War ning
M essages, Display and Windows support.

M essaging - Set options here for SM S settings.

Network - Configure the network settings from this menu though your fre-
quency band information is usually stored on the USIM card.

SIM Settings - You can set your SIM Security and PIN # options here.

Sounds - This alows you to set sounds applicable to certain application actions
e.g. when anew SMS arrives.

Profiles - Create, edit, delete and set the default profile from the items here.

Data Useage Tracking - You can enable/disable data tracking e.g. for billing
purposes.

Firmware - If you need to change network operator/service provider you can do
so here.
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Text Messaging Service (SMS)

In addition to standard internet services you may also send and receive SMS text
messages using Air Card Watcher, if your service supports SMS.

SMS Express

1. Access the AirCard Watcher application from the Start menu (Start > All Pro-
grams > Sierra Wireless > AirCard Watcher) or the desktop shortcut

2. Either click the menu [2] button and select SMS Express, or click the SMS
Express button n from the main program window.

Figure7 - 62
SMS Utility Open
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Sending a Text Message
/ 1. Access the AirCard Watcher application from the Start menu (Start > All Pro-
grams > Sierra Wireless > AirCard Watcher) or the desktop shortcut

S MESsEEES 2. Either click the menu |[=/ button and select SMS Express, or click the SMS

Sent messages will be Express button g from the main program window.
automatically saved to 3. Select File > New Message or click the New button in the toolbar.
the Sent Items folder. 4. Type the recipients phone number in the “To:” field (to send to multiple recipients

separate the numbers using a semi-colon or space).
Type the message (160 characters max) in the bottom part of the Message window.
6. Click the Send button or Save the message to send/edit later.

o

Figure7 - 63
Profile - Advanced

Note that you do not have to connect to the network to Send/Receive SM S mes-
sages aslong asthe moduleison.
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Inbox

Any received text messageswill be displayed in the I nbox. The number of total mes-
sages and unread messages will be displayed in the inbox folder title.

M essages

» Opening a text message: Click on any message in the Inbox to read it in the
bottom panel of the window.

* Replyingto atext message: Click on any message in the Inbox and select
Actions > Reply or click the Reply button in the toolbar. Type the reply in the
message field and click Send to send the message (or Save to saveit in Drafts).

» Forwarding atext message: Click on any message in the appropriate folder
and select Actions > Forward or click the Forward button in the toolbar. Enter
the recipient’s phone number in the “To:” field and make any additions/changes
required in the message field and click Send to send the message (or Save to
saveit in Drafts).

» Deleting a text message: Click on any message in the appropriate folder and
select Actions > Delete or click the Delete button in the toolbar. Click Yesto
confirm the deletion.

. |
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N /
2§
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + . key com-
bination to toggle power to
the 3G module, and check
the indicator to see if the
module is powered on or
not (see

/

Mobile Partner

With the 3G module and USIM card (supplied by your service provider) installed
you may then install the M obile Partner application to directly access your HSPA
internet service from the computer.

Mobile Partner Application Installation

1. Enable power to the module by pressingthe Fn +  key combination or
Control Center button (give the module about 10 seconds to power on).

2. If aFound New Hardware window appears, click Cancel (click Cancel for

al Found New Hardware windows that appear).

Insert the Device Drivers & Utilities + User’'s Manual disc into your DVD

drive.

Click Option Drivers (button).

Click 5.Install 3G Driver > Yes.

Click Next > Install > Finish > Next.

Click I Agree (button) to accept the license agreement.

Click Install > Finish.

Choose the language you prefer and click OK, and then click Next.

10. Click I Agree (button) to accept the license agreement.

11. Click Next > Install > Finish.

12. Click Finish to restart the computer.

13. Accessthe Mobile Partner application from the Sart menu (Sart > Pro-
gramg/All Programs> M obile Partner), or by double-clicking the M obile
Partner icon on the desktop.

w
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Mobile Partner Application

Y ou will need to contact your service provider to obtain the exact details of how ex- a

actly to configure the settings on this page. Mobile Partner Help

Profile Management To get help on Mobile
1. Power on the 3G module using the Fn +  key combination. Partner  configuration
2. Access the Mobile Partner application from the Start menu (Start > Programs/ and settings, click the
All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon Help menu and select
on the desktop Online Help or press
3. If you have not created a profile, click Tools and select Options, and then click Fl.
Profile Management.
4. Click New and input the appropriate information for Profile Name, APN
and Authentication etc. as supplied by your service provider.
5. Click Save to save the profile.
Figure7 - 64

Profile Management
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Connecting to the Service Provider

1. Power on the 3G module using the Fn + key combination.

2. Access the Mobile Partner application from the Start menu (Start > Programs/
All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon
on the desktop

3. The software will run and you can select the Profile Name from the menu.

4. Click Connect to begin the connection process.
Figure7 - 65
Connect
5. The Mobile Partner application will then display the connection information.
Figure7 - 66
Network

Connection Prompt

. |
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6. While connected you can also click the icon [EM in the notification area of the
taskbar to display the Windows 7 Mobile Broadband connection status.

Figure7 - 67
Connected
Taskbar
Notification Area
Notification

7. You can then access the internet, download e-mail etc. as per any internet
connection.
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8. While you are connected the indicators in the Mobile Partner window will display
uploading and downloading icons.

9. To disconnect click the Disconnect icon, or right click the notification

areaicon and select Disconnect (you can also select the connection in the Mobile
Broadband connection status window, and click Disconnect).

Figure7 - 68

Di nn
sconnect © O

10. The program will disconnect from the service provider.

11. The module will still be on, and you will need to press the Fn + key combination
to turn it off.
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12. If you click the Mobile Partner close icon a message will be displayed asking
you to click OK to confirm the program exit and to terminate the connection.

Figure7 - 69
Exit Prompt

13. Exiting the program terminates the connection, but DOES NOT turn off the 3G
module, and you will need to press the Fn + key combination to turn off the
module (pay careful attention to this aboard aircraft - see “Wireless Device
Operation Aboard Aircraft” on page 7 - 84).

14. If the module is on and the computer enters a power-saving state, then the power
status of the module on resuming from the power-saving state will be as below:

 |If the 3G moduleis on and the computer is Shut Down or Restarted; the mod-
ule will be off when the computer starts up.

 If the 3G module is on and the computer enters Sleep or Hiber nate; the module
will be off when the computer resumes from sleep.

. |
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Text Messaging Service

In addition to standard internet services you may also send and receive SMS text
messages using the M obile Partner program, if your service supports SMS.

Reading SMS Messages

1.

2.
3.

4.

An icon [=£] will blink at the bottom of the Mobile Partner interface to notify you of
any new messages received.

Click the Text icon  in the Mobile Partner Interface.

Select the Local > Inbox or SIM/USIM Card folder and select any message to
read it.

Right-click the message and choose an option to reply, forward or delete the
message.

Creating and Sending SMS Messages

Click the Text icon  in the Mobile Partner Interface.

Click the New button [=].

Enter the recipient’s number in the Send To... field or click the Send To... button to
select an entry from the phone book, and click OK.

Type in the message details.

Click the Send button, Save button to send the message later or Close > Yes to
save in the Draft folder.

For more details on SMS click the Help menu and select Online Help or press F1
and select SM S.
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Trusted Platform Module

The TPM security chip allowsyou to create and manage digital certificatesfor user
and platform authentication. This type of security is usually administered within
large enterprises and organizations, and therefore requires implementation by asys-
tem administrator before users can access security features.

Individual users can use the TPM as an authentication with the fingerprint reader.

Make sure you have administrator’ s rights to your computer, and have a Windows
password enabled for full security protection. In addition Make sure you prepare
aremovablemedia (e.g. a USB flash drive) to stor e passwor dsetc. befor e begin-
ning the TPM initialization process.

Before setting up the TPM functions you must initialize the security platform.
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Enabling & Activating TPM

Restart the computer.

Enter the Aptio Setup Utility pressing F2 during the POST/startup.

Use the arrow keys to select the Security menu.

Select Trusted Configuration and press Enter to access the sub-menu.

Press Enter to access the TPM Support menu and select Enable to display the full
TPM configuration menu.

Select TPM State, press Enter and select Enable to change the TPM state to
enabled. You will then need to press F4 to save the changes and restart the
computer.

agprwnE

o

Aptio Setup Utility — Copyright (C) 2012 American Megatrend

TPM SUPBORT

Figure7-70
TPM State
(Enabled)

7. As the computer restarts press F2 to enter the BIOS again and go to the TPM
Configuration menu.

. |
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8. Select Pending TPM operation, press Enter and select the option you require (if
you are initializing TPM you should select Enable Take Ownership). You will then
need to press F4 to save the changes and restart the computer.

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

Pending TPM cperation [Hone] .
Figure 7-71
Pending TPM
operation
Pending TPM operation (Enable Take
::::Ele Take Ownership OwnerShip)

Disable Take Ownership
TPM Clear

9. You can now install the TPM driver (see “ Trusted Platform Module (TPM) Driver
Installation” on page 7 - 94) and then initialize the TPM.
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Figure7- 72
TPM Confirmation
Message

(if the driver is installed
without TPM being en-
abled and activated in the
BIOS)

Trusted Platform Module (TPM) Driver Installation

1.

N

00N U~ W

Make sure you have enabled and activated the TPM in the BIOS before
installing the driver (if you do not do see the note below).

Insert the Device Drivers & Utilities + User’s Manual disc into the DVD
drive.

Click Option Drivers (button).

Click 6.Install TPM Driver > Yes.

Click Install > Next.

Click the button to accept the license and click Next.

Click Next > Next > Install.

Click Finish > Yesto restart the computer.

If you haveinstalled the driver without enabling and activating the TPM first, acon-
firmation message will appear on restart.

A configuration change was regquested to enable, activate, and allow the creation of
an operator authentication walue that permits temporary deactivation of the TPFM

Press [F10] to enable, activate, and allow the creation of an operator authentication
value that permits temporary deactivation of the TPM
Press ESC to reject this change reguest and continue

Press F10 to enable and activate the TPM and you can then configure as overleaf.
However it is recommended that you enter the BIOS and take ownership (see page
7-92) of the TPM before configuration in Windows. Alternatively press Esc to con-
tinue without making changes the TPM.
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Initializing TPM
1. Run the application from the Infineon Security Platform Solution > Manage
Security Platform item in the Start > Programs menu.
2. Click User Settings (tab) and click Yes, or right-click the icon EE in the notification
area of the taskbar, and select Security Platform Initialization (or click the
Security Platform State taskbar bubble).
3. The Quick Initialization method will automatically be selected for you (if you need
to use advanced settings provided by your network administrator then select
Advanced Initialization).
4. You will need to use a removable media (e.g. a USB Flash Drive) to store passwords
and data (keep the media in a safe place until required).
5. Select the drive you want to use from the drop-down menu and click Next. .
7

Figure7-73
Security Platform
Quick Initialization

Wizard
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6. Choose the Security Platform Features you want to use by clicking the appropriate

/ A tickbox.

7. Enter a Basic User Password (and re-type to confirm it) and click Next.

Help

Right-click the icon in
the notification area of the
taskbar to bring up the menu
to select Help or How to use
the Security Platform Fea-
tures.

You can also click the Help
button in any of the Infineon
Security Platform Settings
Tool tabs to bring up specific

help topics on each tab. 8. Click Next to confirm the settings.
9. The computer will then initialize the settings.
10. Click Finish.
Figure 7 - 74 11. Click the tabs and control panels to adjust the settings.

12. Double-click the icon in the taskbar notification area to access the Infineon

Settings ; . . ) . .
g Security Platform Settings Tool, or right-click the icon and select a menu item.
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Infineon Security Platform Settings Tool
The Infineon Security Platform Settings Tool allows you to manage and check the 2
TPM state, manage your password information, and to backup and restore the TPM Menus
data. As TPM is usualy administered within large enterprises and organizations,
.. . . . . - - Note that not all the
your system administrator will need to assist you in managing the information here. | = S e

be available for access.
The menu items that ap-
pear will be dependent on
your configuration set-
tings etc. (see the Help
file for full details).

Figure7-75
Infineon Security
Platform Settings

Tool

. |
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User Settings

This page allows the settings to be configured for the currently logged in Infineon
Security Platform user including the ability to change the password, configure se-
cure e-mail, file and folder encryption and Enhanced Authentication. Y ou can also
import or delete certificates protected by the security platform.

Figure7- 76
Infineon Security
Platform Settings

Tool (User Settings)
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Backup

Here you can configure backup and restore operations. Backup files contain the
computer identification and user identification information which is used to match
the machine name and user name with the current machine and user during restora-

tion.

Figure7- 77
Infineon Security

Platform Settings
Tool (Backup)

. |
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Migration
The Migration tab is used to help securely transfer keys and certificates from one
platform to another.

Figure7- 78
Infineon Security

Platform Settings
Tool (Migration)
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Password Reset
Use Password Reset to reset basic user passwords when required.

Figure7-79
Infineon Security

Platform Settings
Tool 7
(Password Reset)
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BitLocker

BitLocker Drive Encryption can be used in conjunction with the TPM to encrypt
data on the disk and is done via the Microsoft BitL ocker Control Panel Applet.
Click Configure and select a drive to be encrypted and then follow the Wizard to
begin the encryption process.

Figure7 - 80
Infineon Security

Platform Settings
7 Tool
(BitLocker)
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Access the Microsoft BitLocker Drive Encryption control panel applet from the
Windows control panel (System and Security).

Figure7- 81
BitLocker Drive

Encryption
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Advanced
Configure all the Security Platform owner and policy settings from the Advanced
tab. The settings that can be changed are for the local computer only.

Figure7 - 82
Infineon Security

Platform Settings
7 Tool
(Advanced)
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Intel Rapid Storage Technology

Install the Intel Rapid Storage Technology to support your SATA driveif set up in
AHCI mode in the BIOS (see “SATA Mode Selection (Advanced Menu)” on

page5 - 9).

IRST Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD
drive.

Click Option Drivers (button).

Click 7.Install IRST Driver > Yes.

Click Next > Yes > Next > Next.

Click Finish to restart the computer (you will need to restart the system
again after the computer has rebooted).

gagrwn
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Intel® Smart Connect Technology

ntel® Smart Connect Intel® Smart Co_nnect Technology_ periodi(_:ally, and bri_efly, vyakgs the computer
e mslogy Syeien from Sleep mode in order to update information for certain applications (e.g. to get
Requirements mail from Microsoft Outlook) as required. These updates can therefore be made
T M e T without having to turn the computer on, and applications will be up to date when the
St M) G (Son computer resum'esfrom Sleep mode (make sure that I ntel Smart Connect Technol-
nect Technology your ogy is enabled in the BIOS - see “Intel Smart Connect Technology (Advanced

system will need to have © Menu)” on page5 - 8).
the item enabled in the
BIOS (see page 5 - 8).

Z

Notethat the applicationsneed to be on and running when the computer enters

In addition only the follow- || Sleep modein order to get updates.
ing WLAN modules sup-

port this feature: Intel® Smart Connect Technology Driver Installation
Intel® Centrino® Wire-

less-N 2230 1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD
Intel® Centrino® Wire- drive.

less-N 135 Click Option Drivers (button).

Click 8.Install ISCT Driver > Yes.

Click Next.

Click the button to accept the license agreement and click Next.

Click Next > Install > Finish.

Click Yesto restart the computer.

N arwWN
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Intel® Smart Connect Technology Configuration

\ A/
1. Access the Intel(R) Smart Connect Technology application from the Start menu. 7&‘
2. Click Basic (tab) and adjust the slider to set the update frequency (note that the Wireless Device
slider balances between “More Frequent Updates” and “More Battery Life"). Operation Aboard
3. Note the sidebar warning about the use of Intel(R) Smart Connect Technology Aircraft
aboard aircraft and make sure your wireless LAN module is off during air travel.
4. In order to update any applications, they will need to be on and running when the The use of any portable

electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if

computer enters Sleep mode.

you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the LED indicator to
see if the module is pow-
ered on or not (see

/

).

Figure7 - 83
iSCT Basic
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o

Click Advanced (tab) to access the Extended Power Savings settings.

6. Extended Power Savings allows you to set a time period during which the
computer will update less often (e.g. at night while you are asleep or whenever you
are at work).

Figure7- 84
iSCT Advanced

7. Updates set during this time period will be performed every two hours, and this will
override the settings selected in the Basic tab in order to conserve power
consumption.

.|
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8. Click the Help tab and click Topics to access the main Help menu.

4

Intel WLAN Modules

If your purchase option
includes an Intel WLAN
module, (with Intel's
PROSet Wireless Con-
nection  Utility in-
© stalled), Intel® Smart
Connect Technology
will search for WiFi net-
works around you that

you have previously ac-
cessed.

If no known WiFi net-
works are found, your
computer will not update
again until it recognizes
a known WiFi network.

Figure7 - 85
iSCT Help
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Troubleshooting

Chapter 8: Troubleshooting

Overview

Should you have any problemswith your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’'t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautionsin the preface.
If al elsefails, talk to your service representative. Y ou should also make a record of what happened and what
remedies you tried.

Of course, if something goeswrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you' ve tried everything, and the system still won't cooperate, try turning it off
for afew minutes and then rebooting. Y ou will lose any unsaved data, but it may start working again. Then call
your service representative.

. |
Overview 8 - 1



Troubleshooting

Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working.

Power - Isthe computer actually plugged into aworking electrical outlet? If plugged into apower strip,
make sureit is actually working. Check the LED Power & Communication Indicators (see” LED Indica-
tors’ on page 1 - 11) to see the computer’s power status.

Connections - Check al the cables to make sure that there are no loose connections anywhere.

Power Savings - Make sure that the system is not in Hiber nate or Sleep mode by pressing the keys config-
ured in your Power Options (see “ Power-Saving States” on page 3 - 6), the Fn + F4 key combination, or
power button to wake-up the system.

Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
Ness.

Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive
(thisis acommon cause of the message “I nvalid system disk - Replace the disk, and then press any key” /
“Remove disks or other media. Press any key to restart”).

8 - 2 Basic Hints and Tips



Troubleshooting

Backup and General Maintenance

» Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don't forget to note the serial numbersif you are storing them out of their original cases, e.g. inaCD wal-
let.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.

» Write down your passwords and keep them safe (away from your computer). Thisis especially important if
you choose to use a Super visor password for the BIOS (see “ The Setup Utility” on page5 - 2).

» Keep copiesof vital settingsfiles such as network, dialup settings, mail settings etc.(even if just brief notes).

N2
2

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
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Viruses

Install an Anti-Virus program and keep the definitionsfile (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tionsfile updates are usually downloadable directly from the internet.

Be careful when opening e-mail from sources you don’'t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

Keep a“Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS's documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such adisk (or at
least instructions on how to make one).
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Upgrading and Adding New Hardware/Software

* Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.

» Don’'t open your computer or undertake any repair or upgrade work if you are not comfortable with what
you are doing.

» Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

* When installing a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.

» Make sureyou haveinstalled the driversfor any new hardware you have installed (latest driver filesare
usually available to download from vendor’s websites).

.|
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» Thoroughly check any recent changes you made to your system as these changes may affect one or more
system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.

» Don't over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of aproblem. Try disconnecting all of the devices and
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and

removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power but it doesn't | Battery missing / incorrectly installed. Check the battery bay, make sure the
work. battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator , is | Low Battery. Plug in the DC power source. If the computer doesn’t start up
blinking orange. immediately, turn it off then on again.

You are losing battery power too quickly. | The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 4) check its settings. You may also be using a
USB device/external device that is drawing a lot of power.

Actual battery operating time is shorter | The battery has not been fully discharged before being recharged. Make sure
than expected. the battery is fully discharged and recharge it completely before reusing (see
“Battery Information” on page 3 - 11).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/lUSB device is consuming a lot of power. Turn off/fremove
the unused device to save power.

. |
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Problem Possible Cause - Solution

The computer feels too hot. Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn't sitting on a thermal surface (see
“Overheating” on page 1 - 24). Make sure you're using the correct adapter.

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen. The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F4 (see “Configuring the Power Buttons” on page 3 - 8).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you're connected to an external monitor, make sure
it's plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the Touchpad.

No image appears on the external | You haven't installed the video driver and configured it appropriately from the
monitor | have plugged in and powered | Control Panel. See Appendix C for instructions on installing and configuring
on. the video driver.

. |
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Problem

Possible Cause - Solution

You forget the boot password.

If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

AN
Ik

Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows taskbar, or use the key combination Fn + F5 and
F6 (see “Function/Hot Key Indicators” on page 1 - 15) to adjust.

The CD/DVD cannot be read.

The CD/DVD is dirty. Clean it with a CD/DVD cleaner kit.

The CD/DVD tray will not open when
there is a disc in the tray.

The CD/DVD is not correctly placed in the tray. Gently try to remove the disc
using the eject hole (see “Loading Discs” on page 2 - 3).

The DVD regional codes can no longer
be changed.

The code has been changed the maximum 5 times. See “DVD Regional
Codes” on page 2 - 5.

Unwelcome numbers when

typing.

appear

If the LED El is lit, then Num Lock is turned ON. (see “LED Indicators” on
page 1 - 11).
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Problem Possible Cause - Solution

4

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not
work.

The system freezes or the screen goes | The system’s power saving features have timed-out. Use the AC/DC adapter,

dark. press the sleep (Fn + F4) key combination, or press the power button if no LEDs
are lit.

The system never goes into a power | Power Options features are not enabled. Go to the Windows Power Options

saving mode. menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 6). Make sure you have enabled Hibernate mode from the control
panel.

The Wireless LAN or Bluetooth modules | The modules are off. Check the LED indicator and/or function key indicator to
cannot be detected. see if the WLAN/Bluetooth module is on or off (see “LED Indicators” on
page 1 - 11). If the LED indicator is off, then press the Fn + F11 (WLAN) or Fn +
F12 (Bluetooth) key combination(s) in order to enable the modules (see
Table 1 -5, on page 1 - 15).
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Problem

Possible Cause - Solution

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function/Hot Key Indicators” on page 1 - 15). Run the camera
application to view the camera picture.

The PC Camera module does not display
the LED light when the camera is in use.

You are using a 300K or 1.3M camera in the Windows 8 OS. The Windows 8
OS does not support 300K or 1.3M cameras, and therefore the LED light will not
display.

The Wireless LAN/Bluetooth/ PC
Camera modules cannot be configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Modules & Options” on page 7 - 1).

A file cannot be copied to/from a

connected Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the device to your computer until
the file transfer process from the computer has been completed.

The Bluetooth module is off after

resuming from Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep
power-saving state. Use the key combination (Fn + F12) to power on the
Bluetooth module after the computer resumes from Sleep.

| am sliding my finger up and down on the
right side of the Touchpad to scroll a
Window and the Touchpad does not
respond.

There are different Touchpad versions available on this computer, and this
version requires tapping/holding to scroll. Either tap repeatedly, or hold the
finger down, at the top or bottom right of the Touchpad (depending on the
scrolling direction required) to scroll the window.

Problems and Possible Solutions 8 - 11




Troubleshooting

Bluetooth Connection Problems

If you are experiencing problems connecting to some Bluetooth devices (in particular certain mobile phones and
headsets) it maybe necessary to download and install the Windows Mobile Device Center software (for Win-
dows Vista and Windows 7). Go to the Microsoft website and search for the Micr osoft Windows Device Center
Driver for Windows Vista (64-bit or 32-bit) and Windows 7 (64-bit or 32-bit), and then download the driver.

Install the Microsoft Windows Device Center Driver as appropriate for your operating system.

Windows Vista will automatically configure the driver for you, however Windows 7 requires further configuration.
Make sure the Bluetooth device is powered on.

Go the Windows 7 control panel and double-click Device Manager (Hardware and Sound > Devices and
Printers).

Bluetooth Peripheral Device(s) will be listed under Other Devices (note this will only be listed if you have
connected, or tried to connect to, a Bluetooth device previously).

PwDNPE

o

2¥ MNetwork adapters /
'3 Atheros ARS007EG Wireless Network Adapter
l&-"‘ Bluetooth Device (Personal Area Network)
5;-“ Bluetooth Device (RFCOMM Protocol TDI)

A

Bluetooth Peripheral Devices

l;‘ Marvell Yukon 88E8040 PCI-E Fast Ethernet Contreller You will need to repeat the procedure
4-llp Other devices : listed here for all Bluetooth Peripher-
i 4|7 Bluetooth Peripheral Device q A q

W PCIFLASH Memory .a| DeV|.ces listed under Other Devices
o) Processors i.e. until there are no more Bluetooth
>~ Sound, video and game controllers Peripheral Devices listed under this
P - Storage controllers menu heading_

ol Suertarn Asicar

Figure 8 - 1 - Device Manager

. |
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6. Right-click Bluetooth Peripheral Device and click on Update Driver Software.

7. Click Browse my computer for driver software.
8. Click Let Me pick from a list of device drivers on my computer.

Figure 8 - 2 - Browse my computer.../Let me pick from...

9. Select Bluetooth Radios from the list.

>

Figure 8 - 3 - Select Bluetooth Radios
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10. A list of drivers will appear with Manufacturer on one side and Model in the other.
11. Choose Microsoft Corporation (make sure you choose the full name Microsoft Corporation and do not

choose Microsoft - Note that you must have installed the Microsoft Windows Device Center Driver for
Microsoft Corporation to appear in the list).

12. Select Windows Mobile-based device support from the Model list.

@ | Update Driver Software - Bluetooth Peripheral Device

Select the device driver you want to install for this hardware.

Select the manufacturer and model of your hardware device and then click Mext. If you have a
disk that centains the driver you want to install, click Have Disk.

Manufacturer “ || Model
Wwice support

Make sure you select

Microsoft Corporation

| This driver is digitally signed.

Tell me why driver signing is important
Ciiet ] cona

Figure 8 - 4 - Select Device Driver

13. Click Next > Yes and the driver will install.
14. Click Close to complete the installation.
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15. The Device Manager should now display the Windows Mobile-based device support under Bluetooth

Radios.
16. You will need to repeat the process for any other Bluetooth Peripheral Devices listed under Other Devices.

>

Figure 8 - 5 - Device Manager - Bluetooth Radio

. |
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Resolving the “Insert a SIM” issue with the 3G Module (Windows 8)

1. IfaPIN was set for the EM820W 3G module, you have then switched Mobile broadband off (or put the system

in Airplane Mode) under Wireless in PC Settings, and the system has just resumed from a power-saving state
the following error may occur.

PC SettlﬂgS Airplane mode

Turn this on to stop wireless communication

Search off |

Share Wireless devices

Genefal Mobile broadband \
off [ |

Privacy
Off

Devices

Mobile broadband hardware

Huawei Technologies

Ease of Access

Figure 8 - 6 - PC Settings (Charms Bar) - Wireless (Mobile Broadband Off)

2. Onresuming from the power-saving state the standard procedure would be to go to PC Settings in the Charms
Bar and turn on Mobile broadband under Wireless > Wireless Devices.
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Go to the Charms Bar.

Select Settings and you will then note that the WiFi icon will read Unavailable.
Standard procedure would be to click the connection and enter the PIN number to unlock the connection.
In this instance you will note that the Mobile broadband connection will read Insert a SIM.

o0k w

(© Networks

Airplane mode

off N

Mobile broadband

Insert a SIM

Figure 8 - 7 - Mobile Broadband (Insert a SIM)
7. In this case you will need to restart the computer.
8. After system restart you can then connect to the Mobile Broadband as normal.
9. To fully resolve this issue it is recommended that you do not Enable a PIN for the EM820W 3G module.
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Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give aquick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.
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Notebook Ports and Jacks

Item

Description

Card Reader Port

The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

DC-In Jack

Plug the supplied AC/DC adapter into this jack to power your computer.

External Monitor (VGA)
Port

This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or
simultaneous display on the LCD and external monitor/FPD.

HDMI-Out Port

The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or
Flat Panel Display etc. as a display device by means of a HDMI cable. Note that HDMI carries
both audio and video signals.

Headphone-Out Jack

Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.
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Item Description
Microphone-In Jack Plug an external microphone in to this jack to record on your computer.
RJ-45 LAN Jack This port supports LAN (Network) functions.

Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

USB 2.0/1.1 Ports These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into
USB 3.0 Port the computer, and unplugged from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure you use the power supply which
comes with the device).

The USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black. USB
3.0 will transfer data much faster than USB 2.0, and is backwards-compatible with USB 2.0.

Note that the USB 3.0 ports require a driver installation (see “USB 3.0 (Win 7 Only)” on page 4
- 7) for Windows 7 (Windows 8 does not require a driver) and do not support wake on USB.
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Appendix B: Control Center

Overview

Thefollowing chapter will give aquick description of the functions of the Control Center. The Control Center
givesquick accessto frequently used controls, power management features and enables you to quickly turn mod-
ules on/off. Click the Control Center iconsto toggle the appropriate function, or hold the mouse button down
and move the slider where applicable. Certain functions will automatically be adjusted when a power mode is
selected. The Control Center in Windows 8 works under the Desktop app (see “ Function/Hot Key I ndicators

& Control Center” on page E - 15) and not under the Start screen, and does not feature the wirel ess/Bluetooth
buttons and Airplane Mode etc.

Figure B - 1 - Control Center
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Power Modes
Y ou can set a Power M ode by clicking the appropriate icon at the top of the Control Center. Each power
mode will affect the power status of modules (e.g. WLAN, Bluetooth, 3G or Camera), screen brightness,

TouchPad power and Silent Mode.

You can click aControl Center icon to set an overall power mode and then click individual iconsin the
Control Center to power on/off any modules etc.

Thetableoverleaf illustrates the basic settingsfor each power mode. If you choose user defined the settings
will correspond to your selected system settings.

. |
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. Flight . . User
Modes Power Saving g Entertainment Quiet Performance .
(Win 7 Only) Defined
Icon ” '
*
Power Plan Power Saver Balanced Power Saving Power Saving High Performance
Power Conservation Mode Energy Star BIOS Default Energy Star Energy Star Performance
Brightness 14 42 100 42 100
WLAN
(Win 7 Only) OFF OFF ON ON ON c
o]
Bluetooth g
(Win 7 Only) BIOS Default .
(0]
(=8
3¢ OFF OFF OFF OFF OFF
(Win 7 Only)
PC Camera OFF OFF OFF ON ON
TouchPad ON ON OFF ON ON

Table B - 1- Power Modes

. |
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Power Status

The Power Status icon wiil show whether you are currently powered by the battery, or by the AC/DC adapter
plugged in to aworking power outlet. The power status bar will show the current battery charge state.

Brightness

The Brightness icon will show the current screen brightness level. You can use the slider to adjust the screen
brightness or the Fn + F8/F9 key combinations, or use the Fn+ F2 key combination to turn off the LED backlight
(press any key to turn it on again). Note that screen brightness is also effected by the Power M ode selected (see
TableB - 1, on page B - 3).

Volume
The Volume icon will show the current volume level. Y ou can use the slider to adjust the Volume or the Fn +
F5/F6 key combinations, or use the Fn+ F3 key combination to mute the volume.

Power Conservation

This system supports Ener gy Star power management features that place computers (CPU, hard drive, etc.) into
alow-power sleep modes after a designated period of inactivity (see“ Power Conservation Modes’ on page 3 -
10). Click either the Perfor mance, Balanced or Energy Star button.
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Sleep
Click the Sleep button to bring up the Hiber nate or Sleep buttons, and click either button to have the
computer enter the appropriate power-saving mode (see “ Power-Saving States” on page 3 - 6).

Display Switch
Click the Display Switch button to access the menu (or use the & + P key combination) and select the appro-
priate attached display mode (see page C - 10).

Time Zone
Clicking the Time Zone button will access the Date and Time Windows control panel.

Desktop Background
Clicking the Desktop Background button will alow you to change the desktop background picture.

TouchPad/PC Camera/Wireless LAN Module /Bluetooth/3G Module

Click any of these buttonsto toggle the TouchPad or modul €’ s power status. A crossed out icon will appear over
the top left of theicon when it is off. Note that the power status of a module, and TouchPad power, is also
effected by the Power Mode selected (see Table B - 1, on page B - 3). The WLAN, Bluetooth and 3G buttons
are not featured in the Windows 8 system.
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Silent Mode

Click the Silent M ode button toggles silent mode on/off. Y ou can use Silent M ode to reduce power consump-
tion and fan noise. Note that the Silent M ode effected by the Power M ode selected.

o Silent Mode is OFF

. Silent Mode is On

Note Silent M ode may reduce computer performance.

Caps Lock/Scroll Lock/ Number Lock 8 & &
Click the button to toggle the appropriate lock mode.
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Appendix C: Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features’ on
page 1 - 26.

Video Driver Installation

Make sureyou install the driversin the order indicated in Table 4 - 1, on page 4 - 3.

1. Insertthe Device Drivers & Utilities+ User’s Manual disc and click I nstall
Drivers (button).

2. Click 2.Install VGA Driver > Yes.

3. Click Next > Yes> Next > Next.

4. Click Finish to restart the computer.

Note: After installing the video driver go to the Display control panel to adjust the
video settings to the highest resolution.

Dynamic Video Memory Technology

Intel® DVMT automatically and dynamically alocates as much (up to 1748MB)
system memory (RAM) as needed to the integrated video system (the video driver
must beinstalled). DVMT returns whatever memory is no longer needed to the op-
erating system.

. |
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Video Card Options

Note that card types,
specifications and driv-
ers are subject to contin-
ual updates and
changes. Check with
your service center for
the latest details on vid-
eo cards supported.

DVMT Notes

DVMT is not local video
memory.

DVMT will not function
in MS-DOS. DOS uses
the legacy memory indi-
cated.
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4

Application Mode

Note that all figures pic-
tured, and instructions
outlined here are based
on the Advanced Ap-
plication Mode.

FigureC-1
Intel® G&M
Control Panel

Intel® Graphics & Media Control Panel

Advanced video configuration options are provided by the Intel® Graphics and
Media Control Panel. To access the control panel:

1. Click Advanced settings in the Screen Resolution control panel in Windows.
2. Click the Intel(R)... tab and click Graphics Properties (button).

OR
3. Right-click the desktop and select Graphics Properties from the menu.

OR

4. Double-click the Intel(R) G&M control panel in Windows.

5. Choose the application mode (Basic, Advanced or Wizard) required (see
sidebar).

>
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Y ou may make changes to any of the graphics properties by clicking the appropriate
menu tab on the left of the menu and adjusting the settings on the right. Z

Options & Support

Click Options & Sup-
port and select an item
from the sub-menu to
bring up the help and
support topics.

You will need to be con-
nected to the Internet to
access the key resource
links.

Multiple Display

At least one other dis-
play must be attached in
order to view multiple
display selection op-
tions.

FigureC- 2 a
Intel® G&M

Control Panel Tabs

Intel® Graphics & Media Control Panel C - 3
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4

Function Key
Combination

You can use the Fn + F7

key combination to tog-

gle through the display

options:

* Notebook Only

e External Display Only

* Notebook + External
Display

Make sure you give the

displays enough time to
refresh.

Note that HDMI sup-
ports video and audio
signals.

TableC-1
Display Modes

Display Devices & Options

Besidesthe built-in LCD you can also use an external monitor/flat panel display/TV
connected to the external monitor port or to the HDMI-Out port (High-Definition
Multimedia Interface) as your display device. The table below outlines the display
options.

Y
Attaching Displays

When you first attach an external display you may find that the desktop does not occupy
the full screen area. Use either the display’s auto adjust/configure controls, or the Intel(R)
G&M control panel to configure the full screen display.

Intel Display Mode Description

One of the connected displays is used as the display

Single Display device

Both connected displays output the same view and may

Clone Displays be configured independently

Both connected displays are treated as separate

Extended Desktop devices, and act as a virtual desktop
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Attaching Other Displays

4
If you prefer to use amonitor or flat panel display, connect it to the external monitor N
port or HDMI-Out port on the left of the computer. IR IR ]

At least one other dis-

To Clone Displays: play must be attached in

1. Attach your display to the external monitor port or HDMI-Out port, and turn it on. order to view Multiple
2. Gotothe Intel(R) G&M control panel and click Display > Multiple Displays. Display selection op-
3. Click Operating Mode and select Clone Displays from the menu. tions.

4. Click Apply, and OK to confirm the settings change.

5. You can switch the Primary/Secondary Display from the menu. General Settings

Click General Settings
to access settings the
options for any attached
display.

FigureC- 3
Display > Multiple

Displays (Clone) a
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To Enable Extended Desktop:
4 1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.

: . 2. Gotothe Intel(R) G&M control panel and click Display > Multiple Displays.
Display Settings ; )
Extended Desktop 3. Click Operating Mode and select Extended Desktop from the menu.
4. Click Apply, and OK to confirm the settings change.

You can have different ] ) ]
Colors, Screen Area Click the appropriate monitor
and  Monitor Refresh icon and drag it to match the
Reize i et clgpey physical arrangement you
device provided your ish h d
monitor can support Wi .'[O use (e.g. the second-
them. ary display may be extended

_ left/right/above/below  the
You can drag the moni- . disol
tor icons to match the primary disp ay)
physical layout of your
displays. Icons and pro- Click Genera Settings to
grams may also be make any adjustments re-
dragged between the :

: quired.

displays.

FigureC-4
Display > Multiple

Displays (Extended)

C - 6 Attaching Other Displays
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Display Profiles
Y ou can save display settings to be loaded at any time.

1.
2.

Go to the Intel(R) G&M control panel and click Display.

Configure the General Settings, Multiple Displays, Color Enhancement, Custom
Resolution & Monitor/TV Settings to your preferences.

Click Apply, and OK to confirm the settings change.

Click the Save button at the top of the General Settings, Multiple Displays or Color
Enhancement menus (under Display Profiles).

Type a name for the Profile and click OK.

The Profile will be listed under Display Profiles.

Select the profile from the pull-down menu and click Apply, and OK to confirm the
settings change.

FigureC-5
Intel® G&M
Profiles

Attaching Other Displays C - 7
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Function Key
Combination

You can use the Fn +

F7 key combination to

toggle through the dis-

play options:

* Notebook Only

» External Display
Only

* Notebook + External
Display

Make sure you give the

displays enough time

to refresh.

Note that HDMI sup-
ports video and audio
signals.

FigureC-6
Screen Resolution
Multiple Displays

(Win 7)

Video Driver Controls

Configuring an External Display in Windows 7

Y ou can also use the Screen Resolution control panel in Windows 7 to configure an

external display.

1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.

2. Go to the Screen resolution control panel (see “Video Features” on page 1 -
26).

3. Click the Detect button.

4. The computer will then detect any attached displays.

C - 8 Configuring an External Display in Windows 7
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5. You can configure the displays from the Multiple Displays menu.

FigureC-7
Screen Resolution
Multiple Display

Options
(Win 7)
» Duplicate these displays - Shows an exact copy of the main display desktop on
the other display(s)
» Extend these displays - Treats both connected displays as separ ate devices a

» Show desktop only on 1/2 - Only one of your displaysis used.

.|
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Using the Windows Logo Key g + P Key Combination to Switch Displays

You can also usethe g + P key combination to quickly change display configura-
tion and modes (thisis particularly useful when attaching a projector) in Windows 7.

Attach your display to the external monitor port or HDMI-Out port, and turn it on.
Press the g + P key combination.

An on-screen menu will pop up.

Use the cursor keys (or & + P) to select the appropriate configuration from the
menu, and press Enter to confirm the selection.

PR

FigureC- 8
sz + P Display
Configuration
Selection
(Win 7)
Y ou can also use the Display Switch button inthe Control Center to accessthe
menu and select the appropriate attached display mode.

.|
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HDMI Audio Configuration

HDMI (High-Definition Multimedia I nterface) carries both audio and video signals.
In some cases it will be necessary to go to the Sound control panel and manually
configure the HDMI audio output as per the instructions below.

1.
2.
3.

Click Start, and click Control Panel (or point to Settings and click Control Panel).
Click Sound  (Hardware and Sound) and click Playback (tab)

Depending on your display, the playback device may be selected, however in some
cases you may need to select the audio device and click Set Default (button).
Double-click the device to access the control panel tabs illustrated overleaf.

4

Volume Indicator

Click the taskbar volume
indicator ] when an
HDMI device is select-
ed, and you will note that
the icon at the top of the
volume level indicator
has changed.

FigureC-9
Sound - HDMI
Device (set Default)

HDMI Audio Configuration C - 11




Video Driver Controls

5. Double-click the connected HDMI device (or right-click and select Properties) to
adjust the HDMI settings from the control panel tabs.
6. Click OK to close the control panel (see notes overleaf).

FigureC- 10
HDMI Device
Properties

C - 12 HDMI Audio Configuration
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HDMI Notes

Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-
ing to play audio/video sources through the device.

To play audio sources through your external display’s (TV or LCD) speakers
you will need to go to the audio configuration control panel on the display and
configure the audio input accordingly (see your display device manual).

HDMI Video Configuration

1.
2.

3.

HDMI Audio Configuration C - 13

Connect an HDMI cable from the HDMI-Out port to your external display.
Configure your external display as per the instructions in “Attaching Other
Displays” on page C - 5.

Set up your external display (TV or LCD) for HDMI input (see your display device
manual).

You can now play video/audio sources through your external display.

4

Other Applications

If you are using a third
party application to
play DVDs etc. from
any attached DVD de-
vice, you will need to
consult the applica-
tion’s documentation
to see the appropriate
audio configuration
(the application must
support digital to ana-
log translation).
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Specifications

Appendix D: Specifications
e

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your service center for details.

.|
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Specifications

Intel® Core i7-3612QM (2.1GHz)
Quad-Core Mobile Processor

6M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

Intel® Core i7-3520M (2.9GHz)
Mobile Processor

4M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

Intel® Core i5-3360M (2.8GHz)
Mobile Processor

3M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

Intel® Core i5-3320M (2.6GHz)
Mobile Processor

3M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

Intel® Core i5-3210M (2.5GHz)
Mobile Processor

3M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

D - 2 Specifications

Intel® Core i7-2620M (2.7GHz)
Mobile Processor

4M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i5-2540M (2.6GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i5-2520M (2.5GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i5-2450M (2.5GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i5-2430M (2.4GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i5-2410M (2.3GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i3-3110M (2.4GHz)
Mobile Processor

3M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

Intel® Core i3-2370M (2.4GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i3-2350M (2.3GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i3-2330M (2.2GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i3-2310M (2.1GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W




Intel® Pentium® B970 (2.3GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Pentium® B960 (2.2GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Pentium® B950 (2.1GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Pentium® B940 (2.0GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Pentium® B840 (1.90GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Celeron® B815 (1.60GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Celeron® B810 (1.60GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Celeron® B800 (1.50GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Celeron® B720 (1.70GHz)
1.5M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Celeron® B710 (1.60GHz)
1.5M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Mobile Intel® HM76 Express Chipset

Dual Channel DDRIII (DDR3)

Two 204 Pin SO-DIMM sockets
supporting DDR3 1333MHz / 1600MHz
(real operational frequency depends on
the FSB of the processor)

Memory Expandable up to 8GB (using
1GB/2GB/4GB SO-DIMM Modules)

Specifications

Model A:

14.0" / 35.56cm HD (1366 * 768), 16:9
Backlit Panel (LCD Thickness 5.2mm)
OR

14.0"/ 35.56cm HD (1366 * 768), 16:9
Backlit Panel (LCD Thickness 3.6mm)

Model B:

15.6”/ 39.62cm HD (1366 * 768) / HD+
(1600 * 900), FHD (1920 * 1080), 16:9
Backlit Panel

Model C:
17.3" / 43.94cm HD+ (1600 * 900), FHD
(1920 * 1080), 16:9 Backlit Panel

Specifications D - 3



Specifications

Intel® HD Graphics 4000 / Intel® HD
Graphics 3000 / Intel® HD Graphics
(GPU is Dependent on Processor):

Dynamic Frequency

Intel Dynamic Video Memory Technology
up to 1.7GB

Microsoft DirectX®10 Compatible (for
Intel® HD Graphics 3000 / Intel® HD
Graphics)

Microsoft DirectX®11 Compatible (for
Intel® HD Graphics 4000)

One Changeable 12.7mm(h) Super Multi/
Blu-ray Combo Optical Device Drive with
SATA Interface (Factory Option)

One Changeable 2.5" / 9.5 mm (h) HDD
with SATA (Serial) Interface

Built-in Touchpad with Multi-Gesture
Functionality

Model A Only:

Isolated OR Floating A4 Size Keyboard
(Design Style Dependent)

Three Instant Buttons:

WWW/ E-Mail / Silent

OR

WWW/ E-Mail / WLAN ON/OFF
(Design Style Dependent)

Models B & C:

Isolated A4 Full Size Keyboard with
Numeric Keypad

High Definition Audio Interface
Built-In Microphone
2 * Built-In Speakers

One USB 2.0 Port

Two USB 3.0 Ports

One External Monitor Port

One HDMI-Out (High-Definition
Multimedia Interface) Port (with HDCP)
One Headphone-Out Jack

One Microphone-In Jack

One RJ-45 LAN Jack

One DC-In Jack

Embedded Multi-In-1 Card Reader

- MMC/ RS MMC

- SD/ Mini SD / SDHC/ SDXC

- MS/ MS Pro/ MS Duo

Note: Some of these cards require PC
adapters that are usually supplied with
the cards.

D - 4 Specifications



Models A & B:

Two Mini-Card Slots with PCle & USB
Interfaces:

Slot 1 for WLAN Module

Slot 2 for 3G Module (Factory Option)

Model C:

One Mini-Card Slot with PCle & USB
Interfaces:

Slot 1 for WLAN Module

Built-In 10/100/1000Mb Base-TX
Ethernet LAN

Intel® Centrino® Wireless-N 2230 2*2
(802.11 b/g/n) Half Mini-Card PCle
WLAN + Bluetooth Combo Module
(Factory Option)

Intel® Centrino® Wireless-N 135 (1*1
802.11 b/g/n+) Half Mini-Card PCle
WLAN & Bluetooth Combo Module
(Factory Option)

3rd Party Combo WLAN (802.11b/g/n)
and Bluetooth v4.0+HS Half Mini-Card
Module with PCle Interface (Factory
Option)

3rd Party WLAN 802.11b/g/n Half Mini-
Card Module (Factory Option)

Model A:

300K / 1.3M / 2M HD Pixel PC Camera
Module with USB interface (Factory
Option)

Models B & C:
2M HD Pixel PC Camera Module with
USB interface (Factory Option)

Models A & B Only:

UMTS/HSPDA OR UMTS/HSPDA+
based 3G Module with Mini-Card
Interface (Factory Option)

Quad-band GSM/GPRS (850 MHz, 900
MHz, 1800 MHz, 1900 MHz)

UMTS WCDMA FDD (2100 MHz)

Note that UMTS modes CAN NOT be
used in North America

Specifications

Supports Wake on LAN
Supports Wake on USB

Full Range AC/DC Adapter

AC input 100 - 240V, 50 - 60Hz,

DC Output 19V, 3.42A or 18.5V, 3.5A (65
Watts)

Removable 6 Cell Smart Lithium lon
Battery Pack 48.84WH

Removable 6 Cell Smart Lithium lon
Battery Pack 62.16WH (Factory Option)

Windows® 7 with Service Pack 1
Windows® 8

One 48Mb SPI Flash ROM
AMI BIOS
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Specifications

LED Indicators - Power/Suspend,
Battery, HDD/ODD, Bluetooth/Wireless
LAN, Num Lock, Caps Lock, Scroll Lock

Model B & C Computers:
Camera LED located on camera module

For Model A Computers:

Camera LED located on Power/Suspend
LED

For some Model A designs in this
series:

Power/Suspend, Battery, HDD/ODD,
Bluetooth/Wireless LAN

Security (Kensington® Type) Lock Slot
BIOS Password
Trusted Platform Module V1.2

IMR (Injected Molded Resin) LCD Back
Covers (For some Model designs in this
series)

Painted Style (For some Model designs
in this series)

Magic Of Film Art Il Changeable LCD
Back Covers (For some Model designs
in this series)

Temperature
Operating: 5°C-35°C
Non-Operating: -20°C - 60°C

Relative Humidity
Operating:
Non-Operating:

20% - 80%
10% - 90%

Model A (Design Style Dependent):
340mm(w) * 238mm(d) * 13.9-31.8mm(h)
2.2 kg with 48.84WH Battery & ODD

OR

340mm(w) * 238mm(d) * 26.25-34.7mm(h)
2.2 kg with 48.84WH Battery & ODD

OR

341mm(w) * 238.5mm(d) * 16-34mm (h)
2.2 kg with 48.84WH Battery & ODD

OR

340mm(w) * 238mm(d) * 12-30.2mm(h)
2.15 kg with 48.84WH Battery & ODD

Model B (Design Style Dependent):
374mm(w) * 250mm(d) * 14.3-34.1mm(h)
2.3 kg with 48.84WH Battery & ODD

OR

374mm(w) * 250mm(d) * 20-37.2mm(h)
2.6 kg with 48.84WH Battery & ODD

Model C:
413mm(w) * 270mm(d) * 14-40.5mm(h)
2.9 kg with ODD & 48.84WH Battery

.|
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Windows 8

Appendix E: Windows 8

Overview

This Appendix contains information (including control panel information, driver installation etc.) for users of
the Windows 8 OS.

Y ou can refer to the main manual for details of driversrequired, audio & video information, BIOS, modules etc.
However any information specific to Windows 8 will be included in this Appendix, as well as details on how to
navigate the Windows 8 M etro User Interface to access the applications, control panels, taskbar etc.

4

Windows 7/8 OS

In order to run Windows 7 or 8 (32 Bit) without limitations or decreased performance, your computer requires a minimum
1GB of system memory (RAM), however if you are running Windows 7 or 8 (64 bit) your computer requires a minimum
2GB of system memory (RAM).
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Windows 8

Windows 8 Start Screen & Desktop

The Apps, control panels, utilities and programs within Windows 8 are accessed from the M etr o user interface’s
Start screen and/or Windows Desktop. The Desktop (which runs as an app within the Start screen) can be ac-
cessed from the Desktop iteminthe Start screen (or by using the Windows L ogo Key 5@ + D key combination).

Figure E - 1 - Windows Start Screen

E - 2 Windows 8 Start Screen & Desktop



Windows 8

Apps & Tiles

The Windows 8 Start screen will contain a number of Apps, and many more will be installed as you add more
applications etc. Not all of these apps can fit on one screen so you will often need use the slider at the bottom of
the screen in order to view al the necessary apps.

Accessing Pining/Unpinning All Apps

Y ou can add and remove the tiles for apps and control panelsin the Start screen. Right-click on a blank area of
the Metro Ul Start screen and you will seethe All Appsicon. Click the All Appsiconto display al theinstalled
applications etc. Right-click any icon to bring up the menu at the bottom of the screen. Y ou can then click the
appropriate icon to pin the app to (or unpin from) the Start screen, or to the taskbar in the Desktop applica-
tion.

® @ ® @ 6

Pin to Start Pin to taskbar Uninstall Open new n as n file
window admlm strator Iccatlon

Figure E - 2 - All Apps

Windows 8 Start Screen & Desktop E - 3
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Windows 8

Desktop Application

When the Desktop app is running (click the app in the Start screen or use the Windows L ogo Key g@ + D key
combination) you can use lower left hot corner to switch between the Start screen and the Windows Desktop.
To do so move your mouse to hover over the bottom left corner of the screen and click the pop-up.

When you move to the lower left hot corner in the Start screen itself it will take you back to your most recently
used app.

Move the mouse to the bottom left of the screen and click to switch
back to the Start screen.
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Figure E - 3 - Desktop
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Windows 8

When the Desktop app is running you can right-click the lower left hot corner (or use

the Windows L ogo Key g@ + X key combination) to bring up an advanced context Y

menu of useful features such as Control Panel, Programs and Features, Power Op-

tions, Task Manager, Search, Windows Explorer, Command Prompt, Device Man- Display Most
Recently Used

ager and Network Connections etc.

Programs and Features
Meobility Center

Power Options

Event Viewer

System

Device Manager

Disk Management
Computer Management
Command Prompt

Command Prompt (Admin}

Task Manager
Control Panel
File Explorer
Search

Run

Desktop

Move the mouse to the bottom left of the screen

and right-click to access the menu.

Figure E - 4 - Advanced Context Menu (Right-Click lower left hot corner)

Windows 8 Start Screen & Desktop E-5

Apps

If you are in the Start
screen, Desktop or an
app you can move your
mouse to the upper left
corner of the screen to
get back to the most re-
cently used app.

To view all the most re-
cently used apps hover
over the top left of the
screen and then move
the mouse down along
the left side of the
screen to display the
list.
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Windows 8

Windows 8 Charms Bar

Theright side of the screen displays the Windows 8 Charms Bar. The Charms Bar contains the Sear ch, Share,
Start, Devices and Settings menus. To access up the Charms Bar move the cursor to the upper or lower right
corners of the screen, and then hover over one of the itemsin the Charms Bar to activate it (the bar will be black
when it is active), or use the Windows L ogo Key g@ + C key combination.

Figure E - 5 - Start Screen with Charms Bar
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Windows 8

Charms Bar Items

* Search E: You can search for any file, application, apps and control panel settings with instantaneous
results.

« Share@): Thisbutton is used to share information with people viamail or social networks.

 Sart .: Click to bring up the Start Menu (the same function as pressing the Windows Logo Key or click-
ing the bottom left of the screen).

. Devices: Click this button to change connected peripheral device settings e.g. an external display.

o Setti ngsE]: This button gives instant access to the computer settings, such as Network, Audio, Brightness,
Notifications, Power and Keyboard (click Change PC Settings to activate the PC Settings menu).

0 -

= i) -O: 4

Wieeretiitel= & Eaohize Charms Bar - TouchPad Access
To quick access the Charms Bar using the TouchPad:

1. Place your finger off the TouchPad (slightly to the right of
Notifications Power Keyboard the pad resting on the computer).

2. Move your finger across to the left on to the TouchPad.
3. The Charms Bar will then pop-up.

Change PC settings
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Figure E - 6 - Settings Menu
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Windows 8

Windows 8 Control Panel
In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is much the same as that in Windows 7, however it can be accessed in a number of waysin Windows 8.

* Click Search inthe Windows Charms Bar (see previous page) and the search pane will pop out. Type
Control Panel and select it from the results to the | eft.

Figure E - 7 - Search (Control Panel)

* Click on Computer inthe Start screen, click on Computer in the top menu and select Open Contr ol
Panel from the ribbon.
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Figure E - 8 - Open Control Panel (Computer)
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Windows 8

* Whenin the Desktop app (this does not apply to the Start screen) click on Settingsin the Windows
Charms Bar and select Control Panel from the menu.

Settings

’ & i )
wntrol Panel

q

Figure E - 9 - Settings Charms Bar (Desktop App Only)

* Right-click on a blank area of the Metro Ul Start screen, click the All Appsicon and click Control
Panel.
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Figure E - 10 - All Apps - Control Panel
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Windows 8

» Right-click the lower left hot corner to bring up the menu and select Control Panel (see Figure E - 4 on
pageE - 5).

4

Keyboard Shortcut to Control Panel

You can also use keyboard shortcuts to access the Control Panel. Press the Windows logo key § and X to bring up
the context menu, and then press P to bring up the Control Panel. Alternatively press the Wlndows Iogo key & and R
to bring up the Run dialog box, and then type “Control Panel” and press Enter to access the Control Panel.
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Windows 8

Windows 8 Taskbar

In many instances throughout this manual you will see an instruction to access the notification ar ea of the task-
bar. In Windows 8 the taskbar is accessed from the Desktop application. If you are in the Start screen you will
need to click the Desktop app to switch to the Desktop.

The taskbar is displayed in much the same way as it wasin Windows 7, and you can see the notification area of
the taskbar in the bottom right of the screen. Some of the Control Panels and applications referred to during the
course of this manual can be accessed from here.

Figure E - 11 - Desktop Taskbar

Y ou can pin/unpin apps to/from the taskbar in much the same way as you can to the Start screen (see“ Accessing
Pining/Unpinning All Apps’ on pageE - 3).
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Windows 8

LED Indicators

Icon Color Description
The LED indicators on the computer display helpful . .
information about the current status of the computer Green | TN (optional) Wireless LAN Module
in puter. is Powered On
T Win 7 - The (optional) Bluetooth
Icon Color Description Module is Powered On
Orange DC Power is Plugged In Orange Win 8 - The (optional) Bluetooth

Module is Installed (this is not a power

Green The Computer is On on/off indicator in Windows 8)

The PC Camera is In Use . .
Blinking Green | (for 14.0” / 35.56cm Model A Green Hard Disk Activity
computers only)

— Green Number Lock Activated
Blinking Orange The Comp'\l/ljf)edrels in Sleep
Green Caps Lock Activated
Orange The Battery is Charging
Green The Battery is Fully Charged Green Scroll Lock Activated
- The Battery Has Reached
Blinking Orange Critically Low Power Status Blue Power Button
Table E - 1 - LED Power Indicators Table E - 2 - LED Status Indicators
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Keyboard - Windows 8

The main difference between the Windows 7 & Windows 8 keyboardsisin the func-
tion of theWindows L ogo Key & Menu/Application Key (inthe Start screen), oth-
erwise the keyboard functions are identical (see “Keyboard - Model A” on page 1 -
13/*Keyboard - ModelsB & C” on page 1 - 14).

Figure E - 12 - Keyboard - Model A
Thefunction/hot key indicators function in the same manner as outlined for Windows
7 on “Function/Hot Key Indicators” on page 1 - 15. However the indicators work

under the Desktop App (see“ Desktop Application” on page E - 4) and not under the
Start Screen.

Windows Logo Key

Keyboard - Windows 8 E - 13

Windows 8

4

Windows Logo
Keyboard Shortcut

Use the Windows logo
key 3@ + D key com-
bination to switch be-
tween the Start screen
and Windows Desktop
(see Table E - 3 over-
leaf for further informa-
tion).

Menu/Application
Keyboard Shortcut

When the Desktop app
iS running you can use
the Menu/Application
key [Z] on the key-
board to display the
context menu as per a
mouse right-click. In
the Start screen this
function is useful to
quickly display the All
Apps icon.
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Windows 8

Keyboard Shortcuts
Thefollowing Windows L ogo Key (Winkey) keyboard shortcuts are useful for navigation/operation in Windows 8.

Windows Logo =@ Key + Description
Tap Winkey Toggle between the Start screen and the foremost running app or the Windows Desktop
C Display Charms menu
D Switch to the Windows Desktop and toggle show Desktop
E Switch to the Windows desktop and launch Windows Explorer with Computer displayed
F Display file Search

I Open the Settings charm

Open the Connect charm

Lock the computer and display the Lock screen

Display the Second Screen menu (see Figure E - 14 on page E - 16)

Switch to the Windows Desktop and display the Run dialog box

N| 0| O | X

Access the App Bar (see Figure E - 4 on page E - 5)

Table E - 3 - Keyboard Shortcuts
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Windows 8

Function/Hot Key Indicators & Control Center

The function/hot key indicators and Control Center function in the same manner as outlined for Windows 7 on
“Function/Hot Key Indicators’ on page 1 - 15 and “ Control Center” on page 1 - 16. However both of these
functionswork under the Desktop app (see“ Desktop Application” on page E - 4) and not under the Start screen,
and the Control Center does not feature the wireless/Bluetooth buttons and Airplane Mode etc.

4

Control Center

Click on any button to turn any of the modules (e.g.
TouchPad, Camera) on/off.

Click on the power conservation modes to switch be-
tween Performance, Balanced or Energy Star modes
(see page 3 - 10). To remove the Power Conservation
Modes screen just click in a blank area of the icon or
press a key on the keyboard.

Click on the buttons (or just click and hold the mouse
button) to adjust the slider for Brightness/Volume.

Click on Display Switch and click to choose a display
mode from the menu (see page C - 10).
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Figure E - 13 - Control Center

Function/Hot Key Indicators & Control Center E - 15



Windows 8

Video Features

Y ou can switch display devices, and configure display options, from the Display control panel (in Appear ances
and Per sonalization) in Windows 8 in the same manner as Windows 7 running the Desktop app (see “ Desktop
Application” on page E - 4 and Appendix C). In Windows 8 it is possible to quickly configure external displays
from the Devices menu item in the Charms Bar (see “Windows 8 Charms Bar” on pageE - 6).

To Configure Displays from Devices (Charms Bar):

Attach your display to the appropriate port, and turn it on.

2. Gotothe Charms Bar and select Devices.

3. Click Second Screen.

4. Click on any one of the options from the menu to select Duplicate, Extend or a Single display.

L

Devices

Start

There’s nothing to send right now.

I:T Second screen
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Figure E - 14 - Second Screen (Devices)

E - 16 Video Features



Windows 8

Power Options

Power Options can be accessed from the Control Panel in the same manner as Windows 7 from the Desktop app.
The Power item in Settingsin the Charms Bar in Windows 8 may be used to Shut down, Restart or send the

computer to Sleep.

Shut Down, Restart or Sleep

1. Gotothe Charms Bar and click Settings.
2. Click Power .

3. Select Sleep, Shut Down or Restart.

Sleep

0—] Shut down 2
Fau o

-b'd

LEVETEL  Restart Brightness

2 O

Natifications Power Keyboard

Change PC settings
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Figure E - 15 - Power (Settings)
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Windows 8

Ctrl + Alt + Delete Key Combination
You canusethe CTRL + ALT + DEL key combination from almost any of the Windows 8 interfaces/apps to
bring up afull-screen displaying L ock, Switch User, L og off, Change a password and Task M anager options.
If you click the Power iconin the lower right corner of the screen a power management option menu appears to
display Sleep, Shut down, and Restart.

Figure E - 16 - CTRL + ALT + DEL Menu

To fully control al the power options (including Hibernate mode) go to the Power Options control panel and
configure the power button, sleep button and lid (see Figure E - 17 on page E - 19) to perform the function se-
lected.

E - 18 Power Options
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Wake On LAN Settings

If you require your computer to wake up from network activity in Windows 8 then 7\£l/<
make sure that the computer is either in Sleep or Hiber nate. The power/sleep button Wake On LAN
(Fn + F4 key combo) and closed lid may be set to send the computer in to a power- Support

saving state. Click Choose what the power buttons do on the left menu in Power (Windows 8)
Optionsto bring up the menu.

Wake-On-LAN is only
supported from Sleep or

Hibernate states in
Windows 8.

Wake-On-LAN is not
supported from Shut-
down states in Win-
dows 8.
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Figure E - 17 - Power Options Define Power Buttons
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Running Metro Ul Apps

. To run Apps in the Metro Ul in Windows 8 you will need to check that the Screen
Screen Resolution Resol uti dUser A t Control ti atible with th <
for Metro Style Apps esolution and User Account Control Settings are compatible with the system re-

(Windows 8) quirements:

e tide @ Screen Resolution Settings

LETEERVEIGEERIERE 1. Switch to the Windows Desktop (click the App or use the Windows logo key 2@ + D
apps will  run is key combination).

1024x768. 2. Right-click a blank area of the Windows Desktop and select Screen Resolution.

3. Adjust the Resolution to make sure that it is at least 1024 * 768, although preferably

U e ) 1366 * 768 or above (see sidebar).
required to support all

the features of Windows
8 (including multitasking
with snap) is 1366x768.

SN
ALK

These specs are the
minimum screen resolu-

tion that supports all the
features of Windows 8 | |
on a useful physical

size.
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Figure E - 18 - Screen Resolution
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User Account Control Settings

If your computer meets the minimum screen resolution requirements, and still you can't run Metro Apps, then
that you have to check the status of User Account Control (UAC). Metro Apps may fail to open whenthe UAC
isturned off. To check whether the UAC is on or off, follow the instructions below.

1.
2.

3.

Open the Control Panel (see “Windows 8 Control Panel” on page E - 8).

Click on User Accounts and then click on Change User Account Control settings (or click System and
Security and click Change User Account Control Settings under Action Center).

If the slider is in the Never notify position, then the UAC is disabled.

To enable or turn on the UAC, move the slider to Always notify or Notify me when apps try to make changes
to my computer (default) position, and then click OK.
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Figure E - 19 - User Account Control
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Drivers & Utilities

Make sure you install all the driversand uti lites for your system. Follow the instructionsin Chapter 4 “ Drivers
& Utilities” on page 4 - 1/ “Modules & Options’ on page 7 - 1 for installing all the basic system drivers and
module drivers for Windows 7 & 8.

However note that the USB 3.0 driver isnot required for Windows 8, and that the PC Cameradriver isonly
required for 14.0" / 35.56cm Model A computers.
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Driver Installation (Windows 8)

1. Insert the Device Drivers & Utilities + User’s Manual disc into the computer’s DVD drive.
2. Click the message “Tap to choose what happens with this disc.”
3. Click Run autorun.exe.

BD-RE Drive (E:) My Disc

Tap to choose what happens with this disc.

4

Driver Installation

If you miss the message above you can eject the De-
vice Drivers & Utilities + User's Manual disc and then
reinsert it.

Alternatively double-click the disc icon in Comput-
er (use the Windows logo key == + E key combina-
tion to go to Computer in Windows Explorer).

Figure E - 20 - Autorun Driver Installation Disc

4. Click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

5. Check the driver installation order from Table E - 4, on page E - 24 (the drivers must be installed in this
order) which is the same as that listed in the Drivers Installer menu below.

6. Click to select the driver you wish to install, (you should note down the drivers as you install them).

7. Follow the instructions for each individual driver installation procedure as listed on the appropriate pages.
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Win 7 SP1/Win 8 Driver Page # Win 7 SP1/Win 8 Driver Page #

PC Camera Module
Chipset Page 4 -6 (Only 14.0" / 35.56cm Model A computers require a Page 7 -3
camera driver for Windows 8)

Video (VGA) Page 4 - 6 Wireless LAN Module (see page E - 30) Page 7 - 11
LAN Page 4 -6 Intel® Wireless Display Application Page 7 - 32
CardReader Page 4 -6 Bluetooth & WLAN Combo Module (see page E-37) | Page 7 - 37
Touchpad Page 4-6 3G Module (for Models A & B only & see page E - 42)) | Page 7 - 44
Hot Key Page 4 -7 Trusted Platform Module Page 7 - 91

Intel Rapid Storage Technology

USB 3.0is notrequired for Windows 8 (required for hard disks in AHCI mode)

Page 7 - 105

MEI Driver Page 4 -7 Intel® Smart Connect Technology Page 7 - 106

Audio Page 4 -7

Table E - 4 - Driver Installation

All drivers provided are for Windows 7 with Service Pack 1 or Windows 8.

Note that you need to install both the WLAN & Bluetooth driversfor the Intel and 3rd party WLAN & Blue-
tooth Combo modules.
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PC Camera (Windows 8)

Usethe Fn + F10 key combination (see“ Function/Hot Key I ndicators’ on page 1 - 15) or Control Center but-
ton to toggle power to the PC Camera module.

A PC Camera driver is only required if you have aModel A computer with a 14" /35.56cm screen (see “ PC
Camera Driver Installation” on page 7 - 4). Model B & C computers do not requireany driver installation.

When the 14" /35.56cm screen Model A PC Camerais in use the power LED indicator will blink orange (see
Tablel- 2, on pagel- 11).

When the M odel B/C PC Cameraisin usethe LED indicator to the left of the camerawill beilluminated in red
(see @ Figurel-4onpagel- 9/Figurel-4onpagel-9).

Note that you need to use the Camera App in Windows 8 to take pictures and capture video (the camera appli-
cation listed in Chapter 7 isfor Windows 7 only).

.|
PC Camera (Windows 8) E - 25
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Windows 8

Metro Ul Camera App

1. Make sure the PC Camera is turned on by using the Fn + F10 key combination (or Control Center button).
2. Run the Camera App from the Metro Ul by clicking on the Camera App icon @

3. The camera interface is a translucent app bar with three buttons.

Figure E - 21 - Camera App Bar
» Cameraoptions.. Click this button to open a window with three main options:

el Camera options
Camera Options o .
Photo resolution
» Resolution (determined by the camera spec) 0.TMP (4:3) v
» Audio device (select microphone to use) Audio device
) - ) Microphone (Realtek High Defin.. w
* Video Sabilization (atoggle based on spec of
the Camera) Video stabilization
off i

More
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Figure E - 22 - Camera Options

.|
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You can aso click on Moreto adjust Brightness, Contrast and Flicker (if you find that the video screen in
the camera program is flickering, you can try to adjust the setting here),

More options

oo

3.
i<}
0

=3
]
i
@

Contrast

Flicker

60 Hz v

50 Hz

Figure E - 23 -More Camera Options

» Timer: Thisbutton will start athree second countdown before the system takes a still photo or video record-
ing starts.

* Video Mode: This button toggles between still photo mode (transparent button m) and video recording
mode (highlighted white button g ).

PC Camera (Windows 8) E - 27
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Taking Pictures/Capturing Video

Make sure the PC Camera is turned on by using the Fn + F10 key combination (or Control Center button).
Run the Camera App from the Metro Ul by clicking on the Camera App icon @

Click to select the timer if you require a countdown before capture.

Click to select either photo or video modes.

Click in the main window to take a picture or start video capture (if video capture begins a timer will appear in
the bottom right corner of the screen).

To stop video capture click the main window again.

Captured photos and videos will be saved to a Camera Roll folder within the Picture folder in Libraries.

agrwnE

N o
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Figure E - 24 - Libraries - Pictures
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10.

11.
12.
13.

14.

Windows 8

A scroll arrow will appear on the left side of the screen after any pictures/videos have been captured.

Click the arrows (on either side of the screen) to browse through the captured photos/video, and back to the
Camera App.

Clicking on a captured photo will bring up an App bar with Crop and Delete buttons.

Figure E - 25 - Crop & Delete Buttons (for Still Photos)

Use the handles to Crop any captured picture, and click OK to save the changes made.
Click Delete to delete any captured photo (note that no prompt will appear to confirm the delete).
Right-click any captured video to bring up app bar with Trim and Delete buttons.

Figure E - 26 - Trim & Delete Buttons (for Video Files)

Use the buttons at either end of the slider to adjust the video length and click OK to save the changes made.
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Wireless LAN Settings (Windows 8)

If you have included an Intel® or 3rd Party WirelessLAN (or WLAN & Bluetooth combo) modulein your pur-
chase option, make sure that the WLAN module is on before installing the driver.

Usethe Fn + F11 key combination (see“ Function/Hot Key Indicators’ on page 1 - 15) or Control Center but-
ton to toggle power to the Wireless LAN module. Make sure you install the drivers in the order indicated in
Table4-1, on page4- 3. See” 3rd Party 802.11b/g/n Driver Installation” on page 7 - 12 or “ Intel® WLAN Driv-
er Installation” on page 7 - 13 for driver installation information, however see over leaf for WL AN configuration
information in Windows 8.

Note that you need to install both the WLAN & Bluetooth driversfor the Intel and 3rd party WLAN & Blue-
tooth Combo modules.
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WLAN Configuration in Windows 8

Y ou can configure a wireless connection using one of the following options, however make sure the Wireless
LAN moduleisturned on (and not in Airplane Mode) before configuration begins.

Charms Bar

1. Go to the Charms Bar.

2. Select Settings and then click the WiFi icon (it should read Available under the icon and Airplane mode
should be Off).

3. Alist of available access points will appear.

(®© Networks

vl Airplane mode
% \ I") ',O; off [ |
]

Available 67 Brightness
Wi-Fi

Guest 2

= | d) RD113-DIR825-2.4GHZ

Notifications Power Keyboard DA EAD RS AR
Openfly
Guest
Change PC settings RDTH4-E
CLEVO-RD18-WRT300N2
pda-rd112-2.4GHz-50Mb
Chamber12

Hidden network
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Figure E - 27 - WiFi Settings (Charms Bar) & Networks
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Double-click an access point to connect to it (or click it and click Connect).
Enter a network security key (password) if required, and click Next.

You can choose to share or connect to devices or not.

When you are connected to the network access point it will display the Connected icon .
Select any connected network and click Disconnect [IEZE23] to disconnect from a connected access point.

(© Networks Networks

Airplane mode
Airplane mode Off [ |

Off 0

©No A

Wi-Fi

Wi-Fi RD13-DIR.. DIR.. Connected il

RD113-DIR... Connected il

Figure E - 28 - Networks Connected / Disconnect

9. You can click the Airplane Mode button to turn the mode On or Off.
10. If you click on Change PC Settings (at the bottom of Settings in the Charms Bar) you can turn Wireless or
Airplane Mode On/Off (see over).
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PC settings

Activate Windows
Personalize

Users
Notifications
Search

Share

General

Privacy

Devices

WEESS

Airplane mode

Turn this on to stop wireless communication

off

Wireless devices

Wi-Fi

on

Figure E - 29 - PC Settings (Wireless)

Windows 8

11. You need to either use Airplane Mode, or to turn the WLAN module off aboard aircratft.

N /
Z &
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft

is usually prohibited.

Make sure the module is
either OFF or in Air-
plane Mode (for Win-
dows 8 only) if you are
using the computer
aboard aircraft.
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Windows 8

Desktop Mode

Switch to the Windows Desktop (click the App or use the Windows logo key == + D key combination).
Click the wireless icon [ in the notification area of the taskbar.

A list of available access points will appear.

Double-click an access point to connect to it (or click it and click Connect).

Enter a network security key (password) if required, and click Next.

You can choose to share or connect to devices or not.

Select any connected network and click Disconnect to disconnect from a connected access point.

Nogh,~wdhE

(© Networks

Airplane mode

ot i
Wi-Fi
NEWTIIS Guest 2

Airplane mode
RD113-DIR855-2.4GHZ-6

off [ |

Openfly
Guest

Wi-Fi RD114-E
CLEVO-RD18-WRT300N2

RD113-DIR... DIR.. Connected il R EAERETD

Chamber 12
Hidden network

Figure E - 30 - Windows Desktop Taskbar Notification Area WLAN Connection
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Control Panel
If you arein Category View do the following (see over for Icon View):

1. Open the Control Panel (see “Windows 8 Control Panel” on page E - 8).
2. Click the Network and Internet control panel.
3. Click Connect to a network.

Figure E - 31 - Network and Internet Control Panel

A list of available access points will appear.

Double-click an access point to connect to it (or click it and click Connect).

Enter a network security key (password) if required, and click Next.

You can choose to share or connect to devices or not.

Select any connected network and click Disconnect to disconnect from a connected access point.
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If you arein Icon View do the following:

1. Open the Control Panel (see “Windows 8 Control Panel” on page E - 8).
2. Click Network and Sharing Center.
3. Click Change Adapter Settings.
4. Double-click Wi-Fi.
s
=1 Figure E - 32 - Network and Sharing Center Control Panel
% 5. Alist of available access points will appear.
s 6. Double-click an access point to connect to it (or click it and click Connect).
» 7. Enter a network security key (password) if required, and click Next.
oo 8. You can choose to share or connect to devices or not.
9. Select any connected network and click Disconnect to disconnect from a connected access point.
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Bluetooth Settings (Windows 8)

If your purchase option includes the Combination Wireless LAN & Bluetooth module (either Intel® or 3rd
Party) then install the driver asinstructed in Chapter 7 (see links below).

Usethe Fn + F12 key combination or Control Center button to toggle power to the Bluetooth module.

4

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in
one direction only (simultaneous data transfer is not supported). Therefore if you are copying a
file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Blue-
tooth enabled device to your computer until the file transfer process from the computer has been com-
pleted.

» For 3rd party Bluetooth modules see “ 3rd Party Bluetooth (V4.0) Combo Driver I nstallation” on page 7
- 38.

* For Intel Bluetooth combo modules see the installation procedure see “ I ntel Bluetooth Combo Driver
I nstallation” on page 7 - 39.
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Windows 8

Bluetooth Configuration in Windows 8
Y ou can configure a Bluetooth connection as bel ow, however make sure the Bluetooth moduleis turned on (and
not in Airplane Mode) before configuration begins.

Desktop Mode

1. Switch to the Windows Desktop (click the App or use the Windows logo key &@ + D key combination).

2. Click the notification area of the taskbar and double-click the Bluetooth icon E (or click and select Show
Bluetooth Devices).

3. The Devices item in PC Settings will appear.
OR

Charms Bar

1. Go tothe Charms Bar.

2. Select Settings and then click Change PC Settings.

3. The Devices item in PC Settings will appear.

E 0

Available Brightness

Natifications Power Keyboard

Change PC settings

Figure E - 33 - Bluetooth Taskbar Icon & Change PC Settings (Charms Bar -Settings)
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4. Click Add a Device.
5. Double-click the device you want to pair with the computer.

Figure E - 34 - PC Settings (Devices) - Add A Device
6. On first connection the computer will provide you with a pairing code to be entered onto the device.

Figure E - 35 - Enter the Passcode
7. Enter the code into your Bluetooth enabled device and click Yes on the computer to complete the pairing.
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Windows 8

8. You need to either use Airplane Mode, or to turn the Bluetooth module off aboard aircratft.

PC settings

Activate Windows
Personalize

Users
Notifications
Search

Share

General

Privacy

Devices

Ease of Access

Sync your settings

Figure E - 36 - PC Settings (Wireless)
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Airplane mode

Turn this on to stop wireless communication

off

Wireless devices

Mobile broadband

on |
Wi-Fi

on L__ |
Bluetooth

on L |

Mobile broadband hardware

Chunghwa Telecom

N /
2§
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft

is usually prohibited.

Make sure the module is
either OFF or in Air-
plane Mode (for Win-
dows 8 only) if you are
using the computer
aboard aircraft.
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To Make your Computer Discoverable to Bluetooth Devices

1.
2.
3.

4.

Switch to the Windows Desktop (click the App or use the Windows logo key == + D key combination).

Click the notification area of the taskbar, click the Bluetooth icon E and click Open Settings.

Click Options, and make sure that Allow Bluetooth devices to Tind this computer check box (Discovery)
has a tick inside it.

Make sure that the Alert me when a new Bluetooth device wants to connect check box (Connections) has
a tick inside it, if you want to be notified when a Bluetooth device wants to connect.
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Figure E - 37 - Bluetooth Settings
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3G Settings (Windows 8)

If you have included an optional UMTS/HSPDA OR UMTS/HSPDA+ based 3G Module (Universal Mobile
Telecommunications System or High Speed Packet Access) module (see “ Communication” on page D - 5 for
specification details) in your purchase option, you do not require a driver/application installation for Windows
8. Follow the instructions on page 7 - 45 to install the USIM card (which will be provided by your service pro-
vider), and then use the Charms Bar Wireless icon to access the 3G network in the same manner as the
WLAN (see overleaf).

SN
A&

Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module and the Bluetooth/Wireless LAN
modules at the same time as this may disrupt radio frequency, and cause interference. When the 3.75G/HSPA module is
powered on, make sure that the Bluetooth/Wireless LAN modules are powered off.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited.

Make sure the module is either OFF or in Airplane Mode (for Windows 8 only) if you are using the computer aboard aircraft.
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3G Configuration in Windows 8

Y ou can configure a 3G connection as below, however make sure the 3G module is turned on by pressing the
Fn+  key combination (give the module about 10 seconds to power on) or Control Center button (and not in
Airplane Mode) before configuration begins.

Charms Bar

1. Go tothe Charms Bar.

2. Select Settings and then click the WiFi icon (it should read Available under the icon and Airplane mode
should be Off).

3. Alist of available access points will appeatr.

(© Networks

Airplane mode
* ‘0"

Off [ |
Available

" Mobile broadband

E Chunghwa Telecom

Notifications Power Keyboard

Change PC settings
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Figure E - 38 - WiFi Settings (Charms Bar) & Networks (with Mobile Broadband)
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o

Any 3G service provider (connection information is usually stored on the USIM card) will appear under Mobile
Broadband.
Double-click any connection icon under Mobile Broadband (or click and click Connect).

Mabile broadband

Chunghwa Telecom

Reset

. Connect automatically

Figure E - 39 - Mobile Broadband (Connect)

The system will connect to your network.
A Connected will appear alongside the 3G connection (click the connection to view the timer which indicates
your connected time for the current session).

Mobile broadband

Chunghwa Telecom Connected ?'f:|||

Figure E - 40 - Mobile Broadband (Disconnect)
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8. You can then access the internet, download e-mail etc. as per any internet connection.

9. To disconnect you can select the connection and click Disconnect .
10. You need to either use Airplane Mode, or to turn the Mobile Broadband module off aboard aircraft.

PC Settlﬂgs Airplane mode ﬁ

Turn this on to stop wireless communication W| rel ess Dev| ce
i i off :
Activate Windows Operation Aboard
Personalize Wireless devices Aircraft
Users Mabile broadband The use of any portable
- on electronic transmission
Notifications WiFi devices aboard aircraft
Search on is usually prohibited.
Bluetooth
Share on — Make sure the module is
) either OFF or in Air-
General Mobile broadband hardware plane Mode (for Win-
Privacy Chunghwa Telecom dows 8 only) if you are
using the computer
Devices aboard aircraft.

Wireless

Ease of Access

Sync your settings
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Figure E - 41 - PC Settings (Wireless)
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EM820W 3G Module PIN Code & Power-Saving

Note that there may be some issues when a PIN Code is set for the EM820W 3G module (if you are unsure of
your module version contact your distributor/supplier) in Windows 8, Mobile Broadband has been turned off,
and the system has resumed from a power-saving state. To prevent any issues it is recommended that you
simply do not enable a PIN for the EM820W 3G module. The following provides instructions for disabling
the PIN code; for specific instructions on resolving the issue where “Insert a SIM” appears in the connection
see“ Resolving the “Insert a SIM” issue with the 3G Module (Windows 8)” on page 8 - 16.

Disabling a PIN code for a 3G Module

1. Go tothe Charms Bar.
2. Select Settings and then click the WiFi icon.
3. Right-click the 3G connection and select View connection properties.

€) Networks
W\ ¢ o ©
Chunghwa 100 Brightness Hide estimated data usage

Set as non-metered connection

B3 O

Motifications Power Keyboard Forget this network

L View connection properties .
Change PC settings . : prop ‘ ‘ TI“
i

Figure E - 42 - WiFi Settings (Charms Bar) & Right-Click Connection to View Properties
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4. Click Security (tab) and click Disable PIN.
5. Enter the PIN number and click Disable PIN and click OK to confirm.
6. Itisrecommended that you do not Enable a PIN for the EM820W 3G module.

Unnamed Mobile Broadband Properties

Subscription IPrcﬁIe Security

Dizabling the PIN will make the device Disable PIN
less secure.,

The PIM has been successfully disabled.

To change the PIN, dick Change FIN. Change PIN

["show characters

Tries left: 3
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Figure E - 43 - Disable PIN
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